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Installation Quick Guide
This document should guide you through the first steps to get VivoQuant running on your system:

Downloading

Please point your favorite web browser to the VivoQuant Home Page  for access to the latest release.

VivoQuant Home Page

Installing

A. Windows

Double-click the VivoQuant install icon to start the installer.

Windows Install

Follow the sequence of set-up steps carried out by the Installer. Please accept the default settings, or change the options
according to your needs. A detailed description of the install options can be found in Installation Details.

B. Mac OS X

1. Double-click and unzip the VivoQuant zip archive.

2. Locate the VivoQuant installer in the Applications folder.
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Mac OS Install

Troubleshooting Mac OS Install

On some occasions, Mac OS will not recognize VivoQuant as a verified application:

Mac OS Warning

To make the Open option appear, simply the right-click on the warning message and select Open.

Open VivoQuant

C. Linux

Double-click and unzip the VivoQuant zip archive, then move the VivoQuant folder to the desired location. To run VQ,
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double-click the VivoQuant script contained in this folder.

Licensing

I. Active Accounts

VivoQuant supports two licensing methods: a machine locked file-based license and a floating license. Users should consult
their latest purchase agreement for the license to determine which type was purchased.

Floating licenses

The floating license uses an alpha-numeric license key and an internet connection to provide licensed access to VivoQuant.
To add a floating license key:

1. Start VivoQuant

2. Go to Configuration > Licensing > Floating license tab

3. Enter the license key in the field provided.

4. Click Ok to close the Configuration dialog.

5. Restart VivoQuant, and the license will be activated in the next session.

Heartbeat pings

To prevent issues with license activations becoming stuck on a user’s machine, VivoQuant requires a constant internet
connection to send pings to the license server in order to confirm that the activated VivoQuant instance is still in a working
state. If the process can no longer communicates with the license server, VivoQuant will notify the user to resolve the
connection issue before eventually closing.

File-based Licenses

VivoQuant License Manager  manages file-based licenses allocated to an account. An on-site license manager login credential
will be provided to each account to access the VivoQuant License Manager. For detailed information on how to manage your
account’s VivoQuant licenses click Here.

Installing a file-based license

If the end-user’s computer has internet access, VivoQuant will automatically detect and install a pre-approved license file. If
the end-user’s computer does not have internet access, they will need to download the license provided in the link and install
manually. To install a license file manually, go to Help > Licensing within VivoQuant and click on Install key. VivoQuant is
now registered and fully operational.

II. Trial Accounts

Methods for Obtaining a Trial License

If you are a current end-user and have an active software account, contact your account representative for a trial license of a
plugin module. Your account representative will pre-approve the trial license and you should follow section II.b. below. If you
do not have an active account, please follow the below steps.

a. Requesting a Trial License

1. Download  the latest stable version of VivoQuant. Once you have successfully installed VivoQuant, you will be
prompted to register your computer. Click Yes.
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1. Make sure the company code is DEMO. Enter a value to identify your department (or company) in the Department
field. The license file will be sent to the email address specified in Contact address.

2. After clicking Register, your internet browser will load and navigate to the license registration confirmation page.

b. Pre-approved Licenses

1. An account manager can issue a license to an end-user. Upon issuing a license, an email notification will be sent with
instructions for downloading the VivoQuant software and installing the license key. After the software has been
successfully installed, you will be prompted to register your computer for a license. Click Yes.

2. Enter the company code provided in the email along with the email address to which the registration email was sent.

3. After clicking Register, your Internet Browser will load and navigate to the license registration confirmation page. You
will need to enter the password provided in your email to finalize the process.

4. After you click Submit, the system will validate the request. If successful, the below page will appear.

If you experience any problems, please contact support@invicro.com.
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Installation Details
After accepting the VivoQuant license, you have the option to choose the install location and components, which allows you
to tailor the installation to your specific needs.

Choose Install Location

For the destination folder, it is recommended to keep the default settings. However, if you would like to install multiple
versions of VivoQuant on your system, you can choose a different install location here.

Install Location

Choose Components
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Choose Components

Component Description

Qt libraries Unless you already have Qt installed on your system, it is highly recommended that you use the version
coming with VQ.

ImageMagick
binaries

It installs the IM programs mpeg2encode (required for generation of MPEG movies) and convert (general
tool to convert image formats, not required by VQ).

Manual After installation, the manual is available by pressing <F1> on the main VQ screen, or using the
Help|Manual menu. Alternatively, you can also find the manual online.
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Options
Shortcut on desktop Installs a VQ icon on Windows desktop.

DicomBrowser
shortcut on desktop

Allows starting of VQ with opened DicomBrowser quickly. Open DICOM
data

Add local DICOM
folder

Adds an example DICOM folder to the list of repositories.

Add DEMO iPACS Allows access to an online PACS system to download example data and
share your data with other users.

Add Service iPACS Adds a write-only online PACS system (reading requires password) to allow
you to send data to our service engineers.

Enable update check When enabled, VQ regularly checks for the availability of new versions and
offers you to download and install them. 
See Update Check for details.

Debugging These options allows for debugging issues in VQ.
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Keyboard Shortcuts

General Keyboard Shortcuts

Windows / Linux
Shortcut

Mac
Shortcut

Shortcut Function

Ctrl + O ⌘ + O Open Reference

Ctrl + N ⌘ + N Open input 1

Ctrl + Shift + N ⌘ + Shift +
N

Open input 2

Ctrl + D ⌘ + D Open DICOM Data

Ctrl + I ⌘ + I Save Image

Ctrl + M ⌘ + M Save Movie

Ctrl + S ⌘ + S Save Data (DICOM format)

F1 fn + F1 Manual

F2 fn + F2 Show Reference

F3 fn + F3 Show input 1

F4 fn + F4 Show input 2

F5 fn + F5 Slice Control

F6 fn + F6 MIP Control

F7 fn + F7 Data Manager

Ctrl + + ⌘ + + Zoom in

Ctrl + - ⌘ + - Zoom out

Ctrl + 0 ⌘ + 0 Normal Size

Ctrl + F ⌘ + F Full Screen

Ctrl + U ⌘ + U Auto Zoom

Ctrl + Z ⌘ + Z Undo Operation

Ctrl + Shift + Z ⌘ + Shift + Z Redo Operation

Ctrl + I ⌘ + I Save Image

Ctrl + Shift + D ⌘ + Shift +
D

DICOM Dump

Ctrl + Shift + H ⌘ + Shift +
H

Histogram

Page 13



Ctrl + Shift + U ⌘ + Shift +
U

Update Check

Ctrl + Shift + C ⌘ + , Configuration Panel

Ctrl + Shift + P ⌘ + Shift + P Preprocessing Tool

Ctrl + Shift + W ⌘ + Shift +
W

Worklist Tool

Ctrl + B ⌘ + B Base NanoSPECT Configuration

Ctrl + Q ⌘ + Q Quit MMP Calibration Tool

Ctrl + T ⌘ + T Toggle between pre- and post-correction images in the Near-Field Uniformity
panel

←,→,↑,↓ ←,→,↑,↓ Scroll through slices in either the Slice View or Tile View.

PageUp,PageDn fn + ↑, fn +
↓

Scroll through slices in either the Slice View or Tile View.

Windows / Linux
Shortcut

Mac
Shortcut

Shortcut Function

3D ROI Tool Specific Keyboard Shortcuts
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Windows / Linux
Shortcut

Mac Shortcut Shortcut Function

N N Navigate to the Navigation tab in the 3D ROI Operator

P P Navigate to the Manual Painting tab in the 3D ROI Operator

S S Navigate to the Spline Tool tab in the 3D ROI Operator

M M Navigate to the Magic Segmentation tab in the 3D ROI Operator

X X Navigate to the Expert tab in the 3D ROI Operator

Shift + = Shift + = Add a ROI

- - Reset the active ROI

E E Edit the active ROI

v v Toggle visibility of the active ROI

R R Rotate through the ROI list in the active ROI drop down menu

Right Click of
Mouse

Right Click of
Mouse

Rotate through the ROI list in the active ROI drop down menu

T T Display quantification table

H H Display 3D ROI Histogram Tool

Enter Return or Enter Within the Spline tool, confirm classification of voxels within contour to active
ROI

Shift + Enter Shift + Return or
Enter

Within the Spline tool, confirm classification of voxels within contour to active
ROI and move to next slice

Space Space Within the Spline tool, scroll through Spline, Freehand, Bully and Thresholding
tools

C C Within the Spline tool, clear the currently drawn contour

Slice View - Intraframe Zoom And Pan

Key Mouse Button and Action Context Description

Shift Left down and drag Cursor over slice frame Translates

Shift Midel down and drag Cursor over slice frame Translates

Shift Scroll wheel Cursor over slice frame Zooms within display bounds
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VivoQuant Configuration
The VivoQuant Configuration window has several panels that provide access to customizable features as well as important
licensing and set-up information.

Getting There

Windows and Linux

The Configuration window is accessible from the Tools menu under Configuration or by using the keyboard shortcut
Ctrl+Shift+C.

MacOS

On Mac, the Configuration window is accessible from the VivoQuant menu under Preferences or by using the keyboard
shortcut ⌘ + ,.

For more on keyboard shortcuts in VivoQuant, see Keyboard Shortcuts.

Configuration Panels

The Configuration window consists of six panels:

Display

Data

DICOM Settings

Network

Licensing

VivoScript
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Display
Several appearance features may be customized in the Display panel, including General display information, Maximum
Intensity Projection attributes, and Color Palette defaults.

Display Panel

General
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Option Description

Pal Path Pal files hold the color map information for the different Color Palettes available in VivoQuant.

Orientation Provides an option to view the data whether in Radiologist View (face to face) or Neurologist View (mirror).
Diagrams are used to show the difference.

Quality Provides an option to view the data whether in Native or Enhanced quality. With Native quality, voxels are
always displayed as they are defined in the image, with no smoothing applied. With Enhanced quality,
smoothing is applied to the image when a voxel is displayed using multiple pixels on the screen. There is no
effect on quantification.

Default
Frame
Duration

Establish a default value for the ‘Frame Duration’ parameter in the Time Series operator.

Corner and Crosshairs

Option Description

Crosshair
style

Sets the visual style of the crosshair to be used in the Main Window.

Crosshair
color

Sets the colors of the crosshair to be used in the Main Window. Crosshair color options include red,
yellow, magenta, white, green, and blue.

Font Style Controls the font style of the displayed text in the Main Window.

Font Size Controls the size of the text displayed in the Main Window

Crosshair
thickness

Controls the pixel width of the crosshair lines

Crosshair
Opacity

Controls the opacity of the crosshair lines

Preview
Panel

Displays a preview of the font and cross-hair selections.

Corner Info Launches the Corner View Information dialog which controls the information to be displayed on each
corner of the slice views.

The Corner View Information is organized into two tabs: one for information shown on the screen view and one for
information that will show on the image when it is saved out. The corner information is organized into the four corners of the
image as can be seen in the corresponding four editable text areas. These text areas support a combination of regular text
input and also field expansion by the use of tokens prefaced by the percent character. As you add tokens a helpful check
mark will be shown next to the field indicating that it is included in one of the four corners. We also have added a helpful
Expand Parameters button so you may more easily read through the included fields. Also included are three preset buttons
for common corner view settings: None, Basic and Advanced. These were determined by Image Analysts to be commonly
used templates; which can be configured through the registry settings.
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Corner View Screen Layout

The File Output tab expands on the Screen tab functionality with the addition of more configurable templates. There is also a
handy Load Current Screen Corner button to copy the corner screen information over to the current template you are
configuring.
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Corner View File Layout

The Manage Templates dialog allows you to create up to seven templates, delete and rename them. Once you save the
current list you will access to them via the Select Templates dropdown option.

Manage Templates

The Add Template option can be accessed either from the Manage Templates dialog or on the upper right of the File Output
tab.
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Add Corner Template

One additional feature is the addition of three customizable corner fields that can be changed via the Save Image and Save
Movie dialog. These custom fields are called: SubjectID, TimePoint, and Group. If any of these field parameters are present in
the currently selected corner view template then the corresponding editable text fields will show up in the save dialogs. This
feature was requested as a time saver when the user is spending a lot of time saving images and needs to make quick label
adjustments. Although the use case was specific to these three field names anyone can use these fields for their own custom
information; the three names are only mappings from the corner template to these save dialog fields.

Save Corner Label Extra Options
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File Output Custom Fields

Volume Renderer

Option Description

Frame Time -
Display

Sets the display duration for each MIP projection image during MIP Controller playback.

Frame Delay
- Movie

Sets the delay time between MIP frames in a saved movie.

Sync mode If enabled, only completed MIP frames will be displayed. If disabled, the MIP will freely rotate at all times
but will display a message in place of the MIP for uncompleted frames.

Requested
Vol Rendered

Sets the MIP image volume rendering unit. Options are: Smart, CPU and GPU.

Color Palettes
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Option Description

Type Sets the method for determining the color palette range.

Palette The default Color Palettes for the first three loaded volumes of each Modality are set. Inputs beyond the third
loaded volume of a particular modality follow the palette of the third one.

Color Theme

Option Description

Color
Mode

Changes the general appearance of VivoQuant’s menus, buttons and windows:
   - Default (use the native appearance of the Operating System) 
   - Dark
   - Light 
*Note: On MacOS only, the Default option is replaced by the System option which will follow the Dark/Light system’s
configuration from System Preferences -> General -> Appearance. It is not yet supported on other Operating Systems.
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Data
The Data panel contains options for data handling, including data loading, quantification, management and processing.

Data Panel

Data Loading

Use the Data Loading panel to set loading options.
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Option Description

Disable
MIP viewer

Check the box to disable the MIP viewer upon loading. For large datasets, this can improve the loading
speed.

Ask Disable
MIP

If enabled, VivoQuant will ask for your permission to initialize the MIP viewer upon loading. For large
datasets, this can improve the loading speed.

Grow
reference
to input
volume

Choose ‘yes’ to allow the addition of zero-padding to a reference image for it to match the volume of an
input image, or ‘no’ to keep the reference image size static (and potentially crop the input image if it is
larger than the reference). Choose ‘ask’ to allow a window to appear upon loading, in an input, a data set
that is larger than the image in the reference position.

Max
voxsize
ratio for
vol.

Specify the maximum pixel ratio (largest pixel dimension / smallest pixel dimension) by which a data set is
interpolated as a volume image file.

MinVoxSize Specify the minimum allowed voxel width. Data will be resampled upon loading if their voxel width is less
than the specified minimum. The voxel width will be doubled until it exceeds the minimum.

Anchor
input data

Specify where to anchor the input data. Data can be anchored at the following options: center, head, or
foot.

Longest Dimension

In the above image, LD represents the out-of-plane resolution and the X and Y represent the in-plane resolution. If the pixel
ratio of the loaded image exceeds the given threshold, i.e. MaxVoxSizeRatio < LD/X, the data set will be loaded as a planar
2D by n file. Below is an example MR image loaded as a planar 2D by n file.
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Planar

If the pixel ratio of the loaded image is less than the given threshold, i.e. MaxVoxSizeRatio > LD/X, the data set will be loaded
as an interpolated volume image with isotropic voxels. Below is an example MR image loaded as an interpolated volume file.

Interpolated Volume Image

 Note: Other modalities besides MR can be loaded into VQ as planar or interpolated volume files based on the Max voxsize
ratio for volume setting specified in the configuration window.

As described on the Open DICOM Data help page:

If the ‘Force Planar’ check box is checked in the Data Browser, then the image will load in planar mode regardless of the
value set for MaxVoxSizeRatio.

If the ‘Force Planar’ check box is unchecked in the Data Browser, then the image will load in the appropriate mode
according to the value set for MaxVoxSizeRatio.
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Quantification Options

Use the Quantification Options panel to set options used by the Projection++ Operator and the 3D ROI Operator.

Option Description

Units of
Activity

Select the unit to be used for quantifying both PET and SPECT data. Options include MBq, kBq, mCi, and µCi.
Note: Concentration units (e.g. nCi/cc) will not be converted to the unit of activity specified. The Multi-Atlas
Segmentation and 3D Brain Atlas Tool plugin modules do support converting from concentration units to
units of µCi.

CSV
Separator

Choose the CSV file delimiter of their choice, applied when saving Quantification data.

Convert
native
units for
ROI
output

Enable this option if would like ROI output operations to attempt to convert your data to the unit specified in
the Units of Activity drop down box mentioned above.

Grow
ROIs to
reference

Choose if the ROI object should be resampled when the dimensions and or voxel sizes of the reference image
are changed.
   - Ask (a prompt will be displayed to ask for the desired behavior) 
   - Yes (ROIs will be resampled to match the reference’s dimension)
   - No (ROIs will be embedded into an object matching the reference’s dimension) 

Quant.
Table
Items

Available here on MacOS only. See the Projection++ Operator and 3D ROI Operator sections for other
Operating Systems.

Data Manager

The Data Manager panel contains options for handling data.
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Option Description

confirm
moving

Check to enable a confirmation message when rearranging data in the Data Manager.

Show
seconds
in
Browser

Check to display the seconds in the study date column in the DICOM browser. VQ has to be restarted to
configure this change.

Apply
default
shift

Check to apply a default reorientation to data being loaded into VQ. The default shift can be defined in the
Reorientation/Registration operator. For more on this, please see the Reorientation/Registration page.

Collapse
Dynamic
Data

If enabled, dynamic frames from the same series will be loaded into the data manager as a single input. If
disabled, each dynamic frame will be loaded into the data manager as a separate input. Regardless of the
setting, the data manager allows you to manually expand collapsed dynamic data, or collapse a set of dynamic
frames into a single input.

Config
DataList
Info

This button will launch the Data Manager Text Configuration dialog; within which, you will be able to
customize what meta data is shown listed for your data sources in the Data Manager.

Processing

Use the Processing Panel to set resource limits on data processing.

Option Description

ITK Max
Threads

If enabled, you can customize the number of threads used by ITK at runtime. If disabled, ITK thread
number will be set to its default value.

VTK Max
Threads

If enabled, you can customize the number of threads used by VTK at runtime. If disabled, VTK thread
number will be set to its default value.

ITK Priority If enabled, you can customize ITK thread priority. If disabled, ITK thread priority will be set to its default
value.

 Tip: Setting limits on image processing is particularly useful to prevent performance issues in multi-user setups.

Session data

VivoQuant may at times save a local backup of the current session state so that users can recover their session data. The
behavior of the recovery session mechanism can be controlled in the Session data panel.

Option Description

Max days to keep recovery sessions Recovery sessions older than the set days will be deleted on startup.

Cache

Vivoquant allows users to have more control over system resources by allowing the user to adjust the location of the VQ
cache.
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Option Description

Cache Path Various VQ utilities will be using this location in support of computations and data handling.

Page 29



DICOM Settings
The DICOM configuration allows the user to add/edit DICOM repositories. These repositories can be local folders containing
DICOM files, or DICOM network servers located whether on a local or a remote computer. The DICOM Dump uses the
DICOM Dictionary to identify information in the DICOM header. Check the How-To guide for more information on
configuring the NanoSPECT’s DICOM Servers in VivoQuant.

Getting There

The DICOM Repository can be accessed in three different ways.

Ddex is accessible via the Repository panel in the Data Browser. To open the Data Browser, click the  icon.

Repository Panel

The second method is by selecting the Configuration option in the Tools menu, and then click on the DICOM panel.

Configuration Option

The third method is by opening the Configuration panel using the “Ctrl+Shift+C” shortcut. For more information on keyboard
shortcuts in VQ, please see Keyboard Shortcuts.

Configuration Dialog

The DICOM panel in the Configuration dialog box provides the most in-depth DICOM information available in VivoQuant.
The DICOM panel consists of three sections: DICOM Settings, DICOM Cache, and Captures.
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DICOM Settings

DICOM Settings
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Option Description

DB path Location of local DICOM database. Allows optimized internal access to the Mediso DICOM database. See
Optimized local access, for details.

Repositories List of available repositories. The bank of buttons immediately beneath the pulldown menu operate on the
selected repository in this field:

Checks connection to DICOM repository. Local folders are verified to exist and a C-ECHO is sent to
DICOM servers.

Adds a new repository

Deletes selected repository

Opens the DICOM repository editor DICOM repository editor

Dictionary Shows list of additional dictionaries used by the DICOM library. Please set environment variable
DCMDICTPATH to set this value. For more information on the DICOM dictionary, see DICOM Dump

Rcv Port Port over which the DICOM peer sends data.

load palette
%

If enabled, the palette window will be loaded in accordance with the image data. If disabled, the palette
window will be set to whatever the window was set to last.

DICOMDIR Checking this box enables support for DICOMDIR files.

Folder Filter Allows users to specify the type of DICOM files loaded into VivoQuant. Users can configure loading
extensionless dicom data by adding a space and * to the end of the default settings: 

Override
FOR

A Frame of Reference (FOR) is a coordinate system that ensures the spatial relationship of images within a
series. It also allows for images across multiple series to share the same FOR. VivoQuant allows users to
choose among different behaviors regarding this setting.
Yes: the system will always overwrite the FOR settings and apply co-registration when loading a DICOM
series of images.
No: the system will never overwrite the FOR settings of the DICOM image series and will always apply co-
registration.
Ignore: the system will neither overwrite the FOR settings nor apply co-registration.
Ask: the system will provide the user with the option of choosing one of the previous options when loading
a DICOM image series.

DICOM Cache

The DICOM cache allows for the storage of frequently used data sets locally, thus improving load time into VivoQuant. Every
time VivoQuant is started, it checks the current size of the cache against the maximum cache size. If the current cache size
exceeds the maximum cache size, then older files (those opened least recently) are removed.
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DICOM Cache

Option Description

Current
Size

Size in Mb of the data currently stored in the DICOM Cache. The percentage to the right of the field indicates
how close the cache is to capacity.

Max size Maximum amount of memory that can be made available for the DICOM Cache (default = 1000.0 MB).

Life
Time

Length of time over which data will be stored in the DICOM Cache (default = 14 days).

Clear Empties the DICOM Cache.

Captures

Captures

Data Browser Repository Panel

The DICOM Repository panel, in the Data Browser, is the most convenient location for adding and editing repositories,
including DICOM Servers, local folders, and PACS Servers.

Repository Panel
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Option Description

Repositories List of available repositories. The bank of buttons immediately beneath the pulldown menu operate on the
selected repository in this field. Please click here to learn more about the DICOM repository section of the
DICOM browser:

Checks connection to DICOM repository. Local folders are verified to exist and a C-ECHO is sent to
DICOM servers.

Adds a new repository.

Edit: Opens the DICOM repository editor.

Opens a Windows Browser that can be used to select a local folder as a repository.

Fetches all DICOM meta data.

Removes repository from list.

DICOM repository editor

The DICOM repository editor is used to add repositories, including local folders, DICOM Servers, or iPACS Servers.

Local Folder

DICOM Server
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iPACS Server

Option Description

Displayed
Name

Name as shown in the repository selection box. Can contain any alphanumeric character.

Repository
Type

Indicates the type of repository containing the study data to be loaded into VivoQuant.

 Local folders are directories available on the local computer (also via a shared network). Directories
containing many files might take longer to scan. In this case, a DICOM server will perform better.

 DICOM servers are network services on the local or a remote computer. They provide a database to
efficiently browse study data.

 An iPACS server is an online PACS servers, a regularly used archiving and retrieval system for medical
images.

Local
DICOM
folder

Allows for browsing and selecting a local directory. All sub-folders will be displayed as projects in the second
repository drop-down window.

DICOM
server

AET is an Application Entity Title.

 Calling AET: must be a valid AET configured on the server.

 Called AET: name of the DICOM servers application entity.

iPACS
server

Username and Password are specific to the user of the site’s iPACS system.

 Hostname is the site of the server for the iPACS, and Port is the communication channel.

DICOM server

A DICOM server is specified by a calling AET, a Called AET, as well as a TCP address consisting of a host name and a port (the
default settings are localhost:104). The AETs must be configured on the DICOM server. For VivoQuant, use port 23104 on
the remote server.

iPACS server

An iPACS server is specified by setting the appropriate Hostname and Port and by entering user-specific Username and
Password. A DEMO iPACS server may be registered by using Hostname: demo.ipacs.invicro.com, Port 80, and leaving
Username and Password blank. iPACS servers also enable the use of Projects, a useful tool for organizing DICOM data.

Optimized local access

The optimized local access allows for a much faster access to DICOM data. To use this option enter ‘localhost’ (all lower case)
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as the hostname, and define the ‘DB path’.

iPACS Projects

The iPACS repositories allow for the use of projects. A project represents a directory structure for DICOM repositories. Data
may be stored and accessed via different projects, aiding organization of DICOM data. In the example below, an iPACS
repository for “bioscan/demo” is being configured. The “bioscan/demo” repository contains three projects.

iPACS Repository

If any projects are present within a configured iPACS repository, a second pulldown menu will appear in the Repository panel
of the DICOM browser. All projects within that repository are available via the second pulldown menu. The three projects
associated with the “bioscan/demo” repository are shown in the screenshot below.

Repository Projects

Select a project to view data associated with that project only.

Select Project

By default, data will only be displayed when the project to which it belongs is selected from the second pulldown menu. For
example, in this screenshot, no data appears in the “bioscan/demo” repository because all data within the larger repository
belongs to individual projects.
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Larger Repository

To simultaneously view all data belonging to a repository AND its projects, place an asterisk (*) at the end of the hostname
during repository configuration. The asterisk will cause all data within the repository and its projects to be displayed
recursively. This behavior applies across all repository and project levels.

Repository Data Display

How to configure the NanoSPECT’s DICOM Servers

First, open the Data Browser. Find the Repository panel and either select the pre-existing repository from the pulldown menu
or select “new” to create a new repository.

For the standard access on the NS Workstation (WS), use:
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Workstation DICOM Server

Option Description

Displayed Name NSxxWS_DCMSRV (or customer’s preference)

Type DICOM Server

AET INVIVOSCOPE

Called AET NSxxWS_DCMSRV

Hostname localhost

Port 104

where xx is replaced with the NanoSPECT number, typically no leading 0 for numbers \< 10.

The local access VivoQuant is able to access the DICOM Server directly, so there is no need to add the VQ as a client on the
DICOM Server.

The above table described configuring VivoQuant to access the Workstation DICOM Server. VivoQuant may also be
configured to access the Acquisition computer’s DICOM Server. The procedure is similar, but there is no WS in the naming
convention.
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Acquisition computer's DICOM Server

Options Description

Displayed Name ACQ_NSxx_DCMSRV (or customer’s preference)

Type DICOM Server

Calling AET INVIVOSCOPE

Called AET NSxx_DCMSRV

Hostname nanospectxx

Port 104

where xx is replaced with the NanoSPECT number, typically no leading 0 for numbers \< 10.

In place of hostname (i.e., nanospectxx), it is also possible to use IP addresses (i.e., 192.168.1.1 for local WS-ACQ computer
connections). Please verify that the hostname resolves by using ping hostname in a Command window. Also, in order to
access the ACQ computer from the WS computer, you must configure the DICOM Server on the ACQ computer.
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Network
The Network panel consists of two sections: Network Settings and Auto Import.

Network Panel

Network Settings

The Network Settings section includes an option for enabling a proxy server to be used with VivoQuant. There are fields for
entering a proxy and a port number associated with that proxy. The “Enable Online Check” checkbox will automatically
detect any available proxy servers. If you believe a proxy server is needed, please contact your local IT representative.

Auto Import

The Auto Import allows you to designate a folder through which files can be automatically transferred into a Repository.
According to the setup in the above screenshot, DICOM files placed in the VQ-AutoImport directory will be automatically
imported into the NS00WS_DCMSRV repository upon the next restart of VivoQuant.
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Licensing

Getting There

The Licensing panel is available in the Configuration Window. Alternatively, it may be reached directly via the Help menu.

Contents

The Licensing panel contains information about the current active license type (either machine-locked file-based or a floating
license) as well as selected information about the user who owns the license.

Licensing is required to unlock most of VivoQuant features. Please see the Licensing Quick Guide for more details.
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Restricted tags
VivoQuant can be configured to disallow editing of specific DICOM tags. To control which tags can be edited, users can
modify the restricted_tags.cfg file included next to the VivoQuant executable in the installation folder.

Consult the DICOM standard for the names of tags that can be included in this file.

 Note: The macOS installer .dmg bundle is not write-able by default. Users should investigate tools like hdiutil to create a
write-able version of the installer with this file modified to distribute to end-users.
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Opening DICOM Data
The Data Browser provides convenient access to files in a DICOM server or any other specified iPACS Browser. From the
Data Browser, reconstructions can be started and files can be exported.

Getting There

There are three different methods to access the Data Browser.

The first method is by clicking the  icon in the Main Window.

The second method is to go to File > Data Browser.

Data Browser

The third method is to use the keyboard shortcut Ctrl+D. For more on keyboard shortcuts in VivoQuant, see Keyboard
Shortcuts.

Function

The Data Browser’s main window is split into five sections: Repository, Filter, Data, Study Browser, and Transfer.
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Data Browser Main Window

Repository

The Repository section displays the Data Browser or local folder from which data files are currently being displayed in the
Study Browser. See DICOM Configuration for more information on configuring your Data Browser, including the use of
projects in an iPACS repository.

This section contains a filter that allows users to reduce the project list to more easily search for a desired project. There are
three ways to filter the project list, as described in the following table:
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Filter
Option

Description Example

word Reduces project list
to all projects that
contain the given
word in their path.

Type exampledata in the projects filter to reduce the projects list to all projects with the
word exampledata in their path.

!word Reduces project list
to all projects that
do not contain the
given word in their
path.

Type !exampledata in the projects filter to reduce the projects list to all projects that do
not contain exampledata in their path.

&regexp Reduces project list
to all projects that
match the given
regular expression.

An example of a commonly used regular expression is the choice operator “|”, which
matches either the expression before or the expression after the operator. For example,
if the user types &exampledata|test in the projects filter, the project list will reduce to all
projects that have the word exampledata and all projects with the word test in their
path.

Press enter on the keyboard to apply the filter. The filtered number of projects over the total number of projects is displayed.
For example, the image below displays 7 out of 1743 projects with the word demo in their path.

Repository Filter

 Tip: For more examples of regular expressions supported by the projects filter, click here .

Filter

As the database grows, the Filter tool becomes useful for sifting through studies to find just the right one. Options for
filtering include Patient’s Name, Patient ID, Study Description, and Study Date. After entering values in these available

fields, simply hit the refresh filter settings button  to refresh the Study Browser. To view all the data again, hit the clear

filter button  to empty the fields, and hit  again to refresh the Study Browser.

 Note: filtering uses a Unix-like naming structure. For example, to find all studies that begin with Mouse, enter Mouse* in
the filter for Patient’s Name. To find any study containing I123, enter *I123* in the filter for Patient’s Name.

Also available in the filter options is the  function, used to expand or collapse the entries currently displayed in the Data
Browser. The first click will expand all data at the patient/study level; the second click will then expand at the series level; the
third click will collapse the series level; the fourth click will collapse patients/studies.
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Plus Function

The image below shows the project list on the Study Browser before expansion:

Before Expansion

After one click of the  button, the project list will be displayed as follows:
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First Expansion

After the second click of the  button, the series level will be displayed in the Study Browser:
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Second Expansion

 Note: Expanding large numbers of datasets can take several minutes.

Data

The Data section provides several functions for manipulating data, including sorting, finding, and opening.
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Show Data
Type

This pull-down menu is used to limit the data displayed in the Study Browser to a single modality (i.e.,
CT) or data type (i.e.,reconstructions).

Open Opens the data highlighted in the Study Browser. If a single data file is highlighted, it will be opened as
the Reference image. If an entire Study is highlighted, the Open button recognizes which data file is the
CT and sets it as the Reference. The Open button unloads data currently in VivoQuant and replaces it
with the highlighted data. More information on the relationship between the Study Browser and the
Open button can be found in the Study Browser documentation.

Append Appends the data highlighted in the Study Browser to the data sets already loaded into VivoQuant. For
example, if two data sets are selected in the Data Browser and three data sets are already loaded into
VivoQuant, then appending the two highlighted data sets will cause them to appear as data sets 4 and 5
in the Data Manager. Use the Open button to unload data currently loaded in VivoQuant and replace it
with the highlighted data.

Find Enables a search of the Study Browser by looking for user-defined text in one of the available columns
(Patient’s Name, Study Date, Study Description, or Patient ID).

Import Allows data from a local folder to be imported into another local folder, database, or iPACS repository.

Export Allows data to be copied to a local folder.

Apply default
shift

If checked, a pre-defined shift will be applied to reconstructed SPECT data when it is opened. See
Reorientation for more details on setting default shift values.

Auto-start
reconstruction

If checked, CT and NM reconstructions will begin automatically when the Open button is applied to
projection data in the Study Browser.

Force planar If checked, it prevents interpolation from being performed on data with non-isotropic voxels. By default,
data with voxel widths greater in the z dimension than in the x and y dimensions will be interpolated to
have isotropic voxels when the Open button is applied.

Stack 3D If checked, each 3D volume is loaded one on top of the other in a single series of images. If unchecked,
each 3D volume is loaded in the same space, as a separate series.

Data Formats

By default, the Data Browser supports data with *.dcm, *.dc3 or *.dicom extensions. To edit this setting and configure
loading in extension-less data from the Data Browser, navigate to the DICOM Settings page.

Study Browser

The Study Browser displays the data found in the selected Repository. The Filter, Show Data Type, and Find options can be
used to limit the data displayed in the Study Browser. In all cases, the data is opened with either the Open button or the
Append button. The Open button will unload data currently open in VivoQuant and load the highlighted data as Reference,
Input 1, Input 2, etc. The Append button will leave the currently loaded data unchanged and append the highlighted data. This
appended data may be accessed via the Data Manager.

At the top level, multiple files may be opened into the Main Window simultaneously. The Data Browser recognizes the files
in the study and opens them accordingly, setting the CT image as the Reference. If extra data is found, the Data Browser
provides the message: Ignoring extra data sets.
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Top Level

At the next level, single data sets from a study may be selected for viewing.

Second Level

This nested structure continues, depending on the format in which the data is saved. For example, for CT data saved in Single
Frame format, single slices may be selected for viewing.

Third Level

Ctrl-click and Shift-click options are also implemented to simplify data selection. This feature is useful for selecting multiple
subsets of studies for both loading them into the Main Window and exporting them.
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Multiple Selection

Right-Click function

The right-click function of the Data Browser is used as a shortcut for opening/exporting CT or NM data and sending it to a
batch job (HiSPECT or BatchCT for SPECT and CT data, respectively), reconstruction or DICOM dump. When working in a
local repository, the right-click option may be used to delete data.

To use this function, highlight either the CT or NM data and right-click. A box with a number of functions is then displayed.
The options vary depending on the type of projection data selected.

Within Database or iPACS Server

Right-click on the Helical CT or Helical SPECT scan of interest.

Right-Click

The Right-Click function provides various options, depending on the data type available.

Option Description

Open data Opens the selected data set in VivoQuant and loads it as the reference (see Open Reference).

Export to… Allows data to be copied to a local folder or to another Data Browser or iPACS repository.

Open in… Allows the data to be opened in an external Application.

Dump Header Sends the file to the DICOM dump tool, which displays the information contained in the DICOM headers.

Within a Local Repository
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When working in a local repository, the right-click button may also be used to delete data.

Delete Local Data

Transfer

The Transfer section of the Data Browser features a progress bar that shows the percentage of completion of the current
process.

Transfer Bar

Click the  button to cancel the current process. Click the  button to exit the Data Browser.
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Open Reference Data
The first data set loaded into VivoQuant is called the Reference because it is often a CT image used for anatomical reference.
When loading multiple data sets from the Data browser, VivoQuant recognizes CT data and automatically sets it as the
Reference. VQ is capable of handling several file formats.

Getting There

There are three different methods for opening data. The first method is to use the Open Data  or the Append Data 
thumbnails in the Main Window.

Main Window

The second method is to go to Open Data under the File menu.

Open Local Data

The third method is to use the keyboard shortcut Ctrl+O. For more on keyboard shortcuts in VivoQuant, please see Keyboard
Shortcuts.

Function

Selection of the Open Data option opens a navigation window from which the Reference data set may be selected.
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Navigation Window

File Formats

VivoQuant can handle a variety of file formats. The default options include:

1. DICOM: *.dcm, *.dicom, 1.*

2. TRaster: *.ras, *.res., *.bin

3. Raw: *.raw

4. Image Files: *.png, *.tif, *.tiff, *.jpg, *.jpeg, *.bmp

5. Other: *.img, *.nii, *.mhd, *.mha, *.fdf, *.dc3, *.vol

The navigation window also provides an option for displaying All Files, without specifying any of the above formats.
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Append Data
The second data set loaded into VivoQuant is called the Input data and refers to the SPECT data. When loading multiple data
sets from the Data browser, VivoQuant recognizes SPECT/PET data and automatically sets it as the input file. For dual
isotope imaging, two input data sets can be added simultaneously. VivoQuant is capable of handling several file formats.

Getting There

There are different methods for appending data. The first method is to use the “Append Data”  thumbnails in the Main
Window.

Append Data

The second method is to go to File > Append Data.

Main Window

The third method is to use the keyboard shortcut Ctrl+N to load input 1, and Ctrl+Shift+N to load additional inputs. For more
on keyboard shortcuts in VivoQuant, please see Keyboard Shortcuts.

 Note: An initial data set must be loaded into the Data Manager prior to appending data.

Function

Selection of the Append Data option opens a navigation window from which the input data set may be selected.
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Navigation Window

File Formats

VivoQuant can handle a variety of file formats. The default options include:

1. DICOM: *.dcm, *.dicom, 1.*

2. TRaster: *.ras, *.res., *.bin

3. Raw: *.raw

4. Image Files: *.png, *.tif, *.tiff, *.jpg, *.jpeg, *.bmp

5. Other: *.img, *.nii, *.mhd, *.mha, *.fdf, *.dc3, *.vol

The navigation window also provides an option for displaying All Files, without specifying any of the above formats.
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Open Raw Data
This option is used to load the raw data from studies.

Getting There

To load raw data, go to File > Open Local Data > Raw Data.

Open Raw Data

Function

Selection of the Open Raw Data option opens a navigation window from which the raw data may be selected.

Navigation Window

Once the raw data has been selected, a Raw Data Importer window appears which contains information about the data, such
as dimensions, voxel size, data type and file information. Most data is automatically populated from the file. Other data fields
have to be filled in by the user in order to provide VivoQuant with information on how to interpret the file. Once all the data
fields have been completed, click Load to import the raw data is imported.
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Raw Data Importer
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Session
Sessions allow the user to save the current working environment. The exact location in the software is saved along with the
image data that is currently loaded in the Data Manager. The operator or tool and parameters being used are saved as well. A
session can be saved to the local cache or exported as a compressed zipacs folder structure that can be used to share with
colleagues.

Sessions

Getting There

A session can be saved, loaded, or exported by selecting the appropriate option under File > Session in the main menu.

Save Session

Session Manager

The Session Manager allows users to load previously saved sessions, save new sessions and export sessions to save them
locally and/or on any iPACS available.

When saving a session, users can specify the desired repository and session name for easy sorting later.
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Session Manager

In addition to saving sessions locally or to a desired repository, users may also associate the saved session with a specific
project from within their desired iPACS repository. This allows for a more efficient access and organization of various
sessions across multiple projects.

iPACS Repository Session

When exporting a session, specify a location on the local where the compressed zipacs folder will be saved.
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Export Session

To load a compressed zipacs folder, go to File > Session > Load, and select the session from the appropriate folder. When
loading a previously saved session, the session GUI displays the name and date of each study and allows for easy sorting of
files . Users can click on any session to see a Preview of that session in the window.

Load Session

Right-clicking on a session in the Session Manager allows the user to delete that session, export it as a compressed zipacs
folder to a local storage location, or create a Public Link to the session. Public links can be copied to the user’s clipboard and
pasted into a report, email, etc., as desired.
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Public Link
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Navigation
The Navigation operator is selected by default when VivoQuant is opened. This tool enables the user to manually scroll
through the image slices and rotate the Maximum intensity Projection (MIP). Similar functionality is available via the View
Control tool.

 Note: this page is concerned with Navigation in Slice View. While navigation is similar in other view modes, the keystrokes
and movements described below may not produce identical behavior. For information regarding navigation in other view
modes, see the Tile View, Multi View, or MPR View sections.

Getting There

To enter the Navigation Panel, select Navigation from the pull-down menu on the VivoQuant front panel.

Navigation Panel

There are several methods for operating the slice control navigator. This section describes manual manipulation using a
mouse device. The View Control tool offers a wider array of options for controlling the Navigator window.

Function

Navigation through the viewports includes scrolling through slices, zooming and panning.

Navigation Function

Scrolling

To scroll through the individual slices, left click and move the mouse cursor up and down or to the side on the different
viewports (sagittal, coronal or transverse).

When in Slice View or in Multi View with Link Views checked, scrolling is not independent across viewports: scrolling in one
viewport will affect the other viewports.

Zooming

To zoom in or out within a viewport, hold the Shift key and move the mouse wheel forward or backward, respectively.
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Zooming is independent across viewports: zooming in one viewport will not affect the others, and all viewports may be
zoomed to different amounts.

Panning

To pan within a viewport, hold the Shift key and click and drag the mouse. Panning is independent across viewports: panning
in one viewport will not affect the others, and all viewports may panned to different amounts.

Resetting Viewport

At any time, the zooming and panning within viewports may be reset to their default positions by clicking the  icon located
on the toolbar.

Reset to Default

MIP-Specific Function

The functions for controlling the MIP are slightly different than the functions that control the slices.

VTK MIP

To freely rotate the VTK MIP, click and drag the mouse across the MIP. To zoom in and out, scroll the mouse wheel forward
and backward. To pan around the MIP, hold the Shift key and drag the mouse across the MIP. To rotate the MIP about a
fixed axis of rotation, hold the Ctrl key and drag the mouse in a circular motion across the MIP.
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VTK MIP

This information is also found in the MIP Control tool. For more information on using this tool, see the MIP Control page.

Tooltip

The tooltip feature is available by briefly holding a mouse left click on any of the three slice views (transverse, sagittal,
coronal) in the Navigator window. The tooltip feature displays (x,y,z) coordinate locations and voxel values for each displayed
data set for that (x,y,z) position.

Tooltip

This information is also found in the View Control tool. For more information on using this tool, see the View Control page.
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3D ROI Tool

Overview

ROI stands for Region of Interest and is used to describe a particular area or volume within an image for which the user
wishes to characterize some quantity or quality. The 3D ROI operator provides advanced tools for drawing, visualizing,
saving, and quantifying both 2- and 3-dimensional regions. This tool allows for having a voxel belonging to more than one
ROI. For example, a user could have an ROI that contains the whole brain and other ROIs for regions of the brain, meaning
that each voxel of the whole brain ROI would need to simultaneously be part of two different ROIs.

Invicro implemented overlapping of ROIs by adding layers. The user is able to add new layers in the 3D ROI Operator, select
an active layer, and create and modify ROIs in that layer independent of the contents of other layers. Overlapping is then
possible as each voxel can belong to various ROIs on each layer.

The previous ROIs approach limited the user to 256 ROIs, as it used an internal buffer of unsigned chars (1 byte per voxel).
To allow for multiple layers, the new approach keeps a list of buffers of unsigned chars that can be increased on demand by
the user up to a potential of 8 layers if the RAM allows it. The new maximum total number of ROIs was then increased to
2048, and each voxel now supports up to 8 overlapping ROIs. However, the allocated RAM for the ROIs object increases
significantly as the user adds more layers. We can also expect a small overhead execution cost when drawing the ROIs on the
image for display purposes, as the blending or the handling of the different layer will require more processing.

Getting There

The 3D ROI tool can be accessed via the operators pull-down menu on the VivoQuant front panel.

3D ROI Tool

When the 3D ROI Tool is selected, a 3D ROI Tool operator window is displayed.
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3D ROI Operator Window

Each tab of the 3D ROI Operator window provides a grouped set of functionalities.

Tab Description

ROI Loading, Saving, and Quantification Tools

Painting Tools

2D Drawing Tools

3D Segmentation Tools

Expert Settings

Layers

We use ROIs to label voxels in the image as belonging to a region, so we can extract quantitative information about that
region from the image. Layers allow the user to specify that a particular voxel belongs to multiple regions. Within a layer, a
given voxel can only belong to one region; that is, ROIs are associated with a layer. For example, one layer could contain
different brain sections, while another layer defines the entire brain.
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No brain sections defined

Whole brain ROI (green) defined in Layer 1
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Brain sections separately defined as ROIs in Layer 0

Cortex brain section (red) defined in Layer 0 over whole brain (green) of Layer 1
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Whole brain section (green) layered over cortex brain section (red)

Layers can be created and deleted from the strip of icons at the bottom of the 3D ROI Operator.

Layer Options

Relevant layer actions are described in the table below.

Icon Description

Add a Layer

Edit a Layer

Hide a Layer

Reset a Layer

Delete a Layer

Add a Layer

Click the Add Layer button  to create a new layer.
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A popup window will open, prompting the user to name the new layer and set the transparency of the ROIs by selecting an
alpha value.

Decrease the alpha value to increase the transparency of all ROIs in the layer.

Values range from 0% - 100% and change by 10% increments.

The option to make the layer hidden is not available during the layer creation process and appears greyed-out.

Add Layer

 Note: The maximum limit of layers in one session is 8.

Edit a Layer

Click the Edit Layer button  to edit a existing layer.

A popup window will open, allowing the user to edit the name of the selected layer, change the transparency of the ROIs by
adjusting the alpha value, or hide/unhide the layer.

Decrease the alpha value to increase the transparency of all ROIs in the layer.

Values range from 0% - 100% and change by 10% increments.

Edit Layer

Select Active Layer

Select the layer of interest from the dropdown Layer to set it as the Active Layer. The display will show the active layer, and
any layer actions, such as editing or deleting, will be performed on the current active layer.
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Active Layer

Hide a Layer

Click the Hide Layer button  to hide the active layer. Click the Hide Layer button again to show the layer.

Hide / Show Layer

Reset a Layer

Click the Reset Layer button  to clear the contents of all ROIs in the active layer.

Reset Layer

Delete a Layer

Click the Delete Layer  button to open options for the active layer.

Delete Layer

A popup window will open, prompting the user to delete or reassign the ROIs associated with the specified layer.

Delete Layer

To delete all ROIs in the layer, click OK.

To reassign the ROIs to another layer, click the Re-assign ROI Pixels check box and the greyed-out options underneath
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will become active.

Re-assign ROI Pixels

Verify that the layer selected in Target Layer is the layer of interest then select the Move Policy to apply.

Select Move Policy

Available Move Policies are described in the table below.

Move
Policy

Description

Overwrite ROIs from the layer being deleted (active layer) will trump any overlapping ROIs existing on the destination
layer. Use this option if you do not want any of the ROIs being moved to be changed.

Keep
Destination

ROIs on the destination layer will trump any overlapping ROIs existing on the layer being deleted (active
layer). Use this option if you do not want the ROIs in the destination layer to be changed.

Respect
Immutable
(default)

Use this option if the user wants ROIs from both the destination layer and layer being deleted (active layer)
to be preserved or overwritten based on pre-specified information. ROIs marked immutable from the
destination layer will trump any overlapping ROIs. ROIs not marked immutable from the destination layer
will be trumped by the ROIs from the source layer if overlapping.

New ROIs
from
Overlap

Using this option will create new ROIs in areas where the destination ROIs and the ROIs being moved
overlap. Use this option if you want the flexibility to decide how the overlap is handled.

ROI Creation and Deletion

ROIs can be created and deleted from the strip of icons at the bottom of the 3D ROI Operator.
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ROI Creation and Deletion

Icon Description

Add an ROI

Edit an ROI

Delete an ROI

Reset an ROI

Hide an ROI

Add an ROI

There are two methods for adding an ROI:

1. Add Via ROI Section Buttons

Click the Add ROI button  to open options for adding a new ROI.

Add ROI

A popup window will open, prompting the user to provide specific information for the new ROI, including:

The ROI’s name and color.

The layer to which the ROI should be added

 Note: The Number of ROIs per layer should not exceed the limit of 256.

The transparency of the ROI in the slice and MIP views.

To alter the transparency, increase or decrease the alpha values (a lower percentage will increase the
transparency of an ROI).

The ROI’s visibility by checking “Hidden” to turn the ROI off in all views.

The ROI’s ability to be edited by selecting “Immutable.”
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ROI Popup Window

2. Add Via Right-Clicking the Navigation Pane

Another option is to select any (or many) of the existing ROIs is to right click and select Add ROI. This will append a new ROI
to the end of the list.

Right-click Add ROI
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Edit an ROI

To edit an ROI, double-click the ROI to be edited to select it and click on the Edit ROI button  . A popup window will opens
and allow the user to change the name, color, transparency (Alpha), visibility, and state of immutability of the ROI. To make
ROIs immutable, check the boxes in the ‘I’ column.

Edit ROI

Another option is to right-click on any ROI in the operator and select Edit ROI.
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Right-click Edit ROI

Delete an ROI

To delete an ROI, double-click the ROI to be deleted to select it and click on the Delete ROI button  . A popup window will
open and allow the user to move the pixels of the selected ROI to either the background or another ROI.
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Delete ROI

Another option is to select one or many of the existing ROIs, right click, and select Delete ROI.
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Right-click Delete ROI

 Note: The ROI will no longer appear in the drop-down menu after being deleted.

Reset an ROI

To reset an ROI, double-click the ROI to be reset to select it and click on the Reset ROI button  . A popup window will
open and allow the user to move the pixels of the selected ROI to either the background or another ROI.
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Reset ROI

Another option is to select one or many of the existing ROIs, right click, and select Reset ROI.
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Right-click Reset ROI

 Note: The ROI will still exist after it has been reset, but it will no longer have any voxels associated with it.

Hide an ROI

To hide an ROI in the slice and MIP views without deleting it, double-click the ROI to select it and click on the Hide ROI

button  .
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Hide ROI

Another option is to select any one or all of the desired ROIs, right click, and select Toggle Hide ROI(s). All selected ROIs will
become hidden.
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Right-click Hide ROI

 Note: If the ROI is not immutable, it can be edited even if it is hidden.

ROI Loading, Saving, and Quantification Tools

The first tab in the 3D ROI Operator window features tools for basic input/output operations, quantification, and viewing
functionality. To freely navigate through the slices with the cursor, this panel must be active.
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Basic ROI Functions

The buttons in this tab perform several functions within the operator.
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Button Function

Load or save an ROI from disk or iPACS

Render ROIs in the MIP view

Reset the camera view

Reset all ROIs

Show the image histogram

Show the quantification table

Export the quantification table to disk

Perform a cut on an image using an ROI

Perform a copy or paste on an image using an ROI

Export ROIs into the Bed Removal tool

Load an ROI from Disk

The 3D ROI tool supports file formats of VQ 3D ROI (.rmha), RTSTRUCT DICOM (.dcm), and vtkStructuredPoints (.vtk). To

load an ROI from disk, click the Load ROI button  , select the Load from disk option and choose the desired ROI from the
file browser.

Although RTSTRUCT files are intended to be paired with a referenced image, VQ allows you to load any RTSTRUCT even if it
was not created for that image. If contours in the RTSTRUCT file overlap, the ROIs will be loaded in separate layers.
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Load ROI from Disk

Save an ROI to Disk

To save an ROI to disk, click the Load ROI button  , select the Store to disk option and specify a name and location for the
file. All existing regions will be written to the same ROI file.

When saving RTSTRUCT files, keep in mind that the RTSTRUCT file format specifies contours using locations from a
referenced image. If the referenced image was resampled, the origin was moved, or any other changes were made to the
image in VQ that would change the coordinate space of the image, the currently loaded image will need to be saved as well.
This is to enforce that the locations of the contour points in the RTSTRUCT file match the coordinate space of the new
referenced image.
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Save ROI to Disk

Load an ROI from an iPACS

To load an ROI from an iPACS, click the Load ROI button  and select the Load from iPACS option. The image data
currently loaded must have been retrieved from an iPACS, and there must be an ROI associated with that image already
stored on the iPACS.

If only one ROI exists for the image, that ROI will automatically be loaded. If multiple ROIs exist, the user will be given a drop-
down menu of available ROIs to choose from. The choices can be distinguished by the ROI creator’s iPACS username, date
and time of creation, region names, and file type (RMHA or RTSTRUCT).
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Load ROI from iPACS

Save an ROI to an iPACS

To save an ROI to an iPACS, click the Load ROI button  , select the Store to iPACS option, and select the desired format
(RMHA or RTSTRUCT) of the file that will be uploaded. The ROI will be automatically associated with the current image.
Unique filenames will be generated based on the creator’s username and the patient’s name from the image header.
Previously saved ROIs will not be overwritten. The files will be saved to a subdirectory of the current project on the
WebDisk, named roi.

Similarly to saving RTSTRUCT files locally, the contour points in the generated RTSTRUCT will be in the coordinate space of
the current image, so if resampling or other changes that affect the image’s coordinate space were performed on the image in
VQ, the current image will now be the referenced image for any RTSTRUCT. The reference image should be saved to the
iPACS before saving the RTSTRUCT so that the RTSTRUCT files are associated with the referenced image matches their
coordinate space.
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Save ROI to iPACS

Select Current Layer

By default, all layers are loaded or saved when loading or saving an ROI. However, the user can specify to save only a single
layer by loading or saving the current layer. This functionality is only supported for RMHA files. The RTSTRUCT file format
does not support layers because contours can be overlapping.
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Load or Save Current Layer

Merge ROIs from an iPACS or Disk

To append previously stored ROIs to a set of ROIs currently open in the 3D ROI tool, click the Load ROI button  and select
Merge from iPACS or Merge from disk, depending on where the additional ROIs are stored. The additional ROIs associated
with that image will be appended to the currently open ROI set in the 3D ROI viewer. Previously saved ROIs will not be
overwritten.
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Merge ROI

If there is any overlap of existing and merged ROIs, a new ROI will be created and named as a combination of the two ROIs
listed names. For example, if a portion of a “Heart” and “Liver” ROI overlap after a merge, the new combined ROI created will
be named “Heart/Liver”, and consist of only the specific volume of Heart and Liver that overlap.

To associate the combined ROI with the proper ROI, right-click the combined ROI and select Delete ROI. A popup window
will open and allows the user to move the pixels of the selected ROI to either the background or another ROI. Selecting
“background” will delete the ROI all together.
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Associate Combined ROIs

Center view on ROI

To center the field of view on the center of mass of a particular ROI, double click the ROI in the ROI Table.

Render ROIs in the MIP View

To trigger a new rendering of the current viewed ROIs in the MIP view, click the VTK button  .

Reset the Camera View

To reset the MIP view to the original orientation and size, click the Reset Camera button  .

Reset all ROIs

To reset all existing ROIs, click the  button and select Reset All. Empty ROIs will still exist under the same naming and
coloring scheme.
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Reset All ROIs

To delete all ROIs completely, click  and select Delete All. The background will be the only thing left in the ROI menu.
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Delete All ROIs

Show the Image Histogram

To view a histogram of the image or any subset of the image determined by an ROI, click the Show Histogram  button.
Choose the image used to generate the histogram by selecting it from the Data Set drop-down menu. The portion of the
image contributing to the histogram can be set under the ROI Controls by selecting an ROI from the drop-down menu.
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Image Histogram

Set Quantification Table Columns

To determine which quantitative fields will be displayed in the quantification table and stored to the iPACS, if applicable, go
to the Operator tab on the main menu, then select Quantification Table List.

Set Quantification Table Columns

The available quantification values are described below:
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Option Description

ROI Name of the ROI. You can left-click this field to enter comments.

Patient Patient’s name for the current study.

Series Specific data set in the study from which the data was calculated.

Modality Modality from which the data values for the row were calculated.

Color Color of the ROI as drawn in the display.

Voxels Total number of voxels contained in the selected ROI.

Volume Volume of the selected ROI in units of cubic millimeters.

Mean Arithmetic mean of values of voxels contained in the ROI.

StdDev Standard Deviation of values of voxels contained in the ROI.

Min Minimum value of all voxels contained in the ROI.

Max Maximum value of all voxels contained in the ROI.

Median Median value of all voxels contained in the ROI.

Sum Sum of all voxels contained in the ROI, sometimes interchangeable with ‘Uptake’

Unit Unit of voxels in the selected dataset.

Conc 10% Concentration (mean/volume) of the 10th Percentile of voxels contained in the ROI.

Conc 50% Concentration (mean/volume) of the 50th Percentile of voxels contained in the ROI.

Conc
Peakregion

Concentration (mean/volume) of the 3x3x3 cube of voxels with the greatest mean of all 3x3x3 cubes of
voxels contained within the ROI. Referred to below as Highest-uptake region.

Conc
Peakmax

Concentration (mean/volume) of the 3x3x3 cube of voxels that has at its center the maximum voxel of the
voxels contained in the ROI. Referred to below as SUVmax.

Conc Max Concentration (mean/volume) of the maximum voxel of the voxels contained in the ROI.

Conc Concentration (mean/volume) of all the voxels contained in the ROI.

Conc Unit Unit of voxels in the selected data set over volume (mm3).
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“Impact of the Definition of Peak Standardized Uptake Value on Quantification of Treatment Response”. Vanderhoek, et al. J
Nuclear Medicine, 2012. Link .

Show the quantification table.

To display the quantification table, including all existing ROIs, click the Show Table button  .

Show Quantification Table

Export the quantification table to disk.

To export the quantification table to disk as a comma-separated values (.csv) file, click the Export Table button  .

Perform a cut on an image using an ROI.

To remove voxels from image data based on an ROI, choose the desired ROI from the ROI selector and click the Cut ROI

button  . All visible images will be cut and the ROI will remain unchanged. The cut tool is useful for eliminating undesired
features in images, such as metal instrumentation that may appear in some CTs.

Show or Hide an ROI

To hide an ROI, Check the boxes in the H column. An ROI can also be hidden by selecting it and clicking on the Hide/Show
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button  .

Show/Hide ROI

Copy or Paste the 3D ROI

Click the Copy/Paste ROI button  to copy and/or paste ROIs between instances of VivoQuant.

Export ROIs into the Bed Removal Tool

Click the Export to Bed Removal button  to export ROIs into VivoQuant’s Bed Removal tool.

Import Layers and ROIs with Overlapping Regions

Certain image formats, such as PMOD VOI and DICOM RTSTRUCT, support overlapping regions inherently. VivoQuant’s 3D
ROI tool loaders handle the overlap appropriately.

 Note: Overlapping ROIs should be assigned to different layers.

Not only has the 3D ROI Tool been updated to be compatible with overlapping ROIs, but numerous pre-existing features also
successfully operate on the active layer supporting overlapping ROIs. These include: Segmentation Algorithms, Painting in the
slice views, Tooltip Pixel hovers, Reorientation Operator, Modeling Operator, Multi-view Visibility, VTK MIP, AutoRAD, MAS,
Brain Atlas and Smoothing Operator.

 Tip: The number of imported layers should not exceed the limit of 8. Number of layers should be efficient. Do not create
one layer per region; but rather, collapse regions to the same layer where possible.
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Painting Tools

There are several paintbrushes to choose from when creating an ROI. The sphere  , cylinder  , or  cube paintbrush can

be selected by clicking the corresponding radiobutton on the Painting tab  . The radius of the paintbrush can be set by
changing the number of pixels shown in the numerical spin box. These 3D paintbrushes extend across multiple slices. To
activate 2D mode, mark the ‘2D only’ checkbox. In 2D mode, the paintbrush will only paint on the current slice.

 Note: An ROI must be added before the painting tools can be used.

Painting Tools

ROIs can be drawn freely on any of the three slice views. The view currently being drawn in will be denoted as Active in the
upper left corner.

Each voxel can only belong to a single ROI. Painting over an existing ROI with a new ROI will place the painted voxels in the
new ROI, unless the existing ROI is immutable. (See Edit an ROI to learn how to make an ROI immutable.)

To erase voxels from an existing ROI, paint over the existing ROI with the ROI selector set to Background. Alternatively, set
the ROI selector to the existing ROI (from which to erase voxels) and hold down the Shift key while drawing. The Shift key
activates the background ROI for the painting tool, even if another ROI is set in the ROI selector.

Sync Pos

If “Sync Pos” is checked, then the non-Active slice views will be updated in real time to match the position of the drawing
tool on the Active slice. When this option is selected, drawing times will typically be slower.
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Sync Pos Option

Erode/Dilate.

The Erode/Dilate tool can be used to remove or add up to 5 layers of voxels from the input ROI. The erosion or dilation will
be applied to the currently selected ROI in the ROI selector.

If you would like the voxels that are being added or removed from the ROI to be put in an ROI other than the one currently

selected, mark the ‘Map to’ checkbox and choose the ROI to put the new voxels in from the drop-down menu to the right 
.

To perform the erosion or dilation, click the Checkmark button  .

Perform Erosion/Dilation
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2D Drawing Tools

The 2D drawing tools match the options available within the Projection++ Tool.

2D Drawing Tools

Choose the desired tool from the drop-down menu to begin drawing. Use the  button to delete a contour (this will not

delete the ROI). Use the  button to add the voxels within a drawn contour to the currently selected ROI.

Spline tool

Bully tool

Freehand tool

2D Thresholding tool

Spline Tool

Use the spline tool to define points between which smooth curves will be filled in. The base points can be moved by using the
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left mouse button to drag them. Additionally, points can be deleted by click on a middle point, or added by double clicking on
a curve. Once a shape has been closed by clicking the right mouse button, it can be re-opened by hitting Shift + middle click
on a point.

Bully Tool

Use the bully tool to nudge the drawn boundary inward or outward with a circle-shaped cursor. The cursor size can be
changed using the paintbrush size selector in the Painting Tools panel. This mode provides an efficient way to fine-tune an
ROI made in Spline or Freehand mode. You may select which image data you want to use as the input (“Ref” is the first image
loaded in the Data Manager, “Inp1” is the second, etc.) and the thickness of the tool, in the bully tool and for the following
three tools as well.

Freehand Tool

A freehand region may be drawn by moving the mouse while holding down the left mouse button. The region may be drawn
in segments through a series left clicks and closed with a right click.

2D Thresholding Tool

Use the Percentage selector field to set a threshold for the ROI. Specify the image on which to base the thresholding using
the drop-down menu.

Apply Spline Path to ROI and move to next slice

Apply Spline Path to ROI

Clear Spline Path

Apply Spline Path to ROI and move to next slice.

This button creates a 2D ROI within the spline path and moves to next slice.

Apply Spline Path to ROI

This button creates a 2D ROI within the spline path.

Clear Spline Path

This button clears the spline path and all points.

3D Segmentation Tools

The 3D Segmentation Tools are located in the Segmentation Algorithms tab  . They be used to apply different thresholding
techniques across input images and user-defined ROIs, as well as advanced ROI processing.

 Note: An ROI must be added before the segmentation tools can be used.
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3D Segmentation Tools

Setting the Input and Output ROI

The Input ROI must be selected from the Input drop-down menu before applying thresholding. If an ROI other than the
background is selected, only image pixels within the chosen ROI will be considered when thresholding is performed.

The Output ROI is the ROI specified in the ROI drop-down menu located at the bottom of the 3D ROI Operator window. If
the Output ROI is not empty prior to thresholding, the result of the thresholding will be added to the existing voxels of the
Output ROI.

Keep in mind that other ROIs may be overwritten if the result of a thresholding technique intersects them. To prevent other
ROIs from being altered, set them to immutable. (See Edit an ROI to learn how to make an ROI immutable.)
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Set Input/Output ROI

Choosing the Image Data

The segmentation algorithm will work on the data from the image specified in the Image drop-down.

Setting the Seed Point

For methods that require a seed, the cursor location at the time the thresholding is performed will be used.

Setting the Thresholds

For methods that require thresholds, use the number fields beneath the Image Selection drop-down. Click the Min and Max
buttons to the left of each threshold field to fill in the minimum and maximum values, respectively, from the selected image.
The unit is assumed to match that specified in the header.

Available Thresholding Methods

The thresholding methods available can be selected from the Segmentation Algorithm drop-down menu. After selecting a
seed and thresholds as necessary, click ‘Apply’ to perform the segmentation. The thresholding operation may take about a
minute to complete.
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Thresholding Methods
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 Requires Seed? Requires Thresholds?

Global Thresholding No Yes

Connected Thresholding Yes Yes

Neighborhood Thresholding Yes Yes

Otsu Thresholding No Yes

Confidence Connected Yes No

ROI Connected Yes No

ROI Max Size No No

Low-pass Smoothing No No

Bounding Cylinders No No

Interpolate Slices No No

Modal Smoothing No No

Connected Components No No

K-Means Clustering Yes No

ROI Max Size

The ROI Max Size filter can be used to fill holes in existing ROIs. Any connected components in the Input ROI that are
comprised of fewer voxels than the Max size specified will be mapped to the output ROI.
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ROI Max Size

Before/After ROI Max Size

Low-pass Smoothing

Use the Low-pass Smoothing filter to remove jagged surfaces from manually created ROIs. The amount of smoothing can be
controlled with the Low-pass radius parameter. Smaller radii will result in smoother ROIs.
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Low Pass Smoothing

Before/After Low Pass Smoothing

 Note: Smoothing ROIs contained in images with large dimensions can take upwards of 30 seconds.
Page 108

file:///home/runner/work/vivoquant-manual/vivoquant-manual/mirror/assets/images/operators_3droitool_lowpasssmooth.jpg
file:///home/runner/work/vivoquant-manual/vivoquant-manual/mirror/assets/images/operators_3droitool_beforeafterlowpass.jpg


Modal Smoothing

Use modal smoothing to reassign every voxel’s ROI value to the mode of the surrounding region specified by the given radius.
The amount of smoothing can be controlled by the Mode Radius and Iterations parameters.

Modal Smoothing

Bounding Cylinders

The Bounding Cylinders tool can be used to generate cylindrical ROIs that encompass each animal of a multi-animal image.
The number of animals is automatically determined and the cylinder radius can be configured. This algorithm works best on
NM images, but may also work on some CT images.
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Bounding Cylinders

 Note: If there are any ROIs present prior to using this tool, they will be deleted.

Generate Bounding Cylinders

Expert Settings

The Expert tab, presents the advanced settings of the 3D ROI Operator. For the typical user, these settings will not need to
be changed.
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Expert Settings

Data Group

By default, VQ ROIs are written in a compressed format. To extend compatibility with other tools (e.g., ITK), uncheck
“compressed.” If the ROI files will only be used within VQ, leave the “compressed” box checked.

Importing and Exporting ROIs

To import an ROI loaded in the Data Manager from an image file, click the Import button  and select the corresponding
dataset to import. To export a 3D ROI as an image to allow manipulations outside of the 3D ROI tool, click the Export button 

 .

Import / Export ROIs
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Rendering

If “auto” is checked, ROIs will be re-rendered in the MIP view automatically upon certain triggers. When unchecked,
rendering will only occur when the VTK button is used. For systems with less speed and memory, it may be helpful to select a
less demanding setting from the rendering quality combo box.

Segmentation

To add a curvature flow smoothing preprocessing step to the segmentation methods, check the “Smoothing” box. Use the
Segmentation fields to tune up the parameters of the segmentation methods. The Smoothing filter will use the Iterations and
Time Step settings; the Confidence Connected Thresholding will use the Multiplier and NeighborRad (neighborhood radius)
settings; the Neighborhoood Thresholding will use the NeighborRad setting.

Crop Range

To perform any of the thresholding segmentation methods on only a sub-region of the input image, follow these steps:

1. Open the Cropping operator from the Operators drop-down menu.

2. Use the red sliders to select the desired region of the image.

3. After you’ve selected the desired region, go back to the 3D ROI tool by selecting the 3D ROI operator from the
Operators drop-down menu.

4. In the Expert tab of the 3D ROI Operator, mark the Crop Range checkbox. Dashed red lines will appear on the image,
indicating the boundaries of the selected region.
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5. When the desired thresholding method is performed (see Segmentation Tools to learn how to use the Segmentation
panel of the 3D ROI Operator), only the region within the crop range will be segmented.

Undo/Redo Functionality

To undo/redo operations performed in the 3D ROI tool go to the View tab on ViviQuant’s main menu and click the Undo 

or Redo  button. The operation to be undone or redone will be described in the drop-down menu.Keyboard shortcuts are
also available for undoing or redoing an operation.
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Undo / Redo

 Note: The input ROI will be set to background whenever the undo function is applied.

The undo/redo functionalities are applicable to all functions performed on 3D ROI data itself. Operations performed to actual
volume image data cannot be undone or redone. For example, performing a cut on an image using an ROI cannot be undone
since it is applied to actual volume data and not just 3D ROI data.

 Note: To undo/redo filling a contour in the Spline Tool the user must navigate away from the spine tool window.
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Projection
The Projection Tool provides a means to quantify density and activity parameters in CT and NM, MR, PET, or SPECT images.
The tool provides several options for generating quantification data. There are multiple methods for setting the region of
interest, flexibility in selection of the quantification view direction, easy-to-read presentation of data found in the
Quantification Table, and options for saving and loading ROIs or plotting data.

Getting There

To access the Projection tool, use the View sub-menu in the Operator section of the main menu.

Access Projection

Using the Tool

Upon selection of the tool, the Projection panel appears. The first step in using the projection tool is to define a Region-of-
interest (ROI).

Define ROI

Choosing the View Direction

The ROI may be drawn in either the transverse (default), coronal, or sagittal plane. To toggle between these options, use the
View menu in the Operator tab of the main menu.
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Choose View Direction

In this example, using the default settings, the axial sliders determine the extent of the ROI in the axial direction. The region
or pre-defined shape described below determines the bounds of the ROI in the transverse plane.

Transverse Plane

By using the View menu, it is also possible to draw ROI boundaries in the sagittal plane or coronal plane:
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Sagittal and Coronal Planes

Choosing the ROI type

There are four ROI types, labeled as Modes:

Spline Points are defined, and smooth curves are drawn in between. The base points can be moved by using
the left mouse button to drag them. Additionally, points can be deleted (middle click point) or added
(double click position on curve). Once a shape has been closed (right mouse button), it can be re-opened
by using Shift + middle click on a point.

Freehand A freehand region may be drawn by moving the mouse while holding down the left mouse button. The
region may be drawn in segments through a series of left clicks of the mouse.

Bully Push lines out or into the object with a circle-shaped cursor. The size of the cursor is defined by setting
the Bully Rad field in the Options section. This mode provides an efficient way to fine-tune an ROI
made in Spline or Freehand mode.

Threshold A reference voxel is determined with a left click in the transverse window. The ROI is determined by
finding the region of voxels surrounding the reference voxels that share similar values to the reference
voxels. The threshold value establishes how near in value the boundary voxels must be to the reference
voxel.

Mouse Actions

Action Mouse Shortcut

Rotate ROI Shift + mouse wheel

Scale ROI Alt + mouse wheel

Move ROI Shift + left click

Once the desired ROI has been defined, click the Show Table button  or right-click on the ROI to open the Quantification
Table. This table contains a wide range of information, as described below.

Click the Clear button  in the Options section to clear the current ROI and begin drawing another.

 Note: The unit used for measuring CT attenuation is the Hounsfield Unit (HU), while the unit used for measuring activity in
the NM, MR, PET, and SPECT images is Mega-Becquerel (MBq), kilo-Becquerel (kBq), or micro-Curie (uCi).

VQ maintains the most recent ROI until a new ROI is defined. Each ROI for which data is collected is assigned a new color.
Note, for example, that editing a ROI following data calculation results in a change to the color of the ROI. Also, the MIP
reflects the currently selected ROI by shading the region encompassed by the ROI according to the appropriate color.
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Quantification Table

After defining the ROI, the quantification table will fill the following fields.

Quantification Table Fields

Field Description

ROI Name of the ROI. You can left-click this field to enter comments.

Patient Patient’s name for the current study.

Series Specific data set in the study from which the data was calculated.

Modality Modality from which the data values for the row were calculated.

Color Color of the ROI as drawn in the display.

Voxels Total number of voxels contained in the selected ROI.

Volume
[mm3]

Volume of the selected ROI in units of cubic millimeters.

Sum Total amount of attenuation/activity in the selected ROI for CT and NM, MR, PET, or SPECT data sets,
respectively.

Unit Unit of voxels in the selected dataset. CT data use Hounsfield units (HU). You can specify the units used
by SPECT data in the Data Panel of the Configuration Tool. Options include MBq, kBq, mCi, and µCi.

Concentration Total amount of attenuation/activity in the selected ROI for CT and NM, MR, PET, or SPECT data sets,
respectively, divided by the ROI volume.

Conc Unit Unit of voxels in the selected data set over volume. CT data use Hounsfield units (HU/mm^3). You can
specify the units used by SPECT data in the Data Panel of the Configuration Tool. Options include
MBq/mm3, kBq/mm3, mCi/mm3, and µCi/mm3.

Mean Average amount of attenuation/activity in the selected ROI.

StdDev Standard deviation is a measurement of the variability in attenuation/activity in the selected ROI from
voxel-to-voxel. The smaller this value, the more uniform the distribution of attenuation/activity in the
ROI.

Min Minimum attenuation/activity value of the voxels in the selected ROI.

Max Maximum attenuation/activity value of the voxels in the selected ROI.

ZRange Distance spanned by the axial sliders specified via slice numbers.

Quantification Table Options

Right-click on one or more entries in the Quantification table to view the following options:

Page 118

http://www.vivoquant.com/


Quantification Table Options

Menu Item Description

Plot data Plots the selected data on a line graph.

Data to
Quanti Calc

Calculates the Quantification factor with the acquired data.

Data to
SpecAct Calc

Calculates the specific activity with the acquired data.

Data to SUV
Calc

Calculates the standarized uptake value with the acquired data.

Submit ROI #*
to iPACS

Submits #* ROI (the selected ROI) to iPACS.

Remove line Deletes the entire row of the corresponding selected cell.

Clear table Deletes all information from the table, but not permanently. The table can be reopened by right-clicking
and the data for the corresponding selection will reappear.

Plot data

It is possible to plot the quantified data. This function is useful to look at changes in activity, concentration, volume, etc.,
particularly in gated, dynamic, and longitudinal studies.

To plot data from the quantification tool, select the column of interest (i.e., Sum, Mean, etc.), right-click on any element in the
column, and then select Plot Data.

The plotted data will open in a new window and may be saved into an output PDF file.
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Plot Data

Data to Quanti Calc

The calculator will automatically import the associated data.

Quantification Calculator

Data to SpectAct Calc

The calculator will automatically import the associated data.
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Specific Activity Calculator

Data to SUV Calc

The calculator will automatically import the associated data.

SUV Calculator

Operator Menu

The Projection operator also provides several options for saving quantification and ROI information, as well as viewing and
cutting options, and miscellaneous ROI functions. To access these options, click on the Operator section in the main menu.

File Menu
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Menu Item Description

Save table Saves the current Quantification table to a local file. Accepted formats include .csv, .txt, and .xls.

Append to
table

Appends the current Quantification table to a previously saved table.

Quantification
table list

Allows users to choose what fields to be displayed in the Quantification table.

Clear table Clears the current Quantification table.

Load ROI Loads a previously saved ROI.

Save ROI Saves the current ROI as a .roi file.

Submit to
iPACS

Submit the quantification data as a Data Point to the associated image on the iPACS.

View Allows users to choose the ROI view direction.

Cut outside
ALL

Clears all voxels outside the ROI within the currently selected slices, and all voxels outside the currently
selected slices. Slices outside the set axial range will be cleared entirely.

Cut Clears all voxels inside/outside the ROI within the currently selected slices, depending on which direction
(inside/outside) is selected. Slices outside the set axial range will not be affected.
- Apply ROI to all slices: Applies the ROI to every slice in the image.

Select FOV Creates a new ROI entry representing the field-of-view (the entire volume of the image). The
quantification table will be populated with this entry, labelled as FOV.

Copy table Copies the data in the Quantification table to the clipboard.

Close Closes the Quantification panel and returns the VQ to the Navigation screen.
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Reorientation / Registration Tool
The Reorientation/Registration Tool enables manual and automatic realignment of image data via translation, rotation, or
flipping. Reference and input data may be manipulated separately, and specific translation settings may be saved and/or
loaded for future studies, including the option for setting automatically applied default image shifts.

Getting There

The Reorientation/Registration Tool can be accessed via the tool pull-down menu on VivoQuant’s front panel.

Reorientation / Registration Tool

 

Using the Tool

Upon selecting the tool, the Reorientation/Registration operator window is displayed.

Reorientation / Registration Window

The Data Selector Widget is used to determine which inputs will be reoriented by the Operator.

ROIs can be selected by checking the ROI checkbox. By default, all ROIs will be subject to reorientation when the ROI box is
checked. If you wish to select only specific ROIs, click on the pull-down menu and select the desired ROIs. You may also
choose to simply view the ROIs while performing a reorientation, without performing the reorientation on the ROIs
themselves, by selecting View Only from the ROI pull-down menu.
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Select ROIs

The buttons at the top of the operator window perform various functions within the operator.

Option Description

Force re-render of VTK Viewer

Reset VTK Viewer position

Toggle ability to perform reorientation in VTK
Viewer

Resets current reorientation operation

Apply current reorientation operation

The Interpolator drop down menu designates which interpolator will be used during the transformation. The default
interpolator value is Linear.

 Tip: When manipulating atlases and other integer-only datasets, linear interpolation may be detrimental. The Nearest-
Neighbor (NNB) interpolator is recommended in these cases to preserve integer values upon transformation.

The Quick Preview option enables VivoQuant to render a low resolution version of the registration. Note: this toggle does
not execute a registration but only allows a faster low resolution rendering after a registration as been computed via the
Register button. Users can apply by clicking Apply in the Operator menu.

3D and 2D Manual Options

3D and 2D manual registration options are available in the first tab of the operator. Images/ROIs can be rotated up to 360
degrees around their X, Y and Z axis; translated in any direction along their X, Y and Z axis; and scaled in any dimension. The
reorientation will be performed on all images/ROIs selected at the top of the operator window.
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3D and 2D Manual Registration

Rotation is completed by either using the up and down buttons next to the box or by typing in the number of degrees
you wish to rotate the image. Once the desired positioning has been achieved, click ‘OK’ to apply the transformation.

Translation is achieved by scrolling the bar to the left or the right or typing in the number of mm to be moved in the box
below. Translation can also be achieved by holding the “Ctl” button on the keyboard and dragging images in the
Viewports.

Flips can be performed about any of the three axes by selecting the check box for Head/Foot, Left/Right, or
Anterior/Posterior.

Scaling can be enabled in the Operator menu. When enabled, images and ROIs can be scaled during reorientation by
scrolling the bar to the left or right or typing in the % by which to scale. To scale uniformly in all three dimensions,
check the “Uniform” box.

 Warning: When scaling data, please use caution, as scaling can lead to errors in quantitation. For more information, refer
to the Treatment of Quantitative Data page.

3D and 2D Automatic Options

3D and 2D automatic registration options can be found in the second tab of the operator. There are Basic Settings (default)
and Expert Settings available for each type of automatic registration.
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3D and 2D Automatic Registration

The default options for registering data include Translation, Rigid and Affine. The Translation registration is a rigid
registration which will shift the input data set in the (x,y,z) directions. The Rigid registration will rotate and translate the input
data set. The Affine registration is a linear transformation which will rotate, translate, shear and scale the input data set.

Transform Description

Translation Translations only

Rigid Translations and rotations only

Affine Translations, rotations, scalings, and shearings

Quality Description

Fast Fastest, but least detailed

Standard Average

Fine Slowest, but most detailed

The Expert Settings are intended for experienced users only and provide access to a variety of transform, optimization,
interpolation, and metric (figure-of-merit) schemes. User-configurable fields are also provided for the number of sampling
bins, minimum and maximum step length, maximum number of iterations, percentage of voxels to be used for registration,
and a relaxation factor.
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Expert Settings

Option Description

Transform Type of transform used

Optimizer Method used to determine how to move image in response to changes in metric

Interpolation Interpolator used during the registration procedure

Metric Metric used when calculating the similarity between moving and fixed images

Sampling
Bins

Number of bins used for calculating the histogram in the Mattes MI metric (only applies when Metric is
Mattes Mutual Information)

Sampling
Percent

Percentage of voxels in the image to use when calculating the metric (only applies when Metric is Mattes
Mutual Information, or Mutual Information)

Step Length
(min)

Minimum step size the optimizer is permitted to take

Step Length
(max)

Maximum step size the optimizer is permitted to take

Iterations Maximum number of iterations the registration process is permitted to take

Relax Scaling factor applied to the step size when the optimizer changes direction

A crop range can also be defined which, when enabled, will perform the registration optimization calculations based solely on
the voxels within the crop range. This can be useful when images have noise, regions of little to no signal, or other artifacts
that may affect optimization calculations. For information about setting a crop range, see Crop Range under Expert Settings
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on the 3D ROI Tool page.

To begin the registration, select the desired dataset and click Register. A window will appear that shows information about
the progress of the optimization.

Begin Registration

Menu Options

The Reorientation/Registration operator menu can be used for storing transformations, setting a default image
transformation, and controlling the behavior of the operator.
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Operator Menu
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Option Keyboard
Shortcut

Description

Load
Transformation…

Ctrl+Shift+L Applies a pre-defined transformation to the active data set.

Save
Transformation…

Ctrl+Shift+S Saves the current transformation settings (rotation, translation, flips) into a .xml file.

Save as default  Saves the current transformation settings (rotation, translation, flips) as default settings
for image data. If the Apply Default Shift checkbox is selected, these settings will be
automatically applied to any image data that then gets loaded. See the How To Guide
for more on setting a default image shift.

Reset Ctrl+R Resets all transformation settings (rotation, translation, flips) back to the default values.

Apply Ctrl+Return Applies the current transformation settings (rotation, translation, flips) to the active
data set.

Flips  Provides the option of flipping the data in any of three directions, described as
Head/Feet, Left/Right, and Anterior/Posterior.

Resample  Directs the user to the Resample Data tool. The Resample Data tool allows rebinning
of reconstructed data into an arbitrary voxel size.

Pre-compose  Transformation which applies T1 to the source, and then applies T2 to that result to
obtain the target.

Post-compose  Transformation which applies T2 to the source, and then applies T1 to that result to
obtain the target.

Reorient ROI
around center

 Sets reference point for transformation as center of ROI instead of center of image.

Enable scaling  Toggles appearance of Scaling under 3D and 2D manual registration panels.

Automatic Non-Linear Registration

The 3D Automatic Non-Linear Registration tool provides deformable registration of the data by computing a unique
transformation matrix for all voxels of data represented. After selecting your preference from the dropdown, the number of
iterations for each resolution level can be adjusted. Drop-down preferences include: Fast Symmetrical Demons, Symmetric
Demons, Diffeomorphic Demons, and Demons. To show the deformed grid overlaid or a heatmap of the Deformable vector
field over of the image, use the toggle buttons.

To learn more about the Non-Linear Registration techniques please visit the link below:

http://www.insight-journal.org/browse/publication/154
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Non-Linear Registration

Automatic Slice-by-Slice Non-Linear Registration

The 2D Automatic Slice-by-Slice Non-Linear Registration tool provides deformable registration of the data by computing
individual transformation matrices for each voxel of data represented. After selecting your preference from the dropdown,
the number of iterations for each resolution level can be adjusted.

To learn more about the Non-Linear Registration techniques please visit the link below:

http://www.insight-journal.org/browse/publication/154
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Slice-by-Slice Non-Linear Registration

How to Set a Default Image Shift

One of the most powerful features of the NanoSPECT is its ability to automatically register SPECT and CT data to create
anatomically and functionally valuable fused images. Imaging without the application of any transformation typically results in
data that are fused well within 1.5mm in any direction. However, taking the time to set up a default image shift can help
insure that all image acquisitions are perfectly fused.

Make a simple phantom, but one that breaks symmetry along multiple directions. A syringe with an air bubble, placed in the
bed at an angle works well.

Collect an image/CT of the phantom. It is recommended that standard reconstructions (or better) are used for both the image
and the CT to enable more precise transformation settings.

1. Uncheck the Apply Default Shift box located in the DICOM browser.
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Open Data

2. Load the data into VivoQuant.

Load Data

3. Use the reorientation tool to shift and/or rotate the image data set (Input 1) so that the image and CT data are perfectly
aligned. Typically, only shifts are needed for this operation. If rotations are needed, they should be only plus/minus 1
degree. Before clicking Apply, go to Operator > Save As Default and save the transformation
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Save as Default

4. Return to the Data Browser or go to the Tools Menu and re-check the Apply Default Shift box.

Apply Default Shift

5. Reload the image/CT phantom data that were just acquired. They – and all other data sets – will now be perfectly
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fused.

Reload Data

 Note: This same formalism may be used to generate other Transformation files. Instead of choosing Save as Default in the
operator menu, choose Save Transformation. Then, it is possible to later load that transformation (using the Load
Transformation option in the operator menu). These saved transformations are useful when fusing data from other
modalities with NanoSPECT CT data, for example.
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Time Series
The Time Series operator provides an easy way to visualize sets of dynamic data as a time series. This operator can be used
to play slice views of each image of a collection in sequence.

Getting There

The Time Series operator can be accessed via the pull-down menu on VivoQuant’s front panel.

Time Series Operator

Using the Operator

Data must be loaded into VivoQuant in the correct time-order, with the reference image (if any) loaded first. Use the Data
Manager to sort the datasets as necessary.

If there is a reference image loaded, check Lock Ref to keep the reference image visible with all other images of the series.
Check Lock Inp1 to keep the image in the Input 1 position visible with all other images of the series.

Lock Image

The Time Series operator also enables users to set a global windowing, which will apply to all loaded images. The windowing
format (either Min/Max or Level/Width) is determined by the Display Configuration. To set it, simply check the Global box
and enter appropriate windowing values into the respective boxes.

Timeline Settings

Timeline Settings

Use the slider or image index field to manually scroll through the datasets of the series. Click Play to run the sequence in a
loop.
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The Playback Speed pull-down menu allows you to select the frame duration for all frames. There are two groups available:

1. Uniform Frame Duration: Select a fixed frame duration to apply to all frames.

2. Variable Frame Duration: Choose between the following options:

Standard: Use the FrameAcquisitionDuration or ActualFrameDuration as obtained from the DICOM Header.

Logarithmic: Apply a logarithmic function to each frame duration obtained from the DICOM Header.

Square Root: Apply a square root function to each frame duration obtained from the DICOM Header.

Reduce Min to Sec: Reduce the duration of each frame obtained from the DICOM Header by a factor of 60.

 Note: The Variable Frame Duration option retrieves frame duration information from the DICOM Header. If this data is
unavailable or needs to be modified, the user can open the Frame Time Editor from the Tools menu to add or modify these
values.

The user can select the Other… option to add a custom frame duration.

The Show ROI option in Timeline Settings section enables or disables ROI’s on all frames.

Timeline

Timeline

The Timeline section displays a list of frames with preview images. Here, users can select the duration and enable or disable
ROIs for each individual frame. Multiple frames can be selected to apply changes simultaneously.

Default Frame Duration

When the Time Series is opened, it uses a default frame duration. This value can be changed in the Configuration Tool under
the Display tab in the General section.

Saving a Movie
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To save a Time Series movie, open the Save Movie dialog with the Time Series operator. This can be done by clicking the

Save Movie icon in the toolbar  ; by navigating to File > Save Movie, or by the keyboard shortcut Ctrl + M.

The options for the output movie are similar to those in the regular Save Movie dialog box. The only difference is that the
options in the Movie Type drop-down box reflect the Time Series movie types. Once the desired options are set, click Save
to save the movie file.

Save Movie
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Distance / Annotation Tool
The Distance/Annotation tool enables you to measure the distance between two points in any image. For example, it can be
used to measure the size of a tumor by measuring its length, depth and width. One of the most powerful options available
with the distance measure is the capability to perform landmark co-registration.

Getting There

The Distance/Annotation tool can be accessed via the tool pull-down menu on VivoQuant’s front panel.

Distance / Annotation Tool

Using the tool

Upon selecting the tool, theDistance/Annotation operator is displayed. The physical distance between two points can be

measured by clicking on the Add New icon  to add an object. To measure distance, left-click on two points of the image.
A line is displayed between the two points to show what is being measured.

In the Distance/Annotation operator, each line is identified by a unique color tag. For each line, the 3D start and end points
of the line are displayed as well as the length of the line (in mm). Multiple distances can be measured on the same image and
are easily distinguished by their unique color. The results can be saved into an Excel file by clicking Save. The Profile function
enables a graphic plot of the distance to be displayed for both the reference and the input data.

Add Object

Goto with-in the object

Since a single left click sets a new point, you have to use a single middle mouse button click to go to the given position in the
two respective other slices.

Removing Distance Measures

Right-click on any of the distance measures and click Remove to delete the distance measure completely.
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Remove Distance Measure

Profile

The Profile tool plots the values in each voxel through which the line passes. Values are displayed for both Reference and
Input data sets and, given proper calibration, the plot values will be in Houndsfield units and MBq for CT and NM data sets,
respectively. The File menu provides an option to save the Profile data as a PDF.

Profile Tool

Landmark Circle Detection
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This feature is triggered via the Landmark Circle Detection icon  . Landmark Circle Detection is basically a way to find
circles in the image slices that can be used as anchor points for image registration, and is effectively used by Reorientation /
Registration via the Landmark tab option.

Landmark circle detection employs an algorithm known as Hough Circle Detection. This algorithm works best if you first
create circle annotations around the circles in one slice of the image; this helps the algorithm by seeding it. The more circle
annotations the better the registration will be. When you click the button the algorithm will use your annotations as known
circles and will try to interpolate and detect the same circle in all other image slices, populating new annotation shapes into
the list for each. Without any supplied annotation circles the Hough settings dialog will appear and allow to you to tailor the
algorithm for automatic circle detection.
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Checker Board
In Checker Board mode, the reference and input data sets are arrayed in a pattern of alternating squares. This mode is
especially useful when checking image registration.

Getting There

The Checker Board tool can be accessed via the tool pull-down menu on VivoQuant’s front panel.

Checker Board Tool

Using the Tool

Upon selecting the Checker Board tool, the display of the coronal, sagittal, and transverse windows is automatically updated.
In these windows, the reference and input data sets are displayed in an alternating grid pattern. Both the Input 1 and Input 2
data sets are displayed in the same squares of the checkerboard. To return to normal viewing, select Navigation in the Tools
menu. To adjust the size of the tiles, hold Shift and use the mouse wheel.

Using the Tool
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Cropping Tool
The Cropping Tool allows images to be made smaller by removing any unwanted areas. For example, if an image has been
cut, then the cropping function can be used to trim away the blank areas of the image.

Getting There

The Cropping tool can be accessed via the tool pull-down menu on VivoQuant’s front panel.

Cropping Tool

Using the Tool

Upon selecting the Cropping tool, the standard view options disappear and red sliders are displayed in their place.

Cropping Sliders

Two red sliders appear for each view direction (i.e., coronal, sagittal, and transversal). The red sliders may be moved using the
mouse (click and hold on a slider and then move the mouse to move the slider) or by using the arrow keys in the cropping
dialog. Manipulation of the red sliders creates a three-dimensional rectangular cropping volume. The current voxel position
of the red sliders is displayed in the Cropped Area section of the operator window.

To apply the crop, once the red sliders are in the desired positions, click the Crop button  .

To reset the crop range sliders to their original positions, click the Refresh button  .

The Cropping dialog provides information about the pixel location of each red slider (x, y, z), and current and cropped image
size information in both voxels and mm. The embed function will pad background slices to increase the dimensions of the
image. The auto-crop feature starts its search at the end slices of the image and adjusts the sliders towards the center of the
image until a non-background voxel is detected from all 6 faces.
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Arithmetics
The Arithmetics operator can be used to add, subtract, multiply, divide, average or merge multiple images. Additionally, a
scalar multiplier or addend can be applied to all voxels of an image with the Arithmetic operator.

Getting There

The Arithmetics operator can be accessed via the tool pull-down menu on VivoQuant’s front panel.

Arithmetics Tool

Using the Tool

Upon selecting the operator, the Arithmetics window is displayed.

Arithmetics Tool Window

The main drop-down menu in the operator window contains a selection of the available operators. In some cases, multiple
images can be selected for the operation via the Data Selector Widget.

Add, Subtract, Multiply, Divide, and Average: each of these operates on two images. These operations are performed
voxel-wise.

Scalar Multiply and Scalar Add: can be applied to any of the loaded images. Set the factor or addend by increasing or
decreasing the scalar value.

Weighted Average: applies a time weighted average across the selected dynamic images. Weights can be set manually
per-frame or derived from DICOM header entries.

Merge whole integer value phantoms to load into the 3D ROI tool. It can be applied to any of the loaded images. This is
very useful for fixed-volume ROI analysis.
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Merge

Click OK to perform the chosen operation. A dialog will appear to indicate successful application of the chosen function.

Operation Applied

For all arithmetic operations, the user has the option to append the resulting volume(s) or perform the function in-place, thus
replacing the existing data with the amended data.

Data List

Units are considered by the Arithmetics operator. A warning will be displayed if an attempt is made to add, subtract, multiply,
divide or average two images of differing units and will allow the user to halt the operation.
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Arithmetic Units
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Filtering
The Filtering operator offers a variety of smoothing filters with configurable input parameters and can be applied to any of the loaded images.

Getting There

The Filtering operator can be accessed via the tool pull-down menu on VivoQuant’s front panel.

Filtering operator

Using the Tool

Upon selecting the tool, the Filtering operator window is displayed.

Filtering operator window

Using this tool, any loaded data can be selected for smoothing via the Data Selector Widget.

Select the desired smoothing algorithm from the available options in the Smoothing drop-down menu. Use the parameter fields to set
appropriate values. The effect of the chosen smoothing filter will be previewed in 2D in the slice views. To remove the 2D preview, go back to
None in the drop-down menu of smoothing filters.

Currently available filters include:

Gaussian Smoothing

Curvature Flow

Gradient Anisotropic Diffusion

Curvature Anisotropic Diffusion

Positivity Smoothing (to remove negativity from FBP reconstructions)

Zero Crossing Edge Detection

Bilateral Smoothing

Bias Field Correction

Each filter uses a different subset of the configurable parameters. See the table below if parameters other than the default settings are desired.
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Parameter Description Used by Default
Value

Append Bias
Field

Append the estimated bias field as an image Bias Field Correction not
checked

FWHM Full-width half-maximum kernel size Gauss, Zero Crossing Edge Detection 1.00mm

Conductance Parameter governing sensitivity to edge contrast Gradient Anisotropic Diffusion, Curvature Anisotropic
Diffusion

1

Control
Points

Set the control point grid size defining the B-spline
estimate of the scalar bias field

Bias Field Correction  

Converge
Threshold

Minimum difference between estimates needed to
end iterations

Bias Field Correction 0.001

Downsample
Factor

Factor by which image voxels will be downsampled
before calculating the filter

Bias Field Correction 2.0

Iter, Max Iter Number of iterations Curvature Flow, Gradient Anisotropic Diffusion,
Curvature Anisotropic Diffusion, Positivity Smoothing,
Bias Field Correction

5

Iterative
Otsu

Toggles option to use ROIs as a mask Bias Field Correction checked

CutOffFrac If the fraction of voxels that are negative falls below
this value, further iterations of the filter will not be
performed.

Positivity Smoothing 0.005

Time Step Stepsize, effectively analogous to kernel width Curvature Flow, Gradient Anisotropic Diffusion,
Curvature Anisotropic Diffusion

0.125

Mask ROI masks to use to limit filter context Bias Field Correction background
ROI layer

Max Error Difference between the area under the discrete
Gaussian curve and the area under the continuous
Gaussian

Zero Crossing Edge Detection 0.5

Range Sigma The standard deviation of the gaussian blurring
kernel in the image range. Units are intensity.

Bilateral Smoothing 50

Domain
Sigma

The standard deviation of the gaussian blurring
kernel in each dimensional direction. Units match
image spacing units.

Bilateral Smoothing 4

Spline order Sets the spline order defining the bias field estimat Bias Field Correction 3

The smoothing function is executed by left-clicking on OK. Depending on the image size and filter selected, this may take several seconds. Once
the smoothing function is applied, any subsequent operations will be based on the smoothed images.

Each filter will have different edge-preserving and noise-reduction properties. Choose the one that best suits your application.
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No Smoothing Gauss Curvature Flow Gradient Anisotropic
Diffusion

Curvature Anisotropic
Diffusion

The bilateral smoothing filter could take several minutes for large images in 3D, especially for greater values of domain sigma. Check the Force
2D option to speed up this filter.

No Filtering Applied Various Bilateral Smoothing Parameters

The positivity smoothing filter will also typically take longer to run than the other smoothing filters, up to several minutes for larger images. This
filter was specially designed to redistribute the activity across neighboring voxels such that the total sum of the image is preserved but the
number of voxels with negative values is reduced. It is intended to be used to correct images reconstructed with FBP.

Bias Field Correction

Intensity gradient artifacts in magnetic resonance imaging can often cause difficulties with automated segmentation and analysis tools that rely
on intensity contrasts, not to mention the detriment to qualitative appearance. The Bias Field Correction filter implements the N3 bias
correction algorithm (Tustison 2010) to estimate the gradient field present in the image and uses this filter to normalize each voxel of the image.
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Due to the higher performance cost, a preview of its filtering is not available but the filtering can be applied via the filtering operator. The user
may optionally adjust the field smoothness to avoid or allow high spatial frequency corrections and also append the estimated bias field as an
image to the DataManager.

Bias Field Correction
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Modeling
The Modeling operator provides an integrated solution for representing the loaded data set with one of the following
relevant mathematical models to allow for predictions and analysis.

Getting There

The Modeling operator can be accessed via the tool pull-down menu on VivoQuant’s front panel.

Modeling Tool

Function

Upon selecting the tool, the Modeling operator window is displayed.

Modeling Tool Window

Appropriate data should be loaded into VivoQuant in the correct order, with the reference image (if any) loaded first. Use the
Data Manager to sort the datasets as necessary.
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From within the Modeling operator drop-down, you can select the specific mathematical model applicable to your analysis.
Once chosen, the operator window will fill with the model’s parameters and settings.

 Note: Access to models depends on your specific VivoQuant license. For information regarding your license, please
contact your account manager or email support@invicro.com.

Models

MR Models

MR models are included with every VivoQuant license. These models include T2, T1, ADC, Fat and GLM.

Pharmacokinetic Models

Pharmacokinetic models are available as a plug-in for the Modeling operator. These models include the Two-Tissue
Compartment Model (2TCM), One-Tissue Compartment Model (1TCM), Logan Graphical Method, Simplified Reference
Tissue Model 1 & 2 (SRTM/SRTM2), Logan Non-Invasive Graphical Method, and Patlak Analysis. Detailed information for
these models may be found on the Pharmacokinetic Modeling page.

 Note: Access to models depends on your specific VivoQuant license. For information regarding your license, please
contact your account manager or email support@invicro.com.
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Splitting

Overview

This operator allows the user to create and modify shapes to extract areas of interest. It is at its heart an elaborate cropping
operator. The geometric properties of the shapes will ultimately decide the eventual splitting operation while the stylistic
options are meant to help the user organize their workflow. Once fine tuning is complete the user can export the areas of
interest into new data sources. The exported files can be automatically loaded into the data manager or saved out to the file
system. There is also an additional option to control the orientation of the split data to aid in further analysis.

Getting There

The Splitting Operator can be accessed and launched via the operator pull-down menu on VivoQuant’s front panel.

Splitting Operator

The default widget will then populate into a UI pane.

Using the Operator

The first step in using the splitting tool is to choose a geometry, the options are Rectangle, Cylinder, Rectangle Group and
Cylinder Group. These basic shapes the user will modify to fit their desired areas of interest. The geometric properties will
ultimately determine the final extraction export.

Splitting Operator Geometry

The next step is to click the + button and expand the dropdown shape creation options. The option labeled New (Data State)
will create the shape with initial values that correlate well with the loaded data. The initial defaults in this mode will be based
on proportions of the currently loaded data size. This is a good way to start fresh, especially when using a new data source.
The second option labeled From Saved State allows the user to load a previously saved shape of the current type. If no saved
shape of that shape type is found a pop up will alert the user than one was not found and how to go about creating one. See
Saving State. A new shape created in this mode will not be automatically correlated with the data and will keep the saved
values unchanged.

Splitting Operator Creation Mode
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Once the shape is created and selected the fields of the shape will populate in the dialog.

Rectangle

The center options will adjust the position of the rectangle in three-dimensional image space, while the height, width, and
depth values will be defined relative to the currently selected plane. Stroke and Opacity can be used to change the visibility,
color options are provided for visual organization, and the 3D Mode is used for additional adjustments within the 3D view,
see 3D Support. The user can also manipulate the shape in the 2D slice views by dragging the corners of the rectangle or the
center marker.

Splitting Operator Rectangle

Cylinder

The center options will adjust the position of the cylinder in three-dimensional image space, while the radius and height
values will be defined within the currently selected plane. Stroke and Opacity can be used to change the visibility, color
options are provided for visual organization, and the 3D Mode is used for additional adjustments within the 3D view, see 3D
Support. The user can also manipulate the shape in the 2D slice views by dragging the circle edge of the cylinder, the corners
or the center marker.

Splitting Operator Cylinder

Rectangle Group
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The Rectangle Group option has two modes based on selection: one for editing the entire group of rectangles and the other
for individual rectangle editing. They both work in the same general fashion as discussed in the previous Rectangle section.
Group editing is performed when the Rectangle Group name is highlighted as shown in the image below. You will notice the
additional fields to adjust the number of rectangles via rows and columns. The center values for the Rectangle Group
represent the center of mass of all the children’s rectangles and can be used to move all the children by the same amount.

Splitting Operator Group Rectangle

 Note: Changing the plane in a group will reset position and size for its children.

Cylinder Group

The Cylinder Group option has two modes based on selection: one for editing the entire group of cylinders and the other for
individual cylinder editing. They both work in the same general fashion as discussed in the previous Cylinder section. Group
editing is performed when the Cylinder Group name is highlighted as shown in the image below. You will notice the
additional field to adjust the number of cylinders via rows and columns. The center values for the Cylinder Group represent
the center of mass of all the children’s rectangles and can be used to move all the children by the same amount.

Splitting Operator Group Cylinder

 Note: Changing the plane in a group will reset position and size for its children.

Group and Child Linking

As can be viewed in the previous two images, there are link icons next to certain shape fields. These links symbolize the
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current state of the group’s children regarding the context of that field and show whether all the children share the same
group value or not. If the user wishes to overwrite one of the individual child settings, they need only to relock the
corresponding icon.

Output

The image below show the fields that are relevant to the export of the splitting.

Splitting Operator Output Options

There are two options for exporting the split results. The first is splitting to the Data Manager triggered by the button labeled
Split to DM. See Data Manager for more information. The second option for export is to Split to Files. All geometries that are
currently listed will be exported as files. The file name that you specify will be prepended to the name of the geometry. Care
should be taken not to overwrite older data that was previously saved.

The post-processing orientation will be applied after the extraction phase and is an additional tool for further analysis and
organization.

 Note: The orientation option will be applied after running the split, it has no visual effect on the screen because it is a post
processing step.

Save Shape State

Once a shape has been created you will see a save floppy disc icon to the right of the current shape title as seen in the image
below. At any time, the user can click that button to save the current state of that specific shape type. A note should be made
here that we currently only support one saved version for each shape type. If the user requires more variety in saved states
they can use the Operator Menu capabilities.

Splitting Operator Save State

Revert Shape State
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To the right of the save floppy the user will see the broom icon that has two options for reverting state. The first option
labeled Previous State will set all the shape values back to either the initial state or the state when the saved icon was last
clicked. The second option labeled Data State is a way for the user to correlate their current shape settings to the currently
loaded data source. This option addresses the case where new data has been loaded that maybe doesn’t currently correlate
well to the current shape. This option is similar to creating a shape with the New (Data State)  except only the values
associated with position and size are updated.

Splitting Operator Revert State

Operator Menu

The Splitting Operator toolbar options consists of a Load Shapes option and a Save Shapes option. Both options launch a file
dialog to complete the requested action. The load option will replace the current splitting shape list with the newly loaded list
and correspondingly the save option will save the entire shape list. The file type is XML.

Splitting Operator Toolbar Menu

Sessions Support

When saving out sessions the entire shape list will be captured in its current state, and when loading a session, the current
shape list will be replaced by the shape list in the saved session. See Session for more information.

3D Support

The 3D View supports picking and hovering and will display the current shape name in the status text in the bottom right of
the view. If no shape is currently being hovered over the status text will return to the currently selected shape name.
Rendering in 3D can be globally turned on and off for all split shapes via the button in the top right corner.

Splitting Operator Show In 3D

Additionally, the individual shapes and shape group have a 3D rendering control which not only includes the ability to turn
them off individually but also allows choosing between a solid vs wireframe rendering.
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Splitting Operator 3D Render Mode

The 3D view supports full editing of the split shapes via the UI field controls or via interacting with the 3D rendering. The
editing using the UI field controls is no different than editing in the slice views and should work as expected.

3D Editing

In order to the interact with the 3D shape rendering the user can click the Edit in 3D  button. This button is present on
individual shapes only and is enabled when the main Show in 3D  button is also enabled. Once the button is depressed the edit
widget will appear around the currently selected shape.

Splitting Operator Edit In 3D

This edit widget has 7 control points; 6 are for dragging the boundary of the shape and 1 is for dragging the center position
of the shape. Other edit widget controls are invoked via the following mouse and keyboard sequences:

Key Mouse Button and Action Context Description

N/A Right down and drag Cursor over edit box Uniform
scaling

Shift Left down and drag Cursor over edit box Translates

N/A Middle down and drag Cursor over edit box Translates

3D Quick Editing

We also have provided another means to edit without first clicking the Edit in 3D  button. This quick edit method should
speed up 3D edits where users wish to change center or do a uniform scaling. These behaviors are invoked via the following
mouse and keyboard sequences:
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Key Mouse Button and Action Context Description

Alt Right down and drag Cursor over any shape Uniform
scaling

Alt Left down and drag Cursor over any shape Translates

Note: The 3D view must be in focus for ALT key to engage.

Once the user enters a quick edit context any current edit widget that may have been visible will be turned off.
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Data Selector Widget
The Data Selector Widget, which is used by the Reorientation/Registration, Arithmetics, and Filtering operators, provides a
flexible method for selecting inputs on which to perform actions.

Data Selector

Using the Data Selector

The Data Selector Widget offers two ways to inform VivoQuant on which inputs the user would like to operate.

Option 1: The user may type the inputs of interest into the text field, using standard list logic. For example, typing
[1,2,3,4] will inform VivoQuant the user wishes to operate on Input1, Input2, Input3 and Input4. Alternatively, this
same command could be accomplished simply by typing [1-4]. These formats may also be mixed, for example, typing [1-
3,5] would indicate the user wishes to operate on Input1 through Input3, and Input5. An important note is that the
widget refers to the Reference image as 0.

Option 2: The user may choose to use the widget dropdown, which is the button with the triangle, shown selected,
above. This will allow the user to select the check box for the inputs of interest, or the All option if so desired. Using the
dropdown does not preclude the user from also editing the text field, as it will update according to the selected items.
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Maximum Intensity Projection (MIP)
A Maximum Intensity Projection (MIP)  is a series of 2D images generated from a 3D reconstruction by selecting the
maximum value through the reconstruction seen by each 2D pixel at each of several viewing angles.

Each angular view in a MIP has a unique viewing angle which defines the 2D projection plane. Parallel rays emanate from
each of the pixels in the projection plane through the reconstruction. The maximum intensity, i.e. largest-valued voxel,
encountered by each ray is assigned to the pixel from which that ray emanated. For example, bone typically exhibits a high
value in a CT reconstruction. Therefore, in X-Ray CT MIPs, the skeleton is prominent as the bone values are selected from the
voxels included in a given ray. Repeating this process for multiple angles around the animal generates what appears to be a
“rotating film” of the reconstructed image.

The MIP tool enables manipulation of 3-dimensional renderings of SPECT and CT data. This easy-to-use software allows the
integration of SPECT and CT data into one image. Data can be viewed as image slices or as a continuous movie. This tool also
provides means to modify color, intensity, and zoom of an image as well as various options for saving the data.

Example MIP projections at three different angles are shown below:

MIP Projections
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Main Window
VivoQuant’s Main Window contains the primary display and is the focal point for reaching all other functions.

Display

Menus

There are five menus across the top of the Main Window:

Menu Function

File Used for file manipulation and includes options for opening, saving, printing, and publishing files.

View Used to control the display of data already loaded into the VQ. Entire data sets may be toggled as may a
variety of display options, including layout and zoom.

Tools Provides access to several VQ image processing tools, including data control, reconstruction, calibration,
and configuration features.

Advanced
Modules

Provides access to more advanced VQ image processing tools, including data control, reconstruction,
calibration, and configuration features.

Help Help content, including licensing information and the manual, are available in this menu.

Docks

The View Control, MIP Control, Data Manager, and Operators are automatically placed into Docks upon opening. Docks may
be dragged and dropped into and out of the Main Window display, and multiple controllers/operators are dockable at any
given time.

Thumbnails

The thumbnail icons described below provide fast access to different features:
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Thumbnail
Icon

Function

Opens the Data Browser

Opens a browser that will unload currently loaded data and replace it with the data selected in the
browser.

Opens a browser that will append data to currently loaded data.

Opens the Save Image window.

Opens the Save Movie window.

Changes the display layout to a 2 x 2 grid layout.

Changes the display layout to a 1 x 1 grid layout.

Changes the display layout to show the sagittal, coronal, and transverse data slices but not the MIP.

Changes the display layout to show only the transverse data slices.

Changes the display layout to show only the MIP.

Resets the zoom and pan within each viewport in the display.

Zooms in 25%.

Zooms out 25%.

Auto-zooms to fit data to screen.

Opens RGB color options.

Opens the Viewer Control panel.

Opens the MIP Control panel.

Opens the Data Manager panel.

Opens the Min Max Tool panel.

Opens the VivoScript Evaluation window.
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Edits the VivoScript file selected in the Quick Scripts menu.

Evaluates the VivoScript file selected in the Quick Scripts menu.

Aborts the VivoScript in execution.

Activates the Peek tool, used to reveal names of operator widgets for use in VivoScripts. See the
VivoScript page for more.

Thumbnail
Icon

Function

View Modes

There are three viewing modes available via the pull-down menu located next to the thumbnail icons.

Viewing Modes

View
Mode

Function

Slice
View

The Slice View (default) simultaneously displays images of single slices for the MIP, sagittal, coronal, and
transversal views of the loaded data sets.

Tile
View

The Tile View displays an array of slices for either, sagittal, coronal, or transversal view of the loaded data sets.

Multi
View

The Multi View displays sagittal, coronal, or transversal slices of each data set adjacent to one another
simultaneously.

Operators

The operators are accessible via the pull-down menu located next to the thumbnail icons.

Operators
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Operator Function

Navigation Enables manually scrolling through the image slices and rotation of the Maximum intensity
Projection (MIP).

3D ROI Tool Provides advanced tools for drawing, visualizing, saving, and quantifying both 2- and 3-
dimensional regions.

Projection Provides a means to quantify density and activity parameters in CT and NM scans,
respectively.

Reorientation/Registration Enables realignment of image data via translation, rotation, or flipping. In registration mode,
a variety of registration algorithms are available to automatically register data from a wide
variety of modalities.

Time Series Allows sagittal, coronal, and transverse slices of datasets from a time series to be played
sequentially in a loop or easily scrolled through manually.

Distance/Annotation Allows you to measure the distance between two points in any image.

Checkerboard In checkerboard mode, the reference and input data set(s) are arrayed in a pattern of
alternating squares, resembling a checkerboard.

Cropping Allows images to be made smaller by removing any unwanted areas.

Arithmetics Allows voxel-wise arimethic operations on two input images, or scalar operations on any
number of input images.

Filtering Uses a selection of built-in smoothing filters with configurable parameters.

Modeling Provides an integrated solution for representing the loaded data set with one of several
mathematical models to allow for predictions and analysis.

Splitting Provides utility to split the image into a number of distince regions.

Display

The Display field is the main component of the Main Window. The first three images loaded in the Data Manager are visible
in the Display field. Many tools and image-processing steps are visible in the data sets shown in the Display field.

Projections vs. Reconstructions

The Display window recognizes whether a loaded data set is projection data or reconstructed data. The default viewing
scheme, known as Slice View, for reconstructed data includes an MIP and three separate viewing directions (sagittal, coronal,
and transversal). When viewing projection data or sinograms (sets of CT projection data), VivoQuant displays the data
accordingly. For example, transverse slices of projection data are displayed with a P in the top-left corner.
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Projections vs. Reconstructions

For CT data, selecting the correct layout will display the relevant sinogram data. For the corresponding windows, the data are
labeled as sinogr., denoting “sinogram”.

Sinogram

 Note: It is not possible to view projection (non-volumetric) and reconstruction (volumetric) data simultaneously.
Attempting to append reconstruction data to projection data, or vice versa, will result in an error message.
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Save Image Data
This function saves images as picture files. Slices can be saved individually (sagittal, coronal or transversal) or all in one image.
This feature can also save a Maximum intensity Projection (MIP) picture (MIP viewer must be active). Images will appear
exactly as they do in the viewer.

Getting There

There are three different methods for saving images. The first method is to go to File > Save Image.

File Menu

The second method is to use the keyboard shortcut Ctrl+I. For more information on keyboard shortcuts, please see Keyboard
Shortcuts.

The third method is to click on the Save Image button  .

Function

Upon selecting any of the above options, the Save Image window opens.

Save Image Window
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There are several options for the output images.

Option Description

File name Sets the name of the image file.

Files of type Sets the type of image file. File types can be:
- .png 
- .jpeg 
-.bmp 
- .gif 
- .tif 

Image type Sets the type of image. Image types can be:
- Maximum intensity projection (MIP)
- Sagittal slice
- Coronal slice
- Transversal slice
- All views in one image
- All images separately

Colorbar
options

Sets the colorbar and label options for the image. Options include:
- None - no colorbars or labels
- No labels - colorbars with no labels
- Simple labels - colorbars with one set of evenly distributed gradations placed across all color bars.
- Smart labels - colorbars with separate sets of gradations for each color bar incremented with respect to
the units of each color bar.

Storage type Sets whether the image file will be stored as a local image file or as a DICOM Secondary Capture.

Magnification Sets a scalar magnification factor to be applied to the resulting image. This affects only the magnification
of the image file being generated.
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Save Movie
This function enables saves images as movie files. The slices can be saved individually (sagittal, coronal or transversal) or all in
one movie. This feature can also be save a Maximum intensity Projection (MIP) picture.

Getting There

There are three different methods for saving movies. The first method is to go to Save Movie under the File menu.

File Menu

The second method is to use the keyboard shortcut Ctrl+M. For more information on keyboard shortcuts, please see
Keyboard Shortcuts.

The third method to save image slices is to click on the Save Movie button  in the Main Window.

Function

Upon selecting any of the above options, the Save Movie window opens.
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Save Movie Window

There are several options for the output movies.

Option Description

File name Sets the name of the movie file.

Files of type Sets the type of the movie file. File types can be:
- .gif 
- .mpg 
- .mpeg 
- .mp4 

Movie type Sets the type of Movie. Movie types can be:
- Maximum intensity projection (MIP)
- Sagittal slice
- Coronal slice
- Transversal slice
- All movies separately

Colorbar
options

Sets the colorbar and label options for the movie. Options include:
- None - no colorbars or labels
- No labels - colorbars with no labels
- Simple labels - colorbars with one set of evenly distributed gradations placed across all color bars.
- Smart labels - colorbars with separate sets of gradations for each color bar incremented with respect to
the units of each color bar.

Storage type Sets whether the movie file will be stored as a local movie file or as a DICOM via Secondary Capture.
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Docks
The Viewer Control, MIP Control, Data Manager, and all Operators are automatically placed into docks upon opening. Docks
may be dragged and dropped into and out of the Main Window display and multiple Controllers are dockable at any given
time.

Docks

Using Docks

Any controller or operator displayed in a dock may be popped out into its own window by dragging and dropping. Similarly,
any controller or operator can be re-docked by dragging it back into a docking area (the left, right, or bottom area of the main
window).

Docks Pop-In and Pop-Out

Docks may be placed on either side of the main window, allowing immediate access to many VivoQuant tools without
changing windows. If you need more main window space for image viewing, close or re-arrange the docks to your preference.
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Dual Docks
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Slice View
The Slice View (default) simultaneously displays images of single slices for the sagittal, coronal, and transversal views of the
loaded data sets.

Getting There

The Slice View is available via the view pull-down menu on the Main Window.

Slice View Display

Slice View Display

Slice View

You can scroll through slices in the Slice View by using the scroll wheel on a mouse or by using the arrow and paging keys on
your keyboard.

The keys control different views (coronal, sagittal, or transversal) depending on the current active view. Click on a view to
make it the active view. Generally, you will control the active view with the paging (PageUp, PageDn) keys, and scroll the
other two views with the arrow (→,←,↑,↓) keys.

Keyboard Controls
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Scrolling Slices Example

You can use the arrow and paging keys to scroll through slices in the Slice View.

In the example image below, the transversal view is the active view. The ← and → keys move the crosshairs towards the L
(left side) and R (right side) in the transversal slice, respectively. Moving through the object to the left or right steps through
the sagittal plane of the object; thus, the sagittal slice changes.

The ↑ and ↓ keys will move the crosshair towards P (posterior side) and A (anterior side). Both these sides are also visible in
the sagittal slice of the object (rotated 90-degrees). Using the ↑,↓ keys in the transversal plane will shift the vertical crosshair
in the sagittal plane, and step through the coronal views of the object.

Scrolling Slices Example

Scrolling Slices Shortcuts Table

The following table displays the function of the arrow and paging keys for each active view.

Active
View

← → ↑ ↓ PageUp PageDn

Coronal Previous
sagittal slice

Next sagittal
slice

Previous
transversal slice

Next
transversal

slice

Previous coronal
slice

Next coronal
slice

Sagittal Previous
coronal slice

Next
coronal slice

Previous
transversal slice

Next
transversal

slice

Previous sagittal
slice

Next sagittal
slice

Transversal Previous
sagittal slice

Next sagittal
slice

Previous coronal
slice

Next coronal
slice

Previous
transversal slice

Next
transversal
slice
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Slice Intraframe Zoom and Pan

The following key and mouse sequences allow users to pan and zoom within a slice display frame. It is important to note that
this zoom behavior differs from the standard Zoom. This zoom keeps the displayed slice bounds fixed and performs the zoom
and pan within these bounds. In contrast, other UI zoom controls change the scale and display bounds of the slice.

Slice View - Intraframe Zoom And Pan

Key Mouse Button and Action Context Description

Shift Left down and drag Cursor over slice frame Translates

Shift Midel down and drag Cursor over slice frame Translates

Shift Scroll wheel Cursor over slice frame Zooms within display bounds

Scrolling Zoom

Other Slice View Tools

You can also scroll through slices through the Viewer Control panel using the sliders and their associated spin boxes.
Additionally, you can use the Layout and Zoom options to control the Slice View.
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Tile View
The Tile View displays an array of slices for either sagittal, coronal, or transversal view of the loaded data sets. The number of
slices displayed depends on the size of the VivoQuant window.

Getting There

The Tile View is available via a pull-down menu on the Main Window.

Tile View

Using the Tile View Display

Tile View Display

You can scroll through slices in the Tile View using the scroll wheel on a mouse or using the arrow and paging keys on your
keyboard. The keys control the rate at which the user scroll through the tiles.

Keyboard Controls
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← → ↑ ↓ PageUp PageDn

Previous slice Next slice Previous row Next row Previous screen Next screen

To switch between views (coronal, sagittal, transversal) in the Tile View, right-click on a tile and choose the desired view.

Switch View

There are two operators available in Tile View. The Time Series operator, which enables dynamic data to be viewed as a time
series, and the 3D ROI Tool operator, which enables ROIs to be displayed in Tile View.

 Note: ROIs can’t be edited in Tile View.
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Multi View
Use the Multi View to create a fully customized Display for your data. You can select how many Viewports and in what
orientation they will be displayed, and which datasets will be rendered in them. This is especially useful if you work with data
across multiple image modalities.

Getting There

The Multi View is available via a pull-down menu on the Main Window.

Multi View

Setting Up the Multi View Display

The Multi View tool activates a view-specific layout operator.

Multi View Layout Operator

Use the Layout operator to customize the Multi View display:

1. Select the desired layout, which will define the number of rows and columns of the Viewports.

2. For each viewport, select the datasets and slices that will be displayed.

3. Use the Hanging Protocol pull-down menu to set the desired layout.

The 5x5 grid will populate with the corresponding number of rows and columns, and control both the datasets
displayed in each viewport and the slice type.
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Hanging Protocol

To load data into a particular viewport, click on the corresponding box in the grid, and select the Reference, Input 1 and
Input 2 dataset(s) image from the Data pull-down menus. The dataset(s) will be loaded automatically.

Load Viewport

The boxes in the 5x5 grid are labelled Cor, Sag, or Tra, indicating the type of slices displayed in the Viewports. To change the
type of slice, double click on the corresponding box in the grid and select the desired slice type.
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Select Slice Type

To show ROIs in a Viewport, select the desired Viewport, by either clicking on it in the Display or clicking on the
corresponding 5x5-grid box, and check Show ROIs. To show ROIs in all viewports, click the Show ROIs All button.

Show ROIs

Using the Multi View Display

Navigation

To use the Multi View in the same way as other Displays, close the Layout operator and select the Navigation operator. The
Navigation operator in Multi View has identical functionalities as in Slice View. Mouse and keyboard functions, including
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Keyboard Shortcuts, are preserved.

Viewer Control in Multi View

The View Control functionality is extended in Multi View to cover the new viewport layout. This includes the ability to view
voxel and color information for each viewport in the Display, as well as the ability to unlink the viewports, enabling them to
be navigated independently of one another.

View Control Functionality
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Capture Viewer
The Capture Viewer allows for editing image and movie files prior to saving.

Getting There

When saving an image or movie file, the second option in the Storage Type drop-down menu is DICOM Secondary Capture.
Select this option and click Save to load the data into the Capture Viewer.

DICOM Secondary Capture Option

Function

The Capture Viewer panel is split into three sections: Info, Convert, and Image View.
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Capture Viewer Panel

Info

The Info field includes functions that affect the output image.
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Option Description

Series Description Image pull-down menu. The selected image will be reflected in the Series Desc field.

PatientsName Patient name as stored in the DICOM header.

Study Desc Protocol used to collect the data.

Series Desc Series description including modality.

Capture Desc Name of image/movie to be saved. Manually entered by the user.

Content Data Date and time at which the image/movie was loaded into the Capture Viewer.

Data Size Size of the original data referred to in the Series Description pull-down menu.

Image Size Size of image currently being displayed.

DICOM When pressed, displays the DICOM header for the data.

Close When pressed, closes the Capture Viewer without saving image.

orig When checked, maintains, or returns to, the original image size.

 and Increases/decreases the image size.

Convert

The Convert field includes several options that affect the output image.

Option Description

Save Image Opens the Save Image screen.

Save Movie Opens the Save Movie screen.

Play Movie Plays/stops the movie.

Save Capture Saves image/movie into the repository specified in the pull-down menu.

Image View

The Image field displays of the image or movie that is currently being edited.
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Show Reference / Input 1 / Input 2
The datasets rendered in the display (Reference, Input 1 and Input 2) may be turned on and off.

Getting There

To toggle the appearance of these datasets, go to the View menu and select Show Reference, Show Input 1, or Show Input
2. The change will be immediately visible in the Display.

Show Reference / Input

Alternatively, you can use the keyboard shortcuts: F2 for Reference, F3 for Input 1, and F4 for Input 2. For more information
on keyboard shortcuts, visit the Keyboard Shortcuts page.
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Cross Hair
This function allows for displaying cross hairs on the images to assist navigation through the slices.

Getting There

To display the Cross Hairs on the image, go to the View menu and select Cross hair.

Cross Hairs

Function

The Cross Hairs are displayed over each cross-sectional image: sagittal, transversal and coronal. To display the cross hairs in
the images, go to the View menu and select Cross Hair. To conceal the cross hairs from view, unselect the Cross Hair
functionality by left-clicking on it.

Sow / Hide Cross Hairs
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Position Labels
The Position Labels are displayed on each image plane and MIP. They indicate which side of the subject is being viewed.

Getting There

To display the position labels on the image, go to the View menu and select Position Labels.

Position Labels

Function

The labels indicate the plane of view (sagittal, coronal and transversal), and also the left/right and anterior/posterior side of
the subject.

Sagittal There is an S on the top left corner of the image to indicate that it is the Sagittal plane. There is also a P to
indicate the posterior side of the subject, and an A to indicate the anterior side of the subject.

Coronal There is a C on the top left corner of the image to indicate that it is the Coronal plane. There is also an H to
indicate the head of the subject, and an F to indicate the feet of the subject.

Transversal There is a T on the top left corner of the image to indicate that is it the Transversal plane. There is also an L
to indicate the left side of the subject, and an R to indicate the right side of the subject.
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Corner Information
This feature allows for configuring the image information to be displayed on the four corners of each viewport.

Getting There

To display the image information, go to the View menu and select Corner Information.

Corner Information

Alternatively, you can use the keyboard shortcut Shift+E to display the image information.

To conceal the information labels from view, unselect the Corner Information function by using either of the above
alternatives.

Function

Once this option is selected, the information for the active image is displayed on the corners of all of the image planes
(sagittal, coronal and transversal) and also on the MIP.
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Info Displayed

Configuration

You can configure what type of information to be displayed on each corner of the image viewports by going to Tools >
Configuration.

On the Display tab, click on the  button and use the patterns shown in the window to select what information you
want to display on each corner of the image viewports.

Configure Corner Information
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Active Indicator
The Active Indicator option places icons in the viewports that indicate which datasets are currently active in the Display.

Getting There

To turn on this option, go to the View menu and select Active Indicator.

Active Indicator

Function

The Active Indicators appear in the upper right corner of the viewports.

The top, middle and bottom indicators correspond to the Reference, Input 1 and Input 2, respectively. If the indicator is a
solid circle, the corresponding input is on. If the indicator is a hollow circle, the corresponding input is off.

Active and Inactive Data
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Layout
This feature offers a variety of layouts for viewing studies. You can view all the slices and the MIP together simultaneously or
each study individually.

Getting There

To select a layout option for the images, go to the View menu and click Layout.

Layout

Alternatively, the different layouts can be activated by clicking on the Layout thumbnails in the Main Window.

Thumbnail Description

Grid 2x2

Grid 1x4

MIP only

Slices only

Transversal only

Layout Options
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Grid 2x2

In the Grid 2x2 layout, the MIP and the coronal slice are located on the upper half of the screen, and the sagittal and
transversal slices are located on the bottom half of the screen.

Grid 2x2

Grid 1x4

In the Grid 1x4 layout, the MIP and all three slices are laid out in a single row.

Grid 1x4

MIP only
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In the MIP only layout, only the MIP is visible. The slices are not in view.

MIP only

Slices only

In the Slices only layout, only the slices are visible. The MIP is not in view.

Slices only

Transverse only

In the Transverse only layout, only the transverse slice is in view.
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Transverse only
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Zoom
The Zoom function allows for altering the viewpoint of the images by zooming in and out, and also provides the option of a
full screen view.

Getting There

There are three different methods for operating the Zoom function. The first method is to go to the View menu and select
Zoom.

Zoom

The second method is to use the following keyboard shortcuts:

Function Shortcut

Zoom in (25%) Ctrl + +

Zoom out (25%) Ctrl + -

Normal size Ctrl + 0

Full screen Ctrl + F

Auto zoom Ctrl+ Z

For more information on keyboard shortcuts, see the Keyboard Shortcuts page.

The third method is to click on the Zoom In  and Zoom Out  thumbnails in the Main Window.

Function

The Zoom In option allows for to zooming in by 25% increments. The Zoom Out option allows for zooming out by 25%
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increments.

Zoom In and Out

The Normal Size is the default angle. Selecting this option will bring the images back to their original viewing angle.

The Full Screen options displays VivoQuant in full screen mode. To enable and disable this mode, hit the keyboard shortcut
Ctrl + F.

The Auto Zoom option automatically increases the viewing angle of the images if the size of VivoQuant’s window is

increased. To access this option, click on the Auto Zoom thumbnail  on the top bar.

 Note: If the Auto Zoom function is not selected and the size of VivoQuant’s window is increased, the image slices will stay
in the same viewing angle and will not automatically fit the larger window size.
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VQScript
VQScript, or VivoScript, is an implementation of ECMAScript (JavaScript) that allows users to access large parts of
VivoQuant.

JavaScript structures

VQScript syntax is identical to JavaScript syntax.

Loop

for (var i=0; i&lt;10; ++i) {
            ...
}

Function

function blub() { ... }
function bar(p1, p2, p3) { return p1+p2+p2; }
var res = bar(1,2,3);

Array

var array  = new Array();
array[0]   = 'foo';
array[1]   = 'bar';
var array2 = new Array('foo', 'bar');
var array3 = [ 'foo', 'bar' ];
var last   = array2.pop();      // remove and get last element
array2.push('burp');           // add element

Other array functions are, for instance, concat, join, reverse, sort, unshift, shift.

The VQScript Toolbar

Adding Script Shortcuts to the Toolbar

Shortcuts for commonly executed VQScripts can be added to the Quick Scripts menu on the VQScript toolbar

To add a Quick Script shortcut:

1. Go to Tools->Configuration and click on the VivoScript tab.
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2. Select a script for which quick access is desired by clicking the Add Quick Script button  and navigating to the
directory where the script is saved.

3. Add a nickname for the script in the dialog box that appears.

4. The script will now appear in the configuration window as well as in the Quick Scripts menu on the VQScript toolbar.

Quick Scripts can be edited directly from the VQScript toolbar by clicking on the Edit VivoScript button  . A window will
appear in which the user can edit the script.

Edit Quick Script
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Using the Peek Tool

The Peek Tool is used to reveal the names of elements (called widgets) in the operator GUIs for use in scripts. The command
VQ.getWidget("widgetName") can then be used to interact with these elements.

For example, to determine the name of the button in the 3D ROI Tool that resets all ROIs, click on the Peek button  on
VivoQuant’s top bar, and then click on the desired button in the 3D ROI Tool operator box. A yellow box containing the class
and name of the selected button will be displayed.

Using the Peek Tool

Then, the command VQ.getWidget("buttonResetROIs").click() ca be used to click the button and reset all ROIs.

VQScript Examples

Included with VivoQuant are 30 VQScript example scripts to help you get started working with VQScript. These scripts
illustrate some of the many ways VQScript may be used to streamline workflows in VivoQuant. To learn more about each
files, see the VQScript Example Scripts page.

VQScript Classes

Click here  to see the list of VivoScript Classes.
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View Control
The View Control palette is a powerful tool for manipulating image appearance in the Main Window.

Getting There

There are three different methods for reaching the View Control tool. The first method is to use the View Control thumbnail 

 in the Main Window.

The second method is to go to View Control under the Tools menu.

View Control

The third method is to use the keyboard shortcut F5. For more on keyboard shortcuts, please see Keyboard Shortcuts.

Function

The View Control window provides a variety of options for manipulating the appearance of open data sets in the main
window. Options include Sliders for slice selection, Color Controls and Voxel Values.
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View Control Operator

Sliders

Adjusting the x, y, and z sliders in the Sliders section changes the sagittal, coronal, and transverse slices, respectively, that are
shown in the Display. The cross hairs displayed on the main window also reflect the x, y, and z slider values.

Color Controls

The Color Controls display information about the datasets loaded at the Reference, Input 1 and Input 2 positions.

The checkboxes on the left toggle the visibility of the datasets in the Display. Next to these, the Voxel Values of each dataset
at the current slice are displayed along with their respective units.

 Note: If given proper Hounsfield or quantification calibration, the voxel values will be given in Hounsfield units or MBq.

The Intensity pinboxes control the relative transparency of the dataset. Decreasing the intensity value increases the
transparency of the image.

View Control in Multi-View

The Multi View mode enables users to customize the layout of viewports in the Display. When in Multi View, additional
controls become available, extending the in the View Control normal functionality to the Multi View Display. Users may also
select whether navigation is linked across viewports, or if viewports may be navigated independently of one another. For
more information on setting up the Display in this view mode, see the Multi View page.

In Multi View, the information in the Sliders and Color Controls is automatically updated to reflect information from the
viewport through which the user is navigating. To update these with information from another viewport, use the drop down
menu in the upper left hand corner and select the desired viewport. Alternatively, click on or navigate through another
viewport in the Display to update the Viewer Control.
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Update Dataset Information

By default, the Viewer Control links all viewports in Multi View together. This means that any navigation through the slices in
one viewport is reflected in all other viewports automatically. Viewports may be unlinked by unchecking the Link Views
checkbox in the upper right corner of the Viewer Control. This will allow users to navigate through each viewport
independently.

Navigate Viewports

To reset all viewports to the same slice, click on the Sync Viewport Settings button  located next to the Link Views
checkbox.

 Note: The Link Views functionality only affects the slice-by-slice navigation between viewports. Zooming and panning
within each viewport will remain independent.

To reset the Zoom and Pan in a specific viewport, select the desired viewport (either by selecting it from the drop down

menu or by clicking on the viewport) and click the Reset button  in the Viewer Control. This will reset only the selected

viewport. To reset all viewports at once, click the Reset button  on the toolbar.
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MIP Control
The MIP (Maximum Intensity Projection) control can be used to manipulate the active 3D rendered volume. See MIP
Explained for a more detailed description of how the MIP is generated.

This tool also allows to automatically rotate the 3D volume and create custom movements that can be exported as videos or
gifs.

Getting There

There are three different methods for reaching the MIP Control window. The first method is to use the MIP Control

thumbnail  in the Main Window.

The second method is to go to MIP Control under the Tools menu.

MIP Controls

The third method is to use the keyboard shortcut F6. For a complete list of keyboard shortcuts, see Keyboard Shortcuts.

Function

The MIP Control window provides a variety of options for manipulating the MIP and the appearance of open data sets in
VivoQuant’s main window. Options include Playing a MIP Movie, Color Controls, View Controls, VTK Viewer, Transfer
Function, and MPR View.
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MIP Controls Function

Playing a MIP Movie

The MIP movie is automatically generated upon the loading of a data set. Using the mouse, it can be manually rotated in the
main window. Hitting Play in the MIP Control enables automatic rotation of the MIP movie. The slider bar marks the rotation
progress of the MIP movie. For large data sets, it can sometimes take several moments for the MIP movie to be generated.
The progress bar in the MIP Control indicates how much of the MIP movie has been successfully calculated.

Color Controls

The Color Controls section provides users with the ability to define tissues and their corresponding coloring properties
(opacity and RGB), for volume rendering.

Color Controls

VivoQuant volume renderer allows for manipulating 3 data sets at the same time: Reference, Input 1 and Input 2. Users can
select canned tissue presets, as well as creating and saving custom tissue properties, and editing existing tissue opacity and
color functions.

Tissue properties can be selected from the Presets combo box.
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Select Presets

Users can select any of the following preset options:

Palette: Syncs with the palette selected in the Data Manager and reacts to min/max changes. This option does not
allow custom coloring for the function. New presets cannot be added based on this option. Therefore the Add Preset
and Remove Preset buttons are disabled.

Custom: Allows for coloring from the current function. The default colors will be those of the palette option if no
presets were selected beforehand. This is the only option that allows for adding new presets. To add a new custom

preset, click on the Add Preset button  . A popup window opens prompting the user to enter a name for the new
custom preset.

Create Preset

The newly created preset will then appear on the list of presets in the Presets combo box.

Newly Created Presets

 Important: When adding preset with a name that already exist, a popup window appears asking the user to confirm
whether they would like to overwrite the previous preset or not.
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Overwrite Preset

To remove a custom preset, click on the Remove Preset button  . A popup window opens asking the user to confirm
deletion of the custom preset.

Remove Preset

CT Tissue Types and Species: These are presets that present CT property configurations that are specific to different
tissue types and species. Some examples include: CT: Human Bone; CT: Human Muscle; CT: NHP Basics; CT: NHP PET;
CT: Rodent Bone + Skin; CT: Rodent Dark Bone; among others.

Users can edit the shading settings by enabling the Light checkbox under Color Controls. The available shading and lighting
settings are as follows:

Ambient Ambient light is the light that is scattered by the environment. It is a simple approximation of global
illumination that is independent from the light position, object orientation, observer’s position or orientation.
That is, ambient light has no direction.

Diffuse Diffuse light is the illumination that a surface receives from a light source and reflects equally in all directions.

Specular Specular light is a light that retains its reflective qualities. When this light hits a surface, reflection bounces
back into the camera. Specular light is a bright spot on an object. It is the result of total reflection of incident
light in a concentrate region.

Shininess Shininess is a material property that determines the size and sharpness of specular highlights.

View Controls

Upon loading a data set, an MIP movie showing the image rotation is automatically generated. By using the mouse, the image

can be manually rotated in the main window. Clicking on the Play button  in the View Controls enables automatic rotation
of the MIP movie. The View Angle slider bar shows the rotation progress. It also allows for fine control of the camera
position. By default, the camera rotates around the Z-axis, and each step is a 3-degree rotation.

For large data sets, the MIP movie may take several minutes to be generated. The progress bar in the under the Play button
indicates how much of the MIP movie has been successfully calculated. The Speed slider allows for fine control of the MIP
rotation speed.

Page 207

file:///home/runner/work/vivoquant-manual/vivoquant-manual/mirror/assets/images/tools_mipcontrol_overwrite.jpg
file:///home/runner/work/vivoquant-manual/vivoquant-manual/mirror/assets/images/tools_mipcontrol_removepresets.jpg


View Controls

VTK Viewer

The Visualization Toolkit (VTK) is open source software used for manipulating and displaying scientific data. VivoQuant uses
the VTK library to generate the 3D Volume (MIP).

Each operator has default VTK Viewer settings which are refreshed upon opening an operator window.

The MIP Projection VTK Viewer allows for fine tuning of some of the parameters offered by the VTK renderer. Some
functions include:

Opacity and color transfer editing function by means of image histograms.

CPU and GPU based volume rendering pipelines.

Interpolation mode selector to change the quality of the VTK rendering.

Ability to save settings to disk and load previously saved VTK settings.

VTK Viewer

The following table describes the options that are available for adjusting the VTK viewer:
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Icon Function Description

Save /
Load
Settings

Provides an option to save the current settings or load previously saved VTK settings.

Auto
Update

Provides an option to enable or disable automatic settings update.

Force
Refresh

Forces re-rendering of the VTK viewer.

Reset
Camera

Resets the camera of the VTK viewer to its initial position.

Bounding
Box

Enables VTK bounding box and clipping.

Gradient
Box

If enabled, replaces black background with VTK gradient grey background.

Toggle MIP Toggles the classic MIP in the VTK viewer.

Toggle
MPR

Toggles Multi-planar reconstruction (MPR) view in VTK viewer. Hold down to toggle background
transparency.

Orientation
Cube

Toggles orientation cube in the VTK viewer. Hold down to select the orientation model: Default,
Human, Human Head, Rodent or Rodent Head.

Annotation Toggles visible annotations in the VTK viewer.

Quality Changes performance of VTK viewer by optionally down-sampling the VTK image. Hold this button
down to specify the resolution of the image: Fine, Standard, or Fast.

Transfer Function

Transfer functions are tools for assigning optical properties to scalar volume data sets. For direct volume rendering, for
example, opacity can be set depending on the gray value at a given voxel position.

VivoQuant’s VTK Viewer allows for editing opacity and color transfer functions by using image histograms and other volume
rendering options.

Computation hardware: This option allows users to choose the desired processing platform for image rendering.
Options are: Default Render Mode; CPU Render Mode; or GPU Render Mode.

 Tip: GPU processes data faster than CPU, but usually has smaller memory. 

Depending on the available hardware, use GPU for rendering images smaller than 1 GB, and CPU for rendering images
bigger than 1GB.

Ray Projection Mode: This option allows users to choose the desired ray projection method. Options are: Maximum;
Minimum; Average; Surface; Composite-Gradient; and Composite-Feature Detection.

Interpolation: This option allows users to change the quality of the VTK rendering by changing the smoothing applied
to the texture mapping when sampling between two voxels. Options are: Linear; or Nearest neighbor.

Histogram: For Intensity Transfer Function, the X-Axis represents pixel intensity. For Gradient Transfer Function, the
X-Axis represents gradient intensity. For both of the previous modes, the Y-Axis represents the weight factor between
0-1.

You can add a point to the transfer function in the histogram. To do so, right-click on the position you would like the
new point to be added to within the histogram, and select Add new point. You can also reset the point to their original
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value by right-clicking the histogram and selecting Reset.

To manually edit the X axis values of the histogram, right click and select Properties. A window opens with editable
fields to enter the Minimum and Maximum values. You can return the X axis to its original minimum and maximum
values by clicking the Reset button.

Add Point

When adding a new point to the function, a color picker window opens which by default assigns interpolated color
between the two surrounding points. Users are allowed to change this color. Also, the color of any of the function
points can be changed by right-clicking it and selecting Color. To remove a point from the histogram, right-click on the
point to be deleted and select Delete Point.

Delete Point

Blending: Controls how volume blend together. Options are: Max or Alpha.

MPR View

The Multi-Planar Reconstruction View (MPR) simultaneously displays a sagittal, coronal, and transversal slice of the
reconstruction. The View Control is used to change the active planes while the sliders and checkboxes across the top of the
window may be used to rotate the view, display the bounding box, reset the view, and turn on/off individual planes.

MPR View
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The image in MPR View may be rotated by using a left-click and dragging the mouse. Similarly, panning may be controlled by
holding the Shift key, using a left-click, and dragging the mouse. The zoom may be changed by using the mouse’s scroll wheel.

To change the active planes in the MPR View, use the (X,Y,Z) sliders in the View Control.

Sliders
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Min/Max Tool
The Min/Max Tool allows you to adjust the windowing of visible voxels for the first three Inputs.

Getting There

The Min/Max Tool is available via the Tools menu.

Min/Max Tool

You can also access the Min/Max Tool by clicking on the Min/Max Tool thumbnail  in the Main Window.

Function

The Min/Max Tool displays the windowing values with units for the Reference, Input 1 and Input 2. The Display
Configuration determines whether the windowing is displayed based on Minimum/Maximum or Level/Width.

Min/Max Tool Operator

The windowing values allows you to calculate the colors for each voxel in the Display, via a mapping from voxel values to the
colors in the color palette. Any values below the minimum will return the lowest color (e.g. black in the gray palette), while any
values above the maximum will return the highest color (e.g. white in the gray palette).

The Min/Max Tool uses a cache feature, whereby minimum and maximum values for inputs are stored in a cache and used by
the color mapping until the user forces the tool to recalculate them. This enables you to keep the color scale consistent when
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working with multiple datasets.

Option Description

Re-calc Recalculates the min/max values for all data sets from the original data. Min/max value will be min/max voxel
values in dataset.

Reset Resets the min/max values to the values stored in the cache.

Apply Stores min/max values in cache and applies values to the datasets.

From
Pal

Copies the current palette window as set in the Data Manager to the Min/Max Tool fields.

To Pal Copies the current Min/Max Tool fields to the palette window settings in the Data Manager.

The buttons with the Cut icon  will clip the data based on values in the tool. This can be useful when trying to clip dense
bone from a CT scan, for instance, or background noise from a PT scan.

Option Description

 (Min) Sets all values below the minimum to 0.

 (Max) Sets all values above the maximum to 0.

Sets all values below the minimum to the minimum.

Sets all values above the maximum to the maximum.

Histogram

The Histogram button  opens the Histogram Tool. This tool generates a histogram of voxel values in the loaded
datasets. For more on this, visit the Histogram Tool page.

Percentile Tool

The Percentile button  brings up the Percentile Tool, which calculates the pixel value associated with the Xth

percentile from the histogram of the image.
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Percentile Tool

Option Description

Calculates the percentile value for selected image in the drop down list to the right.

Shows percentile value with Patient Name, Patient ID, Acquisition Time, Percentile, Cutoff Value, and Units
information from image metadata.

Loads calculated percentile value into table.

Deletes the selected row from the percentiles table.

Resets the value in the ROI field to Field of View .

Copies computed pecentile value to the Max value above.
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Histogram
The Histogram tool is used to plot a histogram of the voxel values in a loaded data set.

Getting There

The Histogram tool may be reached via the Tools Menu or by using the keyboard shortcut Ctrl+ Shift+H.

Histogram

Function

The Histogram tool is operated via two control panels: Data Controls and File Controls.
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Histogram Panels

Data Controls

Option Description

Data
Set

This pulldown menu allows the selection of the data set to be histogrammed.

No.
bins

Sets the number of bins into which to divide the data.

Min Sets the minimum value for which data will be displayed. The Set button, , automatically loads this field with

the minimum value in the object.

Max Sets the maximum value for which data will be displayed. The Set button, , automatically loads this field with

the maximum value in the object.

File Controls
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Option Description

Saves the existing plot into a PDF file.

Writes the data into a text file. The format is in two columns with the first column representing bin
center points (x-axis values) and the second column representing the number of voxels in each bin (y-
axis values).

Refreshes the histogram plot. Use this button after changing the No. bins, Min., or Max. values.

Exits the Histogram Tool.
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Preprocessing Tool
The Preprocessing Tool lets you specify a unique pre-processing protocol and execute it in one step. There are many
preprocessing operations included in the Preprocessing tool that may be added to the protocol.

Getting There

The Preprocessing Tool is available via the Tools Menu.

Preprocessing Tool

Function
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Preprocessing Tool Panel

The Preprocessing Tool panel is divided into four sections. The first section is the Preprocessing Options section, which
includes the preprocessing operations that may be included in the protocol.
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CT Bed
Removal

Automatically detects the bed position within the image and removes the CT voxels which constitute the
animal bed. (Only supports Minerve beds).

Co-register Performs automatic image co-registration of all inputs to the Reference. If Fast or Full 3D are not checked,
then Standard and Translation are used respectively.

Autocrop Performs automatic cropping. Search for boundaries starts at the end slices of the image and moves
towards the center of the image until a non-background voxel is detected from all 6 faces.

Calibration
Factor

Applies a scalar multiplication to NM data (PET/SPECT). It is important to pay attention to the formatting of
the input cell. Calibration factors per modality [comma separated] in format - “Mod=1.0 Unit”. Example:
“PT=13456.7 BQML”. The case of the unit should match what is listed in the Information window.

Resample Up/Downsamples voxels to the specified pixel dimensions.

NM/PT
Convert
unit

Converts to supported uptake and concentration units. If converting to SUV, please make sure the Weight
and Injected Dose options are accurate, including their units.

Series
Description

Appends text to end of series description for all datasets.

Quality
Control
Image

Generates and stores quality control image of preprocessed image. Results stored in the project webdisk of
the repository specified below.

Store Data Saves image data being preprocessed to specified iPACS repository below.

Format Specifies formats in which the data will be saved. The numbers 0, 1, and 2 correspond to multi-frame (MF
module), multi-frame (MF function groups), and single frames (one Z slice per file) formats, respectively. For
multiple data sets, formats are separated by a comma. The current formats of the loaded data sets will be
displayed in this section upon opening the tool as well as in the Information section.

The second and third sections are the Dose and Weight options for image unit calculations. The dose options are not
relevant for conversions to units other than SUV or Percent Injection Dose and will be hidden otherwise. The weight options
are not relevant for conversions to units other than SUV and will be hidden otherwise.

The default unit for the dose depends on the modality and SOPClass of the image. The weight and dose fields will
automatically populate with values from the DICOM header, or can be set manually or from an iPACS datapoint using the
VQS function setUptakeParameter .

If Use Decay Correction is checked, the dose will be decay corrected using information about the half-life and scan times
obtained either from the DICOM header or from values set using the setUptakeParameter function.

If Use Lean Body Mass is checked, the weight will be corrected using the James or Janmahasatian formulas , where the
Janmahasatian formula is used for BMI greater than 43 for men and 37 for women. The Information section of the
Preprocessing Tool shows the DICOM tags that are used for decay correction and their values in each loaded image, including
for each frame of a dynamic dataset.

The fourth section is Storage Options, where users may designate the iPACS repository and Project folder where
preprocessed datasets will be saved (note: Store data must be checked).

Repository Specifies the repository. Repositories can be configured in the DICOM tab of the Configuration window.
See the DICOM settings page for more information.

Project Specifies the sub-project (iPACS) or sub-folder (local path) to which data will be saved.

Protocol Copies and/or pastes preprocessing protocol settings to be used at a later time. Modifications can be made
directly within the Protocol window.

Store Store Image data to the specified location.
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The Information section displays information about the current state of datasets loaded in VivoQuant. Included in this
information is the image dimensions and voxel size for the datasets as a whole, as well as basic header metadata about each
dataset specifically.

To execute the pre-processing protocol, click OK.
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Resample Data
The Resample Data tool allows for rebinning of reconstructed data into an arbitrary voxel size. This tool may be useful when
attempting to fuse multiple large data sets, especially when dealing with high-resolution modalities like MRI and CT.

Getting There

The Resample Data option is available within the Reorientation/Registration Tool via Operations -> Resample, or by
navigating to Tools -> Resample Data.

Resample Data

Using the Tool

Upon selecting Resample Data, a small dialog box appears, displaying the current voxel size and dimensions of the image.
Uncheck the Isotropic Voxels box to adjust the slice spacing. Similarly, uncheck the Auto-compute Dimensions box to adjust
the dimensions of the image. Enter a new voxel size into In-plane Voxel Size and hit OK to resample the data to have voxels
at the new size.

Resample Data Options
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DICOM Tools
The DICOM Tools submenu contains features to aid in the management of DICOM data.

DICOM Dump

The DICOM Dump tool provides the information contained in the DICOM headers for images files currently loaded in the
Main Window. Images loaded from other file types (such as NIFTI) have DICOM headers generated from their contents.

Getting There

There are several ways to access the DICOM Dump. The first method is via the Tools Menu in the Main Window.

DICOM Dump

The second method for reaching the DICOM Dump is to use the keyboard shortcut Ctrl+Shift+D.

The third method is via the Data Browser. Right click on a dataset and click Dump Header.
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Access via Data Browser

The fourth method is via the Data Manager. Right click on a dataset and click DICOM Dump.

Access via Data Manager

Function

Upon activating the tool, a new DICOM dump window opens, showing information from the DICOM headers for any active
datasets. Use the Data set pull-down menu, in the top-left corner, to choose which set of DICOM header information to
display.
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DICOM Dump Window

Enter a search string into the Find field, in the upper right portion of the DICOM dump window. The DICOM Dump tool uses
the DICOM dictionary listed in the DICOM Configuration to read the DICOM header. Each row in the DICOM Dump
represents a DICOM header data entry.

See the dummy DICOM entry below that illustrates the meaning of each field in the DICOM Dump:

(0000,FFFF) AZ [12\18] # 
4,2

VQ DICOM 
Example

(0000,FFFF) is a hexadecimal DICOM address where 0000 represents the group number for that data entry. Even group
numbers correspond to DICOM defined groups, while odd numbers are reserved for private groups. The FFFF half of
the address specifies the element number for that particular entry in the group indicated by the first half of the address.

A two-character item of the form AZ identifies the Value Representation (VR) for that data entry. Several VR types are
specified in the DICOM standard. For example, a Value Representation of US indicates that the data entry will be in the
form “Unsigned Short”.

The actual data values for the data entry (12,18) are displayed next in the Value Field (VF). The values are shown inside
square brackets.

After the hash mark (#), the Value Length (VL) for the data entry is displayed. The VL depends on the VR type and the
number of values in the data entry.

Some data entries contain multiple subsets as indicated by the Value Multiplicity (VM). Subsets are indicated by the
backslash character in the data value field. In the example shown above, there are two subsets: 12 and 18.

The final element of the DICOM entry is the description of the data entry. For DICOM-defined tags, this field will
display relevant information regarding the content of the data entry (i.e., VQ DICOM Example). For private tags, this
field will display Unknown Tag and Data.
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Anonymizer

The Anonymizer anonymizes the data to the user.

Getting There

This function can be found under the Tools -> DICOM menu, or the DCM button in the Main Window.

Function

Upon selecting the Anonymizer, a dialog box appears prompting the user to decide whether to anonymize each loaded
dataset individually (Yes) or anonymize them all together (No).

Anonymize Dataset

In the Anonymizer, header fields can be edited to remove sensitive information, such as the imaging dates, or identifying text
fields. The fields can be edited manually or by setting the text to the label of the field and the dates to a new date. The
buttons Text to Label and Dates to Today will fill in these sections as described. Use the Load Config File button to upload a
configuration file. Selecting OK will apply the changes.
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Edit Header Fields

Rename DICOM Files

Use the Rename DICOM function to rename locally stored DICOM files according to information from selected fields of the
headers.

Getting There

This function can be found under the Tools -> DICOM menu, or the DCM button in the Main Window.

Function

Choose which files to rename by using the Add Files button. Construct new image names by typing into the Template text
box, using the key beneath the text box for reference. Each token represents a particular field of the DICOM header. The
new names of the selected files will be displayed in the Examples window as they are entered. Names must be unique for the
renaming operation to be successful. Renaming will also fail if illegal characters, such as backwards or forwards slashes, are
used. To execute renaming, click OK.
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Rename DICOM

Relabel Study

The Relabel Study tool allows for the following fields to be edited or renamed:

Patient Name

Patient ID

Study Description

Series Description

Patients Birthday

Protocol Name

Getting There

This function can be found under the Tools -> DICOM menu, or the DCM button in the Main Window.

Function

Upon selecting the Relabel Study option, a dialog box appears prompting the user to decide whether to relabel each loaded
dataset individually (Yes) or relabel them all together (No).

Enter the desired Data fields to change. Select the desired Repository and Project to store in the Storage section and click
OK, or click Open if no data are already loaded.
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Relabel Study

DICOM Editor

The DICOM editor tool allows users to modify DICOM headers.

DICOM Editor Window

 Note: See the restricted_tags page for instructions to control editing of DICOM tags.

Getting There

This function can be found under the Tools -> DICOM menu, the DCM button, or by right-clicking on an image in the Data
Manager.
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Function

The DICOM headers are presented in an expandable tree format for each image loaded into the editor. Columns can be
sorted independently between images by clicking on the column headers.

Editing

Simply change the text in the value column to the desired value. When a value is changed, it will be shown in bold text.
Values restricted from editing will be shown in gray text.

To revert all edits on one of the image headers, click the Revert  button.

Filtering

The user can filter by DICOM tag, tag names, Value Representation (VR), or value. Non-matching header entries in each
image will be filtered out.

Filtering is case-insensitive and supports wildcards. The filter will automatically surround the text with the * character when
interpreting the query so that fields like NumberOfValues or NameOfPatient can be found by just entering of. To filter to
subwords within text, include the * character surrounded by parts of the subword.

DICOM Editor filter

Saving changes

The checkbox option Append as new dataset(s) allows the user to create and load a new image with the updated header
upon save. When this option is unchecked, the currently loaded image will be updated instead.

If multiple images’ headers are changed, clicking one of the Save options will update each image (or create new ones if the
append option is checked).

 Note: Users should save their images to disk or iPACS after editing the DICOM header.
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Autoradiography Calibration
You can load, view, analyze and save Autoradiography data using the same tools VivoQuant uses for in vivo image data.
Once loaded into VivoQuant, data can be reoriented, cropped, rescaled, and quantified.

The Autoradiography Calibration tool allows you to calibrate autoradiography data based on known calibration standards in
the image.

 Note: This tool is available only with a CiQuant Module license. For more information, contact support@invicro.com.

Getting There

To access the tool, activate to the 3D ROI Tool operator, then go to the Operator tab in the main menu and select
Autoradiography Calibration.

DICOM Dump

Function

Once the you start the tool, it asks several questions to establish how it will be used. The first prompt asks for the number of
calibration standards being used. This determines the number of ROIs that populate the 3D ROI Tool.

Calibration Standards Prompt

The second prompt asks if there will be a background ROI used. This influences the calibration curve. In most cases, a
background ROI is recommended.
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Background ROI Prompt

The ROIs are populated based on the answers to these questions. You then need manually place them in the correct locations
in the image. Use the 3D Paint Mode tools to perform this task. Regions should appear similar to the image below.

3D Paint Mode

Image Calibration

After segmenting the calibration standards, click Read Values from Image. The table displays the mean value of each region.
Provide the true value of each standard as well as the correct output unit. Also, choose from the available Error Weight
techniques.

After you have established the settings, click Run. The plot populates with the values of the standards and provided values
along with the calculated fit line. Changing the settings, particularly the Error Weights, will change the output calibration
curve.

To see how the curve changes with different settings, change them and click Run. Once the curve fits as desired, click Apply
to apply the calibration to the data.
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Image Calibration

Page 233

file:///home/runner/work/vivoquant-manual/vivoquant-manual/mirror/assets/images/tools_autoradiography_imagecalibration.jpg


Worklist Tool
The Worklist provides an interface for viewing tasks created from iPACS Workflows, completing electronic case report forms
(eCRF) and opening data associated with the tasks.

Getting There

There are three methods to open this tool. The first method is using the Worklist thumbnail  in the Main Window.

The second method is to go to Worklist under the Tools menu.

Worklist

Finally, the Worklist is also available by using the keyboard shortcut Ctrl+Shift+W.

Select Project

Select Project
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The first step in using the Worklist is to select an iPACS project. Any of the iPACS repositories that have been added in the
Data Browser are available to use for the worklist in the iPACS dropdown. The project can be selected using the Project
dropdown, which can be filtered the same way as in the Data Browser. The Filters dropdown allows the user to filter the
worklist results by task type, using the same options available in the Task List on the iPACS.

Once a project and task filter have been selected, the tasks assigned to the current user will appear in the task list panel. The
current user is the user whose credentials were used to login to the iPACS in the Data Browser. The task list can be refreshed
at any time using the refresh button, and the current project and filter can be changed using the settings button. Clicking on a
task opens the Task panel, which displays images and files associated with the task organized in tabs based on their type.

Task Viewer

The Append and Open buttons open or append the data associated with the task in the data list and open the task’s
associated eCRF form. The user can view and interact with the data in VQ and complete the form in the eCRF window. After
the form is submitted, a popup window indicates whether the submission was successful and a refresh of the task list will
show that the task is no longer assigned to the user.
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eCRF Viewer

Depending on the type of task, different tabs will be enabled in the Task panel. For submission tasks, the data appears in the
Submitted tab. Once a submission task is completed and a task has data indexed in the browser, its data appears in the
Dicom tab. For tasks that have files associated with them, which will appear in the Files tab of the task viewer, the right-click
menu provides the “Open Externally” option for opening files using the system’s default application for that file type.

Files Tab

Files that appear in the Files tab that can be opened in VivoQuant, such as images and RMHAs, can also be opened in
VivoQuant using the Open and Append buttons and the Open and Append options in the right-click menu. Choosing this
option for an RMHA will open the 3D ROI Operator and load the RMHA file.

For tasks that are the output or result of an iPACS pipeline, the Analysis Results tab will be available. The Analysis Results tab
shows the JSON output of the pipeline in an expandable tree format. The JSON can be downloaded as a file or copied to the
clipboard using the right-click menu.
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Analysis Results

The Reports tab contains PDF file reports which can be opened using the right-click tab similarly to the Files tab.
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Data Manager
The Data Manager presents information about the datasets loaded into VivoQuant. While VivoQuant only displays up to
three datasets in the Display at a time, post-processing operations may be performed on any number of datasets in the Data
Manager. The only limiting factor in the number of simultaneously loaded dataset is the system memory.

Getting There

There are three methods to open this tool. The first method is using the Data Manager thumbnail  in the Main Window.

The second method is to go to Data Manager under the Tools menu.

Data Manager

Finally, the Data Manager is also available by using the keyboard shortcut F7.

Using the Data Manager

The Data Manager displays a list of all datasets loaded into VivoQuant, along with information about each of them. This tool
can hold as many datasets as the system memory allows; however, the first, second and third datasets in the Data Manager
are the only three that appear in the Display. These datasets are the Reference, Input 1, and Input 2, respectively.

The information displayed by the Data Manager includes the image type, name, dimensions and voxel size. For DICOM data,
the Study Date, Series Date, and Series Description will also be included when available. The information that is shown can
also be customized with the Data Manager Text Configuration.

Below this information is a color bar specific to each dataset. The color bar defines the colors that will be used to represent
the dataset in the Display. The colors can be changed by right-clicking the color bar and selecting the desired color palette.
VivoQuant selects color palettes for datasets by default based on modality (CT, PT, MR, etc.). Default color palette options
may be changed in the Display tab of the Configuration window. These changes do not affect the minimum and maximum
values stored in the Min/Max Tool. For more information on changing the minimum and maximum values, see the Min/Max
Tool page.
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Data Manager Window

If the windowing is using the Min/Max option, the palette can be adjusted by clicking on the black bars at the far left or right
of the palette to adjust the window min or max, respectively. If the windowing is using the Level/Width option, the width of
the window is adjusted by clicking and dragging the ends, while the center is adjusted by clicking and dragging the middle of
the palette display. The Level/Width palette can be also adjusted similarly to the Min/Max by holding the Shift key while
dragging the ends.

The windowing can be adjusted within the image as well, by holding a right-click and dragging the mouse. In the Min/Max
setting, dragging left/right will adjust the min while up/down will adjust the max. In the Level/Width setting, dragging
left/right will adjust the level, while up/down will adjust the width. This function works within any of the operators and does
not require that the Data Manager is active.

The color palettes for a single frame of data can be edited in the Data Manager by right-clicking on the color palette.
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Edit Single Frame

To edit multiple frames at once, use Ctrl or Shift to select multiple frames, then right-click on one of the palettes, and all
frames will be edited together. This technique can also be used for editing the Min/Max for the palettes of multiple frames at
once.
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Edit Multiple Frames

Ordering Data

Data may be rearranged into any order in the Data Manager by dragging a dataset and dropping it to the desired position.
Alternatively, data can be moved into the Reference, Input 1 or Input 2 location by right-clicking and selecting Move to
Reference/Input 1/Input 2.
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Move to Reference

A prompt will appear confirming the move. Click OK to complete the move.

Confirm Move

A dataset can also be quickly swapped with the dataset in the Reference, Input 1, or Input 2 positions by right-clicking on a
dataset and selecting Swap with Reference /Input 1 /Input 2 .
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Swap with Reference

Options

Right clicking on a dataset brings up a menu with several data manipulation options.

Option Description

Move to Reference/Input 1/Input
2

Moves the selected data set to either the Reference/Input 1/Input 2.

Annotate Allows an annotation to be added to the data details.

Copy Details Copies data set details to the clipboard, from where they may be pasted into other
files.

DICOM Dump Opens the DICOM header information for the selected data sets.

Save Data as Allows data to be saved as DICOM, TRaster, Raw, 4D or ITK image file.

Merge Data Merges two or more selected data sets into one.

Unload Data Unloads data from VivoQuant.
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More Information

Many of the functions in VivoQuant are directed to specific images loaded in the Data Manager, so it is important to pay
attention to the order in which data has been loaded into it.

See How To Make a Dynamic Movie for a practical example that makes use of the Data Manager.
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Annotation
The Annotation tool allows you to write and save a comment on any of the files currently loaded in the Data Manager

Adding An Annotation

Right click on the data in the DM you want to edit and select Annotate.

Add Annotation

Write your comment and select OK.
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Write Comment

Your annotation will appear in the data as Ann. It will read Ann: [user] [date]:[annotation]

Annotated Data

You can add as many annotations as needed following the same steps as above. To view all your annotations in full, right click
on the data and select Show Annotations.
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Show Annotations

Annotations Panel

You can also check, edit, and delete your annotations in iPACS. Just log in, locate the file you annotated, click on its number
of data points (DP) and a chart will appear with your annotation and options to edit or delete.

Annotations can only be deleted in iPACS. You have to refresh your iPACS browser or update VivoQuant in order for your
annotation edits to appear in either.
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Save Data
The data can be saved in four different formats. It can be saved as DICOM, TRaster, Raw data files, or Via ITK. The data can
be saved as a DICOM file after post-processing and then be reopened in VivoQuant in its new format for further processing.
Saving the data in different formats enables it to be opened in different programs at a later stage.

Getting There

The data can be saved by selecting Save data under the File menu after data has been loaded.

Save Data As

Function

Once the Save Data option has been selected, there is an option to save the data in four different formats.

DICOM

TRaster

Raw

Via ITK

DICOM If the data is to be saved as a DICOM file, a Store DICOM file window is displayed. Any relevant information or
description of the study can be entered into the DICOM information section of the window. Under the Data
Storage section, the repository and the format of the saved DICOM files can be specified. The DICOM files are
saved by clicking on Save or it can be canceled by clicking Discard.
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Save as DICOM

TRaster If the data is to be saved as a Raster file, a Save Data as Raster window will be displayed and here the data can
be saved to an appropriate location.

Raw If the data is to be saved as a raw file, a Save Data as Raw window will be displayed and here the data can be
saved to an appropriate location.

Via ITK If the data is to be saved via ITK, a Save Data via ITK window will be displayed and here the data can be saved
to an appropriate location.
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Image Magick
Use the Image Magick suite to manipulate frames and movies within VivoQuant. These options are useful for generating
appealing and informative dynamic movies.

Getting There

Select the Image and Movie option of the Tools menu.

Image Magick

Function

The Image Magick options available in VivoQuant provide an excellent tool for generating informative movies for dynamic
and gated data acquisitions. These tools allow you to combine datasets in meaningful ways to reflect the dynamic nature of
the physiological processes taking place.

The Image Magick suite provides four options:

Split Movie into Frames

Join Frames to Movie

Change Movie Delay

Image to Capture

Split Movie Into Frames

This option takes a movie file (options include .gif, .mpg, .mng, and .mpeg) and splits it into individual frames (options include
.png, .bmp, .jpeg, .jpg, and .tif).

Join Frames to Movie

This tool allows you to take individual images (options include .png, .bmp, .jpeg, .jpg, and .tif) and combine them into a movie
file (options include .gif, .mng, .mpg, and .mpeg).

Change Delay

Depending on the size and style of the movie taken, the default frame time may be too fast or too slow. This tools allows you
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to select a pre-existing movie and change the frame time (in milliseconds).

Image to Capture

The Image to Capture feature allows you to load an image or movie from a file on the local machine, edit it, and then re-save
it. The Capture Viewer also supports importation of the image/movie into a DICOM/iPACS repository by using the Save
Capture button.

How to make dynamic movies

Dynamic and cardiac-gated images and movies are useful for illustrating the changing distribution of radioactivity governed
by a dynamic physiological process. This guide provides step-by-step instructions on the proper generation of such files. Use
the links to visit the VivoQuant Manual for more details on any particular feature.

Before using this guide, it is important to understand how to process images so that they are color-comparable across
multiple frames. Matching color scales between two images is not enough to ensure that they are directly color-comparable.
Instead, it is necessary to ensure that the colors in each loaded correspond to the same physical voxel values. You can
achieve this relationship using the Min/Max tool to define the range of voxel values spanned across the color bar.

Load all relevant data sets. These data sets may be only SPECT images (as in this example) or a reference CT in addition to
multiple SPECT images.

Load Relevant Datasets

Adjust the Zoom and Color Palettes to your liking.
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Adjust Zoom and Color

Use the Cropping Tool to select the region of interest.

Cropping

If desired, use the Filtering Operator. Note that if you check Input 3 and higher in the Select pull-down menu of the Filtering
operator, then smoothing will be applied to loaded data sets not displayed in the Main Window, but visible in the Data
Manager.
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Filtering

One of the most critical steps is the application of the Min/Max Tool. First, use the Re-Calc button to display the current
minimum and maximum values used for color scaling. Choose common Min/Max values across all three data sets. Use the
Apply button to adjust the color scaling accordingly. The three visible data sets are now color-consistent: the same colors
represent the same voxel values across each data set.

Min/Max Tool

Save images for each data set using the Save Image option. The All s separately option in the Storage Type pull-down
automatically saves five images (sagittal, coronal, transverse, MIP, all-in-one) simultaneously.
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All Images Separately

Use the Slice Control or appropriate Keyboard Shortcuts to toggle between visible data sets and save the appropriate
images.

After collecting the images for the first three frames, use the Data Manager to save these processed frames (if desired) and
then unload these data sets so that the next three frames in the queue become visible data sets. All operations (such as
Cropping, Projection, and Smoothing) applied to the original three data sets are also been applied to the queued data sets,
with the exception of the Min/Max tool.

Slice Control

Ensure again that the minimum and maximum values are consistent across datasets, so that the newly loaded data sets are
properly prepared. Save the images and data as described above.

After saving all desired images, generate the dynamic movie using the Join Frames to Movie option.
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Join Frames to Movie

Select the images you wish to include in the movie.

Select s

Type in a name and choose a format type for the movie file. The default file format is .gif.

Finally, use the Change Movie Delay option to speed up or slow down the movie frame rate.
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Change Movie Delay
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Frame Time Editor
The Frame Time Editor tool allows you to change the frame duration in the DICOM Header

Getting There

The Frame Time Editor is available via the Tools menu.

Frame Time Editor

Function

Here you can change the AcquisitionDate, AcquisitionTime and ActualFrameDuration.

Frame Time Editor

 Note: It uses the DICOM tags FrameAcquisitionDuration if it’s dynamic data; otherwise, it uses ActualFrameDuration.
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Update Check
VivoQuant is frequently updated to provide more and better tools for all post-processing needs. Therefore, periodic Update
Checks are recommended to ensure that you have the latest software available.

Getting There

There are two methods to access the Update Check function. The first method is through the Tools menu.

Update Check

The second method is to use the keyboard shortcut Ctrl+Shift+u.

Function

If an update is available, the Update Check will present a window providing an option for downloading the new version. You
may either choose to download, by clicking on Yes; not to download, by clicking on No; or to ignore entirely, by clicking on
Ignore.

Update Options

If you download the new version, you will be prompted to follow several straightforward installation steps. For more
information on installation, see the Installation section of this manual.
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Advanced Modules
The Advanced Modules Menu contains a wide range of tools available for a variety of post-processing applications.

Plug-In Modules

Multi-Atlas Segmentation Tool

3D Brain Atlas Tool

Pharmacokinetic Modeling

NanoSPECT

QuantiCalc

Specific Activity Calculator

SUV Calculator

Crosstalk Removal

Biodistribution Visualization

Split Projections

Calibration

CT Geometrical Calibration

MMP SPECT Calibration

Near-Field Uniformity QC

Dosimetry Calc
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Plug-In Modules
VivoQuant™ offers a variety of additional Plug-in Modules in addition to the base license. These are accessed through the
Advanced Modules Menu.

Multi-Atlas Segmentation Tool

3D Brain Atlas Tool

Pharmacokinetic Modeling

For more information on the inviCRO’s Advanced Segmentation Tool Kit, please contact your inviCRO representative or
email support@invicro.com.

You can also access a helpful How To illustrating the main features of the 3D Brain Atlas Tool by going to Tools -> Workflow
Assistant and selecting the 3D Brain Atlas Analysis Tool workflow.
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Multi-Atlas Segmentation Tool

Overview

The Multi-Atlas Segmentation Tool generates ROIs by registering a series of images in a Reference Library to the image that
has been loaded in the Data Manager. The Reference Images must each have a corresponding ROI. The tool registers the
images in the Reference Library to the loaded data, and applies the same transformation to the corresponding ROI. The tool
then works on a voxel-by-voxel basis, classifying a voxel to the new ROI if a greater percentage of the reference sets
classified that voxel as within the ROI than the threshold percentage set by the user. Important factors that influence
performance include image contrast, animal positioning consistency, and the size of the reference library.

Image ROI

Getting There

You can access the Multi-Atlas Segmentation Tool by navigating to Advanced Modules -> Multi-Atlas Segmentation. Here,
there are three options: Multi-Atlas Segmentation, Add to Library, and Download Sample Library.
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Multi-Atlas Segmentation

Adding to Reference Library

The Reference Library is the basis of the efficacy of the Multi-Atlas Segmentation Tool. The Reference Library is stored
locally, and is built in one data set at a time.

The first step in adding a data set to the Reference Library is to open the data and ROI. In order to add to the Library, there
must be an active ROI in the 3D ROI Tool. There can be multiple ROIs, but it is important, when building the Reference
Library, to keep the naming of ROIs consistent; that is, if the organ of interest is the left kidney, always call it exactly Left
Kidney, otherwise, it will not be recognized as all the same organ (however, capitalization does not have an effect).

With the data and ROI loaded simply navigate to and click Add to Library as described above. The GUI will appear.

Add Reference to Library

The GUI offers four editable fields:
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Image
to
Submit

This option allows you to select which of the loaded images to submit to the Reference Library.

Patient
ID

The Patient ID can be anything that is unique and will help you identify this data set when selecting which
scans to use from your Reference Library.

Protocol The Protocol should include information as to how the image was acquired, the field of view, modality, etc.
This will be used as a filter to determine which scans from the Reference Library will be used by the tool.

Species The Species dropdown list contains frequently imaged species. If you wish to have additions made to the
options provided please contact your Account Manager or support@invicro.com.

Segmenting With The Tool

With the image on which the new ROI is to be drawn loaded in the Data Manager, open the Multi-Atlas Segmentation Tool.
You can apply the segmentation settings and perform other tasks from the tool’s GUI.

Segmentation Tool

Settings

The tool relies on the settings you select. There are two levels of settings, the Basic Settings, explained below, and the
Advanced Settings, which should not need to be modified.

Basic Settings

The Basic Settings tab contains most of the settings that will need to be changed. Here, you can select the appropriate
Reference Images, the appropriate Test Image, ROIs to segment, and Probability Threshold to use.

 Note: To reload the settings from a previous run, click Load settings file and browse to the output path to find the
generated settings.txt file.

Reference List Selection

Selecting the proper Reference scan is imperative to the proper functionality of the tool. The settings you select that factor
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into the images used are outlined in the table below:

Image The image in the Data Manager that will be the basis of the ROIs generated.

Species The species of the animal being segmented. This is based on the available options in the Reference Library.

Voxel
Size

The Low and High parameters for the voxel size of the Reference Images available. The default low is 0.00mm
and the default high is the voxel size of the data loaded. Using Reference Data with a lower resolution than
the data that has been loaded will compromise the quality of the Reference ROI.

Protocols A list displaying the protocols present in the Reference Library. Changing the protocols included will narrow
the Reference List. Only include Reference Images with the same protocol as the image loaded in the Data
Manager.

ROIs A list displaying the possible ROIs to generate based on those present in the Reference Library. Only those
selected will be generated by the Tool.

Other Basic Settings

You can also edit the Probability Threshold. Following the registration of each Reference Image to the image in the Data
Manager, each voxel is assigned a probability that it belongs in the ROI. Only voxels with a probability greater than the
threshold you set will be mapped to the ROI. The default for this setting is 0.5; and, typically, the ROI will become larger as
the threshold is lowered.

Select Images

The middle pane of the GUI allows you to select which images to use for the final Reference List. These should already have
been narrowed down by your previous selections in the Settings pane. It is up to you how many Reference Images to use.
However, the time the tool takes to run is largely influenced by how many Reference Images are selected.

Run Tool and View Log

Once the Settings and the Reference Images have been selected, click Run in the lower right corner of the GUI to run the
tool. The Log outlines the steps taken by the tool. At its completion, the tool remains open, but VivoQuant navigates to the
3D ROI Tool, where the new ROIs can be viewed and modified.

 Note: Uncheck the option Close dialog after completion to keep the tool open in order to inspect the log.

Downloading Sample Library

A sample Reference Library is available depending on the VivoQuant license. This option is used for testing and learning how
to operate the tool. To download it, navigate to Advanced Modules->Multi-Atlas Segmentation->Download Sample Library.

Download Sample Library
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3D Brain Atlas Tool

Overview

Use the 3D Brain Atlas Tool to perform brain region analysis. The tool can handle CT or MR data as the input and MR, PET,
or SPECT for the input functional data.

Instructions for the use of the tool are available through the Workflow Assistant, which can be accessed via the Tools menu.

Workflow Assistant

 Warning: Please use caution when scaling data in this tool, as this can lead to errors in quantitation. For more information,
refer to the Treatment of Quantitative Data page.

The brain atlas path location

The brain atlas path can be set via the Advanced Modules > Install Atlas > Change Atlas directory option. Typically the default
path is located next to the VivoQuant cache:

Platform Default path

macOS ~/Library/VivoQuant/atlas

Ubuntu ~/.VivoQuant/atlas

Windows %appdata%/inviCRO/VivoQuant/atlas
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Customizing the atlas path

 Note: Users can also download a sample Mouse and Rat atlas from this menu.
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Pharmacokinetic Modeling

Pharmacokinetic modeling is available in VivoQuant as a plug-in for the Modeling operator. Access to the plug-in
depends on your VivoQuant license. For information on your license, please contact your account manager or email
support@invicro.com

Getting There

The Modeling operator can be accessed via the tool pull-down menu on VivoQuant’s front panel.

Modeling Operator

Function

For more on the function of the Modeling operator, see the Modeling operator page.

Input/Reference Function

Every tissue model requires the input of an additional temporal curve, either as an arterial input function or concentration of
a reference tissue. These temporal data may be derived from image data directly or from acquired samples. The operator
supports input and computation of parent fraction samples, plasma fraction samples, whole blood concentration, and plasma
concentration. In addition, these data can be stored and retrieved from disk and from an iPACS.

Parent/Plasma Fraction

The experimentalist may have acquired blood samples throughout the subject’s scanning session. From these samples, the
ratio of unmetabolized tracer to the sum of unmetabolized tracer and its derivative metabolites can be measured and used to
account for the dynamic nature of available tracer. This is also known as the parent fraction or plasma free fraction. Without it,
the tissue model must assume that metabolism of the tracer is negligible. Whether measured, simulated, or estimated, the
parent fraction can play an important role in accurate estimation of tissue kinetics downstream. Similarly, the fraction of
plasma to whole blood (including red blood cells) has been shown to be an important factor in the estimation of an
appropriate arterial input function [1]. The fraction modeling can be selected from the dropdown of models or from the
Operator menu.
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Fraction Modeling

Both plasma and parent fraction data can be input using the same tool. Towards the bottom of the operator, space is
provided for a table of fraction data. There are 3 columns. The first one can be used to exclude specific time points from the
table. The second column contains the time of each sample in units of minutes. The last column contains free fraction values,
assumed to have a value between zero and one. Users can choose to use a linear interpolation of the points or fit a sum of
exponentials to the provided points. The Save Interp button can be used to save the points as is, at which point the tool will
prompt the user for a name to give the saved curve. If this option is chosen, the operator will prepend a value to time=zero,
assuming that the fraction is equal to one at that time. After the last provided time point, the value is assumed to remain
constant equal to the last fraction value.

Users may want to smooth the fraction points with a sum of exponentials. Up to 3 exponentials can be used to fit the curve. If
less exponentials are desired, users can fix model parameters for one or more of the exponentials (i.e. fix A3=0 and B3=0) [2].
To do so, use the Run button to estimate model parameters under the input conditions provided by the user.

 Important: Use the Estimate t0 button to estimate the start point for the model.

Once you are satisfied with the model estimates, click on Save Fit while the estimate plots are open to save the current
model-estimated fraction curve to the list.

Model Assumptions

This model makes the following assumptions:

The exponential decay begins at user-provided t0

Provided fraction measurements lie between zero and one

References

[1] “Red blood cells: a neglected compartment in pharmacokinetics and pharmacodynamics”. Hinderling. Pharmacol Rev, 1997.
Link .

[2] “Optimal Metabolite Curve Fitting for Kinetic Modeling of 11C-WAY-100635”. Wu, et al. JNM, 2007. Link .
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Arterial Input Function

An Arterial Input Function (AIF) is required for Logan, Patlak, 1- and 2-tissue compartment, and MA1 analysis. To add time
points to an AIF, begin by selecting Blood/Ref 3-Exp from the list of models.

Arterial Input Function

Similar to the parent fraction, users can select to save a linear interpolation of points or a smooth model estimate of AIF
samples. Either way, samples should be input into the table of values as a first step. This may be done with a copy/paste from
an external spreadsheet program or by incrementing the Time Points (table rows) number and manually editing the table. The
table assumes a structure with the number of rows equal to the number of samples. Each sample has three columns. The first
column indicates whether that sample should be excluded or not. The second column contains the time (in minutes) at which
sample was measured. Times should be consistently relative to the same reference start time as the final modeled time
activity curves. The third column contains the measured concentration value at that time. If parent or plasma fraction data are
available and applicable to the provided samples, select them from the dropdown. If none is selected, the fraction is assumed
to be one for the entirety of the time activity curve. If image derived samples are desired, the user may also compute the
samples directly from the average concentration values with ROIs in the loaded image. To do this, select the appropriate
region from the dropdown and click on the *Compute IF button. For more information on segmenting regions of interest from
an image, see the 3D ROI tool.

 Important: Select a unit of concentration for the samples. By default, this dropdown will be set to the unit of the loaded
image data.

If a sum of exponentials model for the samples is desired for smoothing the data, click on Run to estimate exponential
parameters for the data. Before doing so, it may be important to select an appropriate t0 value. This is best estimated from
the samples themselves with the Estimate t0, which will set t0 to the time point where the maximum concentration occurs in
the samples. The linearly interpolated samples or model fit may be saved for use in tissue modeling with the Save Interp or
Save Fit buttons, respectively.

Reference Tissue Compartment

The reference tissue compartment concentrations can be readily computed similar to the Arterial Input Function (AIF). Like
the AIF, you may input the concentrations from a spreadsheet or by manual input; however, it is more likely you will want to
derive the concentration values from a reference region segmented on the loaded images. For more information on
segmentation techniques in VivoQuant, see the 3D ROI Tool page. Begin by navigating to the Blood/Ref 3-Exp. model in the
operator. Next, select the appropriate region of interest in the Img Derived dropdown.
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Reference Tissue Compartment

The Compute IF button will compute the average concentration in the selected region and populate the table, one row for
each volume loaded. The time points are computed from the image acquisition times and frame durations, set to the midpoint
of each frame, and relative to the start of the dynamic scan. Should the temporal information be missing from the image data,
this can be added using the Frame Time Editor, found in the Tools menu. A sum of exponentials model can also be estimated
from the table data. Ensure that the parent/plasma fraction inputs are disabled by setting their respective dropdown setting
to 1. To save a linear interpolation of the concentrations, click on the Save Interp button. Should you want to fit a sum of
exponentials, begin by specifying an appropriate t0 parameter, which can typically be estimated using the Estimate t0 button.
Fitting the sum of exponentials model can be done with the Run button, at which point you will be able to save the fit using
the Save Fit button.

Saving and Loading of Fraction, AIF, and Reference Region Data

All temporal curves can be saved with the Save Interp or Save Fit buttons. When they are saved, their user-provided name
appears in the dropdown of Saved Curves.

Saved Curves

Controls next to the dropdown are available for saving, loading, and viewing the curves. The  menu provides options for
storing the temporal data to/from the iPACS or as a spreadsheet on your local hard drive. This is particularly useful to avoid

re-entry of the information should you want to re-run analysis at a later date. The  menu is an additional tool for the user

to store the current linearly interpolated samples or modeled data into the list of saved curves. The  button clears the

currently selected temporal curve from the list. Lastly, the  button opens a new dialog window showing a plot of the
temporal curve which can be saved as a local image for quality control.

Additional Resources

“Emission Tomography: The Fundamentals of PET and SPECT”, Miles Wernick & John Aarsvold. Elsevier, 2004.  Print.

“Fractions of unchanged tracer in plasma”, Vesa Oikonen. Turku PET Center website. Link

“Converting blood TAC to plasma TAC”, Vesa Oikonen. Turku PET Center website. Link

“Blood sampling in PET studies”, Vesa Oikonen. Turku PET Center website. Link

“Arterial input function from PET image”, Vesa Oikonen. Turku PET Center website. Link

Models
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Two-Tissue Compartment Model (2TCM)

The 2TCM is a three-compartment model that includes two tissue compartments: one tissue compartment represents free
and nonspecifically bound tracer within the tissue (referred to as nondisplaceable), and the other tissue compartment
represents specifically bound tracer within the tissue. The third compartment represents tracer within the arterial plasma.

Parameter Description

CND(t) Concentration in F + NS compartment, nodisplaceable
tracer.

CS(t) Concentration in specifically bound (S) compartment.

Cp(t) Concentration in plasma (P) compartment.

K1(mL*cm3*min-1) Transfer of ligand from arterial plasma to tissue.

k2 (min-1) Transfer of ligand from tissue to arterial plasma.

k3(min-1) Transfer of ligand into specifically bound compartment.

k4 (min-1) Transfer of ligand out of specifically bound compartment.

For those tracers for which a compartmental model is appropriate, estimation of the rate constants provides valuable
information about tracer uptake and binding [1]. Due to the difficulty of reliably estimating all four parameters of the 2TCM,
lumped or macroparameters are often employed. Macroparameters are rate constants which are functions of individual
microparameters (e.g. K1, k2, k3 and k4). One such macroparameter that is estimated by the 2TCM is the total volume of
distribution, VT.

When the 2TCM is applied to image data with a reference region, the distribution volume ratio (DVR) can be calculated: DVR
= VT/VND, where VND is the estimated distribution volume in a region that is devoid of the target site or receptor (often
called the reference region or nondisplaceable region). Binding potential (BPND) can then be calculated by BPND = DVR - 1.

Model Assumptions

This model makes the following assumptions:

The tracer binds reversibly.

Nonspecifically bound ligand equilibrates rapidly with free tissue ligand.

Compartmental model assumptions:

The tracer kinetics or behavior can be represented by a compartmental model.

Tracer concentration within each compartment is well-mixed and does not vary spatially.

First-order kinetics can describe exchange of ligand between compartments.

 Note: Violation of any of these assumptions may produce biased parameter estimates. While the model will still run in
VivoQuant, the estimated parameters may not accurately reflect the true tracer kinetics.

The 2TCM is currently implemented in VivoQuant using a basis function method approach [2] and unweighted fitting in this
basis function method,
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Required Inputs

This model requires the following inputs:

Metabolite-corrected arterial plasma input curve.

ROI(s) or voxels.

Outputs

Region-level analysis:

Plot of data from each ROI with 2TCM fit.

VT, K1, k2, k3, k4, mean-squared error (MSE) of fit, Θ1, and Θ2 are shown when the cursor is hovered over the model fit
plot.

VT, K1, k2, k3, k4, mean-squared error (MSE), data and 2TCM fit for each ROI can be saved out to .csv

References

[1] “A quantitative model for the in vivo assessment of drug binding sites with positron emission tomography”. Mintun, et al.
Ann Neurol, 1984. Link .

[2] “Kinetic modelling using basis functions derived from two-tissue compartmental models with a plasma input function:
general principle and application to [18F]fluorodeoxyglucose positron emission tomography”. Hong, et al. NeuroImage, 2010.
Link .

Additional Resources

“Compartmental Models”, Vesa Oikonen. Turku PET Center website. Link .

One-Tissue Compartment Model (1TCM)

The 1TCM is a two-compartment model that includes one compartment representing tracer within the tissue (free and
nonspecifically bound tracer which together are referred to as nondisplaceable tracer) and one compartment representing
tracer within the arterial plasma [1].
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Parameter Description

CND(t) Concentration in F + NS compartment, nondisplaceable
tracer.

Cp(t) Concentration in plasma (P) compartment.

K1 (mL*cm3*min-1) Transfer of ligand from arterial plasma to tissue.

k2 (min-1) Transfer of ligand from tissue to arterial plasma.

VT = K1/k2 Total volume of distribution.

For tracers for which a compartmental model is appropriate, estimation of the rate constants provides valuable information
about tracer uptake [2]. The 1TCM is generally easier and less computationally intensive to solve than the 2TCM, because it
is a simpler model and has fewer parameters. Additionally, the 1TCM model parameters can generally be estimated with
better identifiability than the 2TCM model parameters.

In some cases, the exchange of tracer between the nondisplaceable and bound tissue is sufficiently fast, so the two cannot be
distinguished kinetically. In these cases, the nondisplaceable and bound tissue compartments may be collapsed into one
compartment that represents both the nondisplaceable and specifically bound tracer within the tissue [3]. In these cases,
apparent transfer of ligand from tissue to arterial plasma is represented by the parameter k2a and VT = K1/k2a.

When a tracer that specifically binds to a target can be represented by a 1TCM as above, and has a reference region the
distribution volume ratio (DVR) can be calculated: DVR = VT/VND, where VND is the estimated distribution volume in the
reference region. Binding potential (BPND) can then be calculated by BPND = DVR - 1 .

Model Assumptions

This model makes the following assumptions:

The tracer binds reversibly.

Nonspecifically bound ligand equilibrates rapidly with free tissue ligand.

Compartmental model assumptions:

The tracer kinetics or behavior can be represented by a compartmental model.

Tracer concentration within each compartment is well-mixed and does not vary spatially.

First-order kinetics may be used to describe exchange of ligand between compartments

 Note: Violation of any of these assumptions may produce biased parameter estimates. While the model will still run in
VivoQuant, the estimated parameters may not accurately reflect the true tracer kinetics..

Required Inputs

This model requires the following inputs:

Metabolite-corrected arterial plasma input curve

ROI(s) or voxels

Outputs
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Region-level analysis:

Plot of data from each ROI with 1TCM fit.

VT, K1, k2, and mean-squared error (MSE) of fit are shown when the cursor is hovered over the model fit plot.

VT, K1, k2, and mean-squared error (MSE) of fit, data, and 1TCM fit for each ROI can be saved out to .csv.

Voxel-level analysis

Plot of data for each voxel with 1TCM fit. Select the voxel for which you would like to see the model fit by clicking on it
with the image viewer.

VT, K1, k2, and mean-squared error (MSE) of fit are shown when the cursor is hovered over the model fit plot.

Parameter maps for VT, K1, k2, and mean-squared error (MSE).

References

[1] “Kinetic modeling in positron emission tomography”. Morris, et al. In: Emission Tomography: The Fundamentals of PET and
SPECT (Eds: wermick MN, Aarsvold JN). 2004.

[2] “Comparison of methods for analysis of clinical [11C]raclopride studies”. Lammerstsma, et al. JCBFM, 1996. Link

[3] “Kinetic modelling using basis functions derived from two-tissue compartmental models with a plasma input function:
general principle and application to [18F]fluorodeoxyglucose positron emission tomography”. Hong, et al. NeuroImage, 2010.
Link .

Additional Resources

“Compartmental Models”, Vesa Oikonen. Turku PET Center website. Link

Logan Graphical Method (Logan Plot)

The Logan Graphical Method [1] was developed for reversibly bound tracers based on the Patlak method for irreversibly
bound tracers [2]. The Logan method proposes that after some time t*, the plot of

 vs. 

where CT is the concentration of the tracer in the tissue and CP is the concentration of the tracer in the metabolite-corrected
arterial plasma, becomes linear with slope equal to the total volume of distribution, VT.

Page 274

http://www.ncbi.nlm.nih.gov/pubmed/8530554
http://www.ncbi.nlm.nih.gov/pubmed/20156574
http://www.turkupetcentre.net/petanalysis/model_compartmental.html


When the Logan Plot is applied to image data with a reference region, the distribution volume ratio (DVR) can be calculated:
DVR = VT/VND, where VND is the estimated distribution volume in the reference region. BPND is related to DVR by BPND =
DVR - 1

The Logan Plot is a rearrangement of tracer kinetic equations to yield a useful linear equation. However, the mapping of
transformed variables is nonlinear in CT(t), and this results in an underestimation of VT which becomes more pronounced
with larger true VT and increased noise [1,3]. Therefore, the Logan graphical method may not be the best method to use
when data are noisy, and other methods should be considered.

Model Assumptions

This model makes the following assumptions:

The tracer binds reversibly

After some time t* the slope of the plot of  vs.  approaches linearity.

 Note: Violation of any of these assumptions may produce biased parameter estimates. While the model will still run in
VivoQuant, the estimated parameters may not accurately reflect the true tracer kinetics.

Required Inputs

This model requires the following inputs:

Metabolite-corrected arterial plasma input curve

ROI(s) or voxels

t* (in scan time)

Selection of t*: The Logan plot as implemented in VivoQuant requires that the user inputs the t*, which defines the
time at which the plotted data become linear. In VivoQuant the default t* value is 0. This is likely not the
appropriate value for your experiment. t* values are tracer dependent. For characterized tracers, we suggest
reviewing the literature to see which t* values have been used in Logan method. The simplest way to select a
reasonable t* value for your data is to run the model once with the default t* value, review the Logan plots to find
the point at which they become linear (t*), then re-run the model with the appropriate t* (in scan time) value.

Outputs

Region-level analysis
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Logan plot with line fit for each voxel. Select the voxel for which you would like to see the Logan plot by clicking on it
within the image viewer.

VT, fitted line intercept, and mean-squared error (MSE) of fit are shown when the cursor is hovered over the Logan plot.

Parameter maps for VT, fitted line intercept, and MSE.

References

[1] “Kinetic modeling in positron emission tomography”. Morris, et al. In: Emission Tomography: The Fundamentals of PET and
SPECT (Eds: wermick MN, Aarsvold JN). 2004.

[2] “Comparison of methods for analysis of clinical [11C]raclopride studies”. Lammerstsma, et al. JCBFM, 1996. Link

[3] “Effects of Statistical Noise on Graphic Analysis of PET Neuroreceptor Studies”. Slifstein and Laruelle. JNM, 2000. Link

Additional Resources

“Multiple Time Graphical Analysis (MTGA)”, Vesa Oikonen. Turku PET Center website. Link

Simplified Reference Tissue Model (SRTM)

The simplified reference tissue model (SRTM) [1] allows for quantification of tracer kinetics without requiring an arterial
input function. SRTM is a numerically robust model which assumes that the tracer can be represented by 1-tissue
compartment models in both the ROIs and the reference region.

Parameter Description

CT(t) Concentration in F + NS + S compartment.

CND(t) Concentration in F + NS compartment, nondisplaceable
tracer.

CP(t) Concentration in plasma (P) compartment.

K1 (mL*cm3*min-1) Transfer of ligand from arterial plasma to tissue.

k2a (min-1) Apparent transfer of ligand from tissue to arterial plasma.

K1’ (mL*cm3*min-1) Transfer of ligand from arterial plasma to reference tissue.

k2’ (min-1) Transfer of ligand from reference tissue to arterial plasma.

Page 276

http://www.ncbi.nlm.nih.gov/pubmed/8530554
https://pubmed.ncbi.nlm.nih.gov/11138696/
http://www.turkupetcentre.net/petanalysis/model_mtga.html
file:///home/runner/work/vivoquant-manual/vivoquant-manual/mirror/assets/images/advanced_plugin_pharmacokinetic_SRTMROI.jpg


Model Assumptions

This model makes the following assumptions:

The tracer binds reversibly.

Tracer concentration in all regions or voxels-of-interest as well as the reference region (see below) can be represented
by a 1-tissue compartment model.

A region/tissue exists which is devoid of the target site/receptor. We call this region the reference region. It represents
the concentration of the tracer which is free in tissue and/or bound to off-target sites (non-specific binding). An ideal
reference region is a) devoid of the target site/receptor, and b) has the same concentration of tracer free in tissue and
nonspecifically bound as the ROI.

 Note: Violation of any of these assumptions may produce biased parameter estimates. While the model will still run in
VivoQuant, the estimated parameters may not accurately reflect the true tracer kinetics [2]. SRTM is currently implement in
VivoQuant using a basis function method approach and unweighted fitting [3].

Required Inputs

This model requires the following inputs:

Reference tissue curve.

ROI(s) or voxels.

Outputs

Region-level analysis

Plot of data from each ROI with SRTM fit.

BPND, R1,k2,k2’, and mean-squared error (MSE) of fit are shown when the cursor is hovered over the model fit plot.

BPND, R1,k2,k2’, and mean-squared error (MSE), data and SRTM fit for each ROI can be saved out to .csv.

Voxel-level analysis

Plot of data for each voxel with SRTM fit. Select the voxel for which you’d like to see the model fit by clicking on it with
the image viewer.

BPND, R1,k2,k2’, and mean-squared error (MSE) of fit are shown when the cursor is hovered over the model fit plot.

Parameter maps for BPND, R1,k2,k2’ and MSE.

References

[1] “Simplified reference tissue model for PET receptor studies”, Lammerstma and Hume. NeuroImage, 1996. Link

[2] “The simplified reference tissue model: model assumption violations and their impact on binding potential”, Salinas, et al.
JCBFM, 2015. Link

[3] “Parametric imaging of ligand-receptor binding in PET using a simplified reference region model”. Gunn, et al. NeuroImage,
1997. Link
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Additional Resources

“Reference region input compartmental models”, Vesa Oikonen. Turku PET Center website. Link .

Simplified Reference Tissue Model 2 (SRTM2)

SRTM2 is a two-pass version of SRTM that attempts to reduce noise in parametric images by fitting all voxels with a fixed,
global k2’ [1]. In practice, SRTM estimates k2’ for every voxel or region, but since there is only one reference region, in
principle there is only one true k2’ value [1]. Fixing k2’ reduces the number of parameters estimated and thus reduces noise in
parametric images [1]. However, this improvement in precision may come at the price of an increase in bias [1].

 Note: SRTM2 can be used on both the region- and voxel-level but generally shows greatest advantage over SRTM when
used at the voxel-level.

Model Assumptions

This model makes the following assumptions:

The tracer binds reversibly

Tracer concentration in all regions or voxels-of-interest as well as the reference region (see below) can be represented
by a 1-tissue compartment model.

A region/tissue exists which is devoid of the target site/receptor. We call this region the reference region. It represents
the concentration of the tracer which is free in tissue and/or bound to off-target sites (non-specific binding). An ideal
reference region is a) devoid of the target site/receptor, and b) has the same concentration of tracer free in tissue and
nonspecifically bound as the ROI.

There is only one true k2’ value. k2’ is the rate of tracer efflux from the reference region to the plasma.

 Note: Violation of any of these assumptions will invalidate the model and may produce biased parameter estimates. While
the model will still run in VivoQuant, the estimated parameters may not accurately reflect the true tracer kinetics. SRTM2 is
currently implemented in *VivoQuant using a basis function method approach and unweighted fitting [2].

Required Inputs

This model requires the following inputs:

Reference tissue curve.

ROI(s) or voxels.

A fixed k2’

Selection of a fixed k 2‘: The value to which to fix k2’ should be selected based on the tracer and the experiment. For
characterized tracers, we suggest reviewing the literature to see how the fixed k2’ has been selected in different
studies and the effect of the method to fix k2’ on SRTM2 parameter estimates. Generally, k2’ can be fixed to the median
value estimated by a first-pass of SRTM from all voxels with a BPND value > a set minimum [3,4] or all voxels with a
BPND value within a given range [5]. The idea behind using BPND values to select voxels for inclusion in the median is
to exclude voxels which maybe represent noise or have poor SRTM fit. For most tracers there is a range of
physiologically-relevant BPND values. Values outside of that range may be non-physiological. Other studies have fixed
k2’ to the population average value estimated from a 1-tissue compartment model fit to the reference region [3] or
estimated k2’ for each subject by a simultaneous SRTM fit including all target regions with coupled k2’ [3,6]. SRTM fit
with coupled k2’ is not currently available in VivoQuant.

Outputs

Region-level analysis

Plot of data from each ROI with SRTM2 fit.

BPND, R1,k2a, and mean-squared error (MSE) of fit are shown when the cursor is hovered over the model fit plot.

BPND, R1,k2a, and mean-squared error (MSE), data and SRTM2 fit for each ROI can be saved out to .csv.
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Voxel-level analysis

Plot of data for each voxel with SRTM2 fit. Select the voxel for which you’d like to see the model fit by clicking on it
with the image viewer.

BPND, R1, k2a, and mean-squared error (MSE) of fit are shown when the cursor is hovered over the model fit plot.

Parameter maps for BPND, R1, k2a, and MSE.

References

[1] “Noise reduction in the simplified reference tissue model for neuroreceptor functional imaging.”, Wu and Carson. JCBFM,
2002. Link

[2] “Parametric imaging of ligand-receptor binding in PET using a simplified reference region model”. Gunn, et al. NeuroImage,
1997. Link

[3] “Tracer kinetic modeling of [(11)C]AFM, a new PET imaging agent for the serotonin transporter”. Naganawa, et al. JCBFM,
2013. Link

[4] “Parametric Imaging and Test-Retest Variability of 11C-(+)-PHNO Binding to D2/D3 Dopamine Receptors in Humans on
the High-Resolution Research Tomograph PET Scanner”, Gallezot, et al. JNM, 2014. Link

[5] “Kinetic modeling of the serotonin 5-HT1B receptor radioligand [11C]P943 in humans”. Gallezot, et al. JCBFM, 2010 Link

[6] “Assessment of striatal dopamine D2/D3 receptor availability with PET and 18F-desmethoxyfallypride: comparison of
imaging protocols suited for clinical routine”. Amtage, et al. JNM, 2012 . ¨Link

Additional Resources

“Reference region input compartmental models”, Vesa Oikonen. Turku PET Center website. Link .

Logan Non-Invasive Graphical Method (Logan reference plot)

The Logan non-invasive graphical method [1] was developed for reversibly bound tracers based on the Logan graphical
method and Patlak method for irreversibly bound tracers [2,3]. The Logan reference method proposes that after some time t*,
the plot of

 vs. 

(where CT is the concentration of the tracer in the tissue and CR is the concentration of the tracer in the reference region)
becomes linear with slope equal to the distribution volume ratio (DVR). Binding potential (BPND) is related to DVR by BPND =
DVR - 1.
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The Logan plot is a rearrangement of tracer kinetic equations to yield a useful linear equation. However, the mapping of
transformed variables is nonlinear in CT(t), and this results in an underestimation of DVR which becomes more pronounced
with larger true DVR and increased noise [1,4]. Therefore, the Logan graphical method may not be the best method to use
when data are noisy, and other methods should be considered.

Method Assumptions

This model makes the following assumptions:

The tracer binds reversibly.

A region/tissue exists which is devoid of the target site/receptor. We call this region the reference region. It represents
the concentration of the tracer which is free in tissue and/or bound to off-target sites (non-specific binding). An ideal
reference region is a) devoid of the target site/receptor, and b) has the same concentration of tracer free in tissue and
nonspecifically bound as the ROI.

After some time t* the slope of the plot of  vs.  approaches linearity.

 Note: Violation of any of these assumptions may produce biased parameter estimates. While the model will still run in
VivoQuant, the estimated parameters may not accurately reflect the true tracer kinetics.

Required Inputs

This model requires the following inputs:

Reference tissue curve.

ROI(s) or voxels.

t* (in scan time)

Selection of t*: The Logan reference plot as implemented in VivoQuant requires that the user inputs the t* which
defines the time at which the plotted data become linear. In VivoQuant, the default t* value is 0. This is likely not
be the appropriate value for your experiment. t* values are tracer dependent. For characterized tracers, we
suggest reviewing the literature to see which t* values have been used in Logan reference method. The simplest
way to select a reasonable t* value for your data is to run the model once with the default t* value, review the
Logan reference plots to find the point at which they become linear (t/), then re-run the model with the appropriate
*t/* (in scan time) value.

Outputs
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Region-level analysis

Logan plot with line fit for each ROI.

DVR, fitted line intercept, and mean-squared error (MSE) of fit are shown when the cursor is hovered over the Logan
plot.

DVR, fitted line intercept, and transformed Logan space data for each ROI can be saved out to .csv.

Voxel-level analysis

Logan plot with line fit for each voxel. Select the voxel for which you would like to see the Logan plot by clicking on it
within the image viewer.

DVR, fitted line intercept, and MSE of fit are shown when the cursor is hovered over the Logan plot.

Parameter maps for DVR, fitted line intercept, and MSE.

References

[1] “Distribution volume ratios without blood sampling from graphical analysis of PET data”. Logan, et al. JCBFM, 1996. Link

[2] “Graphical analysis of reversible radioligand binding from time-activity measurements applied to [N-11C-methyl]-(-)-
cocaine PET studies in human subjects”. Logan, et al. JCBFM, 1990 . Link

[3] “Graphical evaluation of blood-to-brain transfer constants from multiple-time uptake data”. Patlak, et al. JCBFM, 1983 .
Link

[4] “Effects of Statistical Noise on Graphic Analysis of PET Neuroreceptor Studies”. Slifstein and Laruelle. JNM, 2000. Link

Additional Resources

“Multiple Time Graphical Analysis (MTGA)”, Vesa Oikonen. Turku PET Center website. Link

Patlak Analysis (Patlak Plot)

Patlak analysis is rearrangement of tracer kinetic equations to yield a useful linear equation [1]. Patlak analysis proposes that
after some time t*, the plot of

 vs. 

where CT is the concentration of the tracer in the tissue and CP is the concentration of the tracer in the metabolite-corrected
arterial plasma, becomes linear with slope equal to the net influx rate constant, Ki. The rate constant Ki represents influx and
trapping of the tracer into the tissue [1,2].
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In terms of a two-tissue compartment model where k4 = 0 because the tracer is irreversibly trapped, Ki = 

Model Assumptions

This model makes the following assumptions:

The tracer binds irreversibly

After some time t*, the slope of the plot of  vs.  approaches linearity.

 Note: Violation of any of these assumptions may produce biased parameter estimates. While the model will still run in
VivoQuant, the estimated parameters may not accurately reflect the true tracer kinetics.

Required Inputs

This model requires the following inputs:

Metabolite-corrected arterial plasma input curve.

ROI(s) or voxels

t* (in scan time)

Selection of t*: The Patlak plot as implemented in VivoQuant requires that the user inputs the t* which defines the
time at which the plotted data become linear. In VivoQuant the default t* value is 0. This is likely not be the
appropriate value for your experiment. t* values are tracer dependent. For characterized tracers, we suggest
reviewing the literature to see which t* values have been used in Patlak analysis. The simplest way to select a
reasonable t* value for your data is to run the model once with the default t* value, review the Patlak plots to find
the point at which they become linear (t*), then re-run the model with the appropriate t* (in scan time) value.

Outputs

Region-level analysis

Patlak plot with line fit for each ROI.

Ki, fitted line intercept (V), and mean-squared error (MSE) of fit are shown when the cursor is hovered over the Patlak
plot.

Ki and transformed Patlak space data for each ROI can be saved out to .csv.

Voxel-level analysis

Patlak plot with line fit for each voxel. Select the voxel for which you would like to see the Patlak plot by clicking on it
within the image viewer.

Ki, fitted line intercept (V), and mean-squared error (MSE) of fit are shown when the cursor is hovered over the Patlak
plot.

Parameter maps for Ki, fitted line intercept (V), and MSE.

References

[1] “Graphical evaluation of blood-to-brain transfer constants from multiple-time uptake data”. Patlak, et al. JCBFM, 1983 .
Link .

[2] “Net Influx Rate, (Ki)”, Vesa Oikonen. Turku PET Center website. Link .

Additional Resources

“Multiple Time Graphical Analysis (MTGA)”, Vesa Oikonen. Turku PET Center website. Link .
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NanoSPECT Tools
The NanoSPECT Tools sub-menu contains features primarily associated with improving SPECT quantification.

QuantiCalc

Specific Activity Calculator

SUV Calculator

Crosstalk Removal

Biodist. Visualization

Split Projections

NanoSPECT Tools
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QuantiCalc
The Quantification Calculator enables a feature unique to the NanoSPECT/CT imaging system: the ability to perform
absolute quantification in small-animal SPECT imaging.

Getting There

The QuantiCalc tool is available going to Advanced Modules > NucMed > NanoSPECT.

QuantiCalc Tool

Function

The Quantification Calculator is used to calculate a Quantification Factor. To perform absolute quantification, Quantification
Factors must be calculated for each isotope and aperture combination used in the NanoSPECT/CT. The Quantification
Factors are stored in the Quantification Database. For information on collecting the data necessary to calculate
Quantification Factors, see the NanoSPECT/CT documentation.

QuantiCalc Data

The procedure for collecting Quantification Factor data involves performing a highly-specified SPECT measurement on a
syringe filled with isotope. The fields of the QuantiCalc window may then be filled according to:
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Dose Meter Record the amount of activity in the syringe in MBq,kBq, mCi or uCi as measured by a dose calibrator.
Include the time of the measurement.

NanoSPECT Record the activity value measured by the NanoSPECT from reconstructed data. Include the time of data
collection.

Isotope Select the isotope present in the syringe. Isotopes offered include Ga-67, I-123, I-125, Lu-177, Tc-99, Tl-
201, In-111, and Xe-133. The half-life of the selected isotope will be automatically populated in units of
hours.

Decay Factor The information from the Dose Meter, NanoSPECT, and Isotope fields will be used to calculate a decay
factor between the time of Dose Meter measurement and data collection.

Quantification
Factor

The information from the above fields is all combined to determine a Quantification Factor for that
particular isotope and aperture. This Quantification Factor can then be entered in the Quantification
Database.

Quantification Database

The Quantification Database stores all of the Quantification Factors calculated for any isotope and aperture combination
measured with the NanoSPECT/CT.
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Specific Activity Calculator
The Specific Activity Calculator  accepts an input volume, activity, specific activity for a given isotope and calculates the
amount of isotope present in the sample both in moles and moles/volume.

Getting There

Access the Specific Activity Calculator  by going to NucMed > Apect. Act. Calculator.

Specific Activity Calculator

Function

The Specific Activity Calculator  requires several values to make its calculations. An activity, volume, isotope, and specific
activity are used to calculate the number of excited molecules and molarity of a given sample.

QuantiCalc Tool
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Value Units Description

Activity MBq, kBq, 
mCi, or μCi
and
measurement
time.

Amount of isotope as measured in a dosimeter or with the NanoSPECT.

Volume cm3, mm3, ml,
μl

The volume containing the activity.

Isotope Hours The isotope of interest and its associated half-life. Several pre-defined options are available.

Specific
Activity

MBq/pmol, 
kBq/pmol and
measurement
time.

The specific activity of the isotope being used as measured by a specific activity calibration.
Specific activity describes the number of excited atoms out of the total atoms present in a
given sample, i.e., the amount of the activity that has not yet decayed to a ground state.

Amount pmol, nmol, or
#

The calculated amount, or number, of excited molecules in the sample.

Molarity pmol/ml, 
nmol/ml

The calculated molarity, or concentration, of excited molecules in a sample of activity.
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SUV Calculator
Use the SUV Calculator to calculate a specific uptake value (SUV), given the appropriate entries of injected dose, subject
weight, and activity concentration.

Getting There

Access the SUV Calculator by going to Advanced Modules > NucMed > SUV Calculator.

SUV Calculator

Function

The SUV Calculator requires several values to make its calculations. An activity and volume are used to calculate an activity
concentration. The subject weight and injected dose are used in conjunction with the activity concentration to calculate the
SUV. Units for these entries are user-selectable.

SUV Calculator - Values
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Value Units Description

Activity MBq, kBq, mCi, or μCi Amount of isotope as measured in a dosimeter or with the NanoSPECT.

Volume cm3, mm3, ml, μl The volume containing the activity.

Concentration kBq/ml, MBq/ml, mCi/ml, 
kBq/mm3, MBq/mm3

The ratio of activity to volume.

Patient
Weight

g, kg The weight of the animal or object of interest.

Injected Dose MBq, kBq, mCi, or μCi The amount of isotope successfully injected into the subject.

SUV mg/ml, g/ml, kg/ml, g/l, 
g/mm3, kg/mm3

The specific uptake value (SUV) given the patient weight, activity
concentration, and injected dose specified in the other fields.
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Crosstalk Removal
Use the Crosstalk Removal tool to remove crosstalk photons in dual-isotope SPECT images. The limits in energy resolution
inherent to SPECT imaging result in some overlap between the energy spectra of isotopes with relatively similar peak
energies. For example, in dual-isotope I-123 and Tc-99m imaging, some I-123 photons will spill over into the Tc-99m window
and vice versa. The Crosstalk Removal tool is applied to projection data to remove these “spill over” photons or crosstalk.

Getting There

Access the Crosstalk Removal tool by going to Advanced Modules>NucMed>NanoSPECT.

Crosstalk Removal

Function

The Crosstalk Removal tool requires you to enter the scaling factor of both the Input and Reference images, as well as the
Full-Width Half-Maximum (FWHM) of the smoothing kernel in order to remove crosstalk photons.

Crosstalk Removal
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Biodistribution Visualization
The Biodistribution Visualization tool creates an atlas representation of measured mouse biodistribution values.

Getting There

Biodistribution Visualization is accessible by going to Advanced Modules>NucMed>BioDist Visualization .

Biodistribution Visualization

Function

To use the Biodistribution Visualization function, enter the total measured activity for each region-of-interest available in the
atlas list.
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ROI Measured Activity List

After entering the appropriate values, select one of the buttons at the end of the list.

Button Description

Clear Clears all fields

Load Loads a previously saved biodistribution text file.

Save Saves the current biodistribution data into a text file.

Cancel Closes the Biodistribution Visualization window.

OK Prepares the atlas with the entered biodistribution information.
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Split Projections
Use the Split Projections tool to split a single SPECT projection data DICOM file into multiple projection data files along one
of several DICOM fields.

Getting There

Access the Split Projections tool by going to Advanced Modules > NucMed > NanoSPECT>Split Projections.

Split Projections

Function

Upon selecting the Split Projections tool, the Data Browser opens. Select an appropriate SPECT projection data set. A
pulldown menu of split options is presented. After splitting, a confirmation message is presented to verify successful saving
of the new data sets.
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Calibration
Use this tool to evaluate data from several different NanoSPECT calibration measurements, including CT Geometrical, Multi-
Pinhole SPECT, and Near Field Flood.

Getting There

The Calibration menu is available in the Advanced Modules menu.

Advanced Modules Calibration

Function

To calibrate and maintain the NanoSPECT/CT imaging system, several calibration measurements are required. The
Calibration menu provides options for analyzing:

CT Geometrical Calibrations

Multi-Pinhole SPECT Calibrations

Near Field Flood QC Measurements
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CT Geometrical Calibration
Use this tool to evaluate CT Geometrical Calibration data.

Getting There

Access the CT Geometrical Calibration tool by going to Adanced Modules>CT>GT Geometrical.

CT Geometrical Calibration

Function

The gantry of the NanoSPECT has a reproducible wobble as it rotates around its axis. The CT Geometrical calibration
measures this wobble and generates a file that is used to correct for the wobble in the reconstruction.

The calibration data is also used to assess the severity of the wobble and to insure that it does not exceed +/-0.5mm.

A CT Geometrical measurement consists of a set of projection data collected in a circular CT measurement of the
Geometrical CT phantom. The orbits of the three metal balls embedded in the Plexiglas of the phantom are used to assess the
wobble in the gantry. Example settings for this measurement include 55kVp, 360 projections, 1000ms. The protocol needed
to run this measurement is called CT Geometrical and can be found in the Service Protocols section of the Nucline. After
collecting the measurement data, it may be loaded into the CT Geometrical calibration panel using the Open button described
below.
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CT Geometrical Calibration Panel

The CT Geometrical Calibration panel is divided into five sections: Projections, Orbits, 2nd Order Corrections, Results, and
Control.

The Projections panel displays the projections collected in the calibration measurement as they are being analyzed. Each of
the three metal fiducials is marked by a red, green, or blue circle. The progress of the measurement is also noted in this panel.

The Orbits panel displays the trajectory of the three metal fiducials as the projections are analyzed. The trajectories appear
flat in the primary view; however, by drawing a box around a given trajectory it may be expanded to fill the entire panel,
providing a more illustrative view.

To zoom in on a particular orbit, draw a box by holding down the left mouse button and dragging.

Upon release of the button, the display will show only the selected orbit. To return to the full view, just right-click.

The 2nd Order Corrections panel displays an important result of the calibration. This panel plots the axial and transaxial
wobble of the gantry as it rotates. It is critical that these values be less than +/-0.5mm to enable successful correction of the
gantry motion in the CT reconstruction.

The Results panel provides further calibration results, including a mean-square error (MSE) value that represents the
deviation of the fiducials from their ideal trajectories. A one-word Quality assessment is provided as well as numerical values
for other parameters including the radius of the source (Rs), radius of the detector (Rd), offsets of the source axially (Sz) and
transaxially (Sy), and offsets of the detector axially (Dz) and transaxially (Dy).

The Control panel houses four buttons, including:

Button Function

Open Opens the Data Browser where a CT Geometrical dataset may be selected for
analysis.

Close Closes the CT Geometrical panel.

Save Calib Saves the existing calibration in the format used by the NanoSPECT/CT.

Show Calib Shows the existing calibration in the format used by the NanoSPECT/CT.
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MMP SPECT Calibration
Use this tool to evaluate SPECT geometrical calibration data.

Getting There

The MMP SPECT Calibration tool is available in the Advanced Modules Menu.

MMP SPECT Calibration

Function

To successfully implement multiplexed multiple-pinhole methods in small-animal SPECT, several calibrations are necessary.
You can use the MMP SPECT panel to analyze four different small-animal SPECT calibrations, including linearity, collimator
depth, pinhole offset, and geometrical. The panel is split into eight sections: Templates, Control, Preview, Output, and a
section for each of the four calibrations. There are also several helpful tools in the MMP Menus.

To run the tool, hit the Open button and select all of the relevant data (should be titled Service^SPECT_0*_CalibName and
consist of 64 Intrinsic Resolution data sets, 4 Collimated Beam data sets, and 1 4-point data set) from the Data Browser. The
MMP Tool reads in the calibration data and recognizes which data corresponds to which calibration. The panels for the
individual calibrations display the completeness of the data. Once all necessary data is present, use the Run buttons in
succession from the top calibration (Aluminum Grid) to the bottom calibration (Four-Point). Results for each calibration are
presented in their respective panels; a description of possible errors is listed in Calibration Failures.
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Open Data

After successfully completing the analysis, the result CalibrationData_YYYYMMDD.txt file can be copied into
C:\Nucline\Calibrations\CalibrationData.txt to update the calibration information used by the NanoSPECT.

MMP SPECT Calibration Panel

Templates

The Templates section controls the input and output files used/generated by the calibration analysis.
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Input
Template

You can use a previously-generated CalibrationData.txt file as an input template for the data. This feature is
particularly useful if partial calibrations (i.e., only a 4-point measurement) have been performed.

Empty
Template

As a default, an empty template, designed for use with the Nucline software, is used to generate the 
CalibrationData.txt file.

Output
File

You may specifiy any name for the Output file of the calibration analysis. The default name is 
CalibrationData_YYYYMMDD.txt.

Control

The Control panel has four buttons for manipulating the MMP Calibration window.

Button Description

Show Calib Opens the current CalibrationData_YYYYMMDD.txt file for viewing.

Open… Opens a browser that is to be used for loading MMP Calibration data (DICOM format).

Clear Clears the Output panel of the MMP Calibration window.

Close Closes the MMP Calibration window.

The Calibrations

Four different MMP calibrations may be analyzed with this tool. For each calibration, Preview, Details, and Run buttons are
provided.

Button Description

Preview allows the user to view the images for that particular calibration in the Preview panel.

Details provides information about each calibration.

Run performs the analysis of that measurement. Additionally, the orbits from the 4-point calibration may be
displayed using the Orbits button.

Aluminum Grid Measurement / Linearity Check

Data for the Aluminum Grid Measurement is collected with a device containing 16 carefully-positioned holes. The collimated
beam source holder is placed in each hole. The resulting 16 point images are used to analyze the linearity of the detector.

Collimator Depth

The collimator depth phantom is used to collect data for the collimator depth calibration. This calibration was once used to
determine the distance from the detector plane to the pinhole plane, however, it is now out-of-date and is turned off by
default. It may be turned back on using the “Enable ColDepth” option found in the MMP Menus.

Pinhole Offset (Collimated Beam)

The Pinhole Offset calibration evaluates the deviation between the center of the pinhole plane and the center of the
detector plane.

Geometrical Calibration (4-point)

The 4-point calibration provides a wealth of geometrical information for the NanoSPECT/CT. This geometrical information is
then used by special algorithms to determine the forward model necessary for successful SPECT reconstruction.
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Calibration Failures

In each calibration panel, there are also fields relaying information about the completeness of the data for each head and
some quality measure (either Resolution, Linearity, or Quality). The table below includes information about the limits for
passing a particular calibration and how to interpret error messages. In each case, x designates a head number. For example,
in the 4-point calibration, a R1 (as shown in the screen shot) would indicate that the Radius of Rotation for Head 1 was
outside the acceptable limits.

Calibration Error Message Interpretation Limits

Intrinsic
Resolution

Rx Intrinsic detector resolution >2.4 mm

Intrinsic
Resolution

Px Pixel Size <0.97mm or >1.03mm

Intrinsic
Resolution

Lx Quality of linearity >30 (A.U.)

Collimator Depth Hx Detector plane to aperture plane distance >130.1mm or
<134.1mm

Collimated Beam Hx Absolute distance between aperture center and detector center (y
or z)

>1.5mm

4-Point Ax Absolute aperture offset (transaxial or axial) >1.0mm

4-Point Dx Absolute detector offset (transaxial or axial) >1.5mm

4-Point Rx Radius of rotation >45.9mm or <43.9mm

4-Point Q Overall quality of the calibration >3.0 (A.U.)

4-Point B Horizontal bed offset >3.0mm

Preview

The Preview panel displays calibration data for a particular calibration (selected using that calibration’s Preview button). This
panel is useful for checking head order in the 4-point calibration or determining a missing point in the Linearity Check
calibration. The slider bar at the bottom allows movement between heads.

Preview Types

Output
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The Output panel provides a log of the steps being performed. For example, the Output section will inform the user that files
have been found, provide the numerical results from the analysis, and help identify potential errors.

MMP Menus

Several useful fixes and features may be found in the MMP Menus of File, Tools, and Help.

MMP
Menu

Item Function Keyboard
Shortcut

File Open Data… Identical to the Open button in the Control panel, this opens a browser to allow the
loading of calibration data files.

Ctrl-O

File Basic
Configuration

The ID of the NanoSPECT and # of heads (typically 2 or 4) are set in this panel,
pictured below.

Ctrl-B

File Enable
ColDepth

By default, the collimator depth phantom is not used in the MMP Calibration
analysis. However, it may be enabled with this checkbox.

 

File Exit Used to exit the MMP Calibration tool. Ctrl+Q

File Enable
ColDepth

By default, the collimator depth phantom is not used in the MMP Calibration
analysis. However, it may be enabled with this checkbox.

 

Tools Merge 4-
point files

In the presence of only one single-pinhole aperture, 4-point data are collected one
head at a time. This tool merges those data into a single file.

 

Tools Convert Calib
File

On some Nucline versions, a slightly modified version of the calibration data is
needed. This tool converts the calibration file accordingly.
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Near-Field Uniformity
The Near-Field Flood Uniformity (NFF QC) is a quality control procedure for monitoring the stability of the PMT gains for
each head in the NanoSPECT/CT. To collect NFF QC data, please run the QC SPECT Near-Field  Flood (NFF) protocol in the
Configuration/QC Protocols panel of the Nucline software.

Getting There

To gget to the Near-Field Uniformity analysis panel, go to Advanced Modules > NucMed > NanoSPECT.

NF Uniformity Calibration

Function

The Near-Field Uniformity tool analyzes NFF QC data for monitoring detector uniformity. To begin the procedure, use the
QC SPECT Near-Field Flood (NFF) protocol to collect NFF QC data. Place ~0.5MBq of Tc-99m in as small a volume as
possible in a PCR (Eppendorf) tube. Place this tube in the NFF phantom, a specially-designed holder for the Minerve bed.
Center the point source in the object space as well as possible (using the images and countrates as a guide). Run the NFF
Protocol, rotate 90-degrees, and run the NFF Protocol a 2nd time. Now that data are collected, they may be analyzed using
the Near-Field Uniformity tool.

The initial NFF panel shows gray areas for each head and an array of buttons. To load the data, press the Open button.
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NFF Panel

The data for each head will appear in the appropriate box. To run the analysis, press Calculate.

Calculate

As the data are analyzed, the screen is grayed out. Progress can be monitored in the Results panel shown on the left.

Once the data are analyzed, the (x,y,z) calculated source position will be displayed in the lower-left corner of each Raw image.
These images are indicated by the appearance of the word Raw in the upper-right corner. Also, the raw images are displayed
when the All Pre push-button is selected. The red plus sign on each image indicates the source position with respect to the
detector.
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Results

Viewed the corrected images by clicking the All-Post button. Use Ctrl+T to toggle between the two sets of images. The FOM
for each data set is displayed in the lower left corner. A green checkmark in the Results section indicates that the head
passed the calibration. A red FOM in the Results section means that the data are questionable and should be sent to a service
engineer for further analysis. Finally, to create a PDF containing the pre- and post-correction images, press Report.

FOM Data
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Dosimetry Calc
Use the using VivoQuant’s Dosimetry Calc tool, in conjunction with the third party application OLINDA (Organ Level
INternal Dose Assessment), to estimate whole body dosimetry data. The Dosimetry Calc tool calculates the cumulative
activity per unit activity administered (units in uCi-hr/uCi) which is the required input to the OLINDA application for
dosimetry calculations.

The cumulative activity per unit activity administered is estimated using the following area under the curve (AUC) method.
The tool uses a curve fitting algorithm which fits the experimental isotope’s exponential decay curve to the percent injected
dose per gram (% ID/g) vs time curve of the experimental data. The AUC is calculated using trapezoidal approximations for
experimental measurements, and the remaining AUC is calculated using the analytical solution to the definite integral.

The data is then stored in a .CSV file that can be copied into the OLINDA application.

 Note: Before continuing ensure that a Remainder Body ROI has been created. This is a required data point for the
OLINDA application.

Getting There

To access the Dosimetry Calc tool, the 3D ROI Tool must be active. Go to the Advanced Modules tab, then move down to
Dosimetry Calc.

Dosimetry Calculation Tools

Function

Getting Started

Start the tool by selecting Export Quantification.
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Export Quantification

Once the tool starts, a spreadsheet appears and requests you to fill in missing information from the study. You can do this
either in VivoQuant or in another spreadsheet software.

 Tip: It is likely easier to make changes in batch in a spreadsheet software.

Data Spreadsheet

Column Info

Group Group number. This allows for multiple groups to be used at once.

Time
Point

Time point of the study for each frame. The time units can be manipulated using the drop down menu on the
bottom left of the window or manually in another spreadsheet software.

Injected
Dose

Initial injected dose.

Once the spreadsheet is complete, save the information as an easily accessible .CSV file. In VivoQuant you may append an
existing .CSV file or start a new one.

Using the AUC Calculation

Go to Advanced Modules, then select Dosimetry Calc > AUC Calculation.
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Click Load Spreadsheet in the top left corner of the dialog box, and call the spreadsheet you created in the last section. In the
Dosimetry Isotope drop down menu, select the isotope that was used in the experiment. If the isotope used is not listed,
open the file isotopes.txt located in the VivoQuant install directory (default is C:\Program Files\inviCRO\VivoQuant) and add
the isotope information.

Ensure that you select the correct isotope, because the Dosimetry Calc tool uses a curve fit algorithm and extrapolates using
only isotope-specific radioactive decay information.

Load Spreadsheet

Next, click Update Plot and enter the initial percent injected doses assumed for each of the ROIs.

Update Plot

The Plot should now appear next to the table in the window.

Decay Percent ID
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Click OK and save as another .CSV file. This data is now ready to be used in the OLINDA software.
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Treatment of Quantitative Data

Overview

Image data can be quantitative, therefore care must be given to preserving data integrity when modifying it in VivoQuant.
Regardless of whether data is reported in units of uptake (uCi, Bq, etc.) or concentration (uCi/cc, %Id/g, etc.), the data itself is
representative of uptake measured within a given region. As such, the relationship between the uptake (U), the volume (V)
and concentration (C) of uptake of a region must be preserved through any transformations if the data is to remain accurate.

That is to say, the relationship given by  must be preserved.

VivoQuant is meticulous about preserving this relationship whenever data is resampled such that all three metric can be
measured accurately within a region before and after resampling. Workflows that involve scaling the raw data, however,
require specific attention from the user. When data is scaled, the volume of regions change. From the equation above, it is
clear this needs a proportional change in either the uptake or the concentration of regions, but not both. Consequently,
either the sums of data across regions is preserved (uptake) or the averages of data across regions is preserved
(concentration), but not both. Therefore, once the resampling has been performed with scaling, the user should not convert
between units of concentration (or equivalents, such as %ID/g and SUV) and uptake. Doing so would result in systematically
biased numbers.

Reorientation/Registration Tool

The Reorientation/Registration operator may scale data.

Reorientation/Registration Tool

Manual scaling can be enabled in the Operator menu. Non-linear and affine registrations may also scale the data, and can be
accessed through the other tabs in the Operator window.

 Important: Do not convert units after an image has been rescaled. Converting units will compromise the accuracy of the
data.

3D Brain Atlas Tool
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3D Brain Atlas Tool

The tool gives the next options:

Registration Point: option to determine the technique to perform the transformation.

Head Center: will center the reference’s head and do all the operations to present the brain atlas, it is the best
method for cropped output. Options Registration Direction and Crop are enabled for this technique.

Cursor Seed Point: will seed the operation with the crosshair point in order to present the brain atlas, it is the best
method for non-cropped output. In this technique Registration Direction is “Atlas to Data” and Crop is
unchecked, both always fixed.

Registration Direction:

Atlas to Data, the default choice, will simply transform the brain atlas ROIs to fit the data and will avoid scaling
and resampling the data altogether.

Data to Atlas will, however, resample the images and may scale the data depending on the type of transformation
used. The type of transformation used is found in the Transform drop-down menu in the Advanced Settings tab.

Crop: when is enabled will crop the output.
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Advanced Settings

If using a transformation that could rescale the data, the option to Scale Quant Units will be available. If checked, a box will
appear to warn of the effect of scaling quantitative data.

Scale Quant Units Warning

Clicking Yes will check the box and allow VivoQuant to rescale the data. No transform will scale data unless this box is
checked. If the box is checked, a Versor transform will still not scale the data, but Versor-Scale or Versor-Affine transforms
will.

This is only applicable to quantitative data. Non-quantitative data that is loaded will be scaled regardless of the settings here.

 Important: Do not convert units after an image has been rescaled. Converting units will compromise the accuracy of the
data.

How do I Know if my Data is Quantitative or Not?

VivoQuant detects quantification based on the units provided by the image data’s meta-information. Units of activity (Bq,
kBq, MBq, GBq, Ci, mCi, uCi, nCi, COUNTS, PSL), concentration (activity per mm3, m3, cc, L, ml, uL), %ID, %ID/g and SUV
should all be considered quantitative and are recognized as such by VivoQuant.
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Logging

Log file

VivoQuant will always write a log file that is unique per-session. You can find this log in the temp folder, its name contains
the following pattern vivoquant_[datetime]_session-[random id].log.

This will be automatically added to the report when you create a Help Report
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Manual
A VivoQuant manual has been created to guide the user through all the post-processing functions in a clear and step-by-step
manner.

Getting There

To open the manual go to Manual under the Help menu.

VivoQuant User Manual

The keyboard shortcut F1 can also be used to open the manual.

Function

Users can browse through the different chapters of the Manual to read an in depth explanation of all of the post-processing
functions and instructions on their use.

The different sections covered in the manual are as follows:

Installation

File Management

View

Post-Processing

Tools

Help

Keyboard Shortcuts
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Manual Sections

The sections on the left can be viewed in detail by left-clicking on them. This will open up sub sections which can be viewed
on the right.
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About

Getting There

To open the About section go to About under the Help menu.

About VivoQuant

Function

The About feature provides information about VivoQuant. It informs the user what version of VivoQuant is installed, and
provides the contact information for the creator of VivoQuant. It also displays who the VivoQuant program is registered to.

It also supplies the web links to the DICOM toolkit and the Qwt project used to help make this program.

About Info
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Help Reporter
VivoQuant’s Reporter Tool assists users in submitting service and applications reports for review by the inviCRO service
team. The tool offers a variety of pre-defined report sequences as well as an option for a manual report. Reports are bundled
into .zip files that you can then submit during service request creation.

 Note: Only information visible in the Reporter window is uploaded when a report is submitted. No personal, confidential,
or otherwise hidden information is collected.

How to use the VQ Reporter Tool

To get to the Help Reporter tool, go to Help > Request Help.

Reporter Tool

Initializing the Help Reporter will save a copy of the session currently in-progress.

Most reports will first request a written description of the problem to be included in a text file attached to the report.

Reporter Input Dialog

For all reports, it is possible to add additional files and images using the Add buttons arrayed across the left-hand side of the
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tool.

The Add Files button opens a window that can be used to manually select files. Multiple files may be selected simultaneously
for inclusion in the report.

The Add DICOM button opens the Data browser where files may be selected. To load into the Reporter, either press the
Open button or right-click and choose Load into Reporter.

The Add Comment button opens the Text Dialog Input window, which may be used to add additional written comments to
the report.

The Add Screenshot button opens a screenshot acquisition dialogue. The dialogue has a capture delay to allow files to be
opened or procedures begun prior to acquisition of the screenshot.

Add Screenshot

The Add Video Recording button opens a video acquisition dialogue. The dialogue has also a capture delay option. You can
record a video of up to 2 minutes. The VivoQuant application can be captured when it is located on the primary monitor.

 Important: This records the entire screen where VivoQuant is open, including other apps visible on that same screen
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Add Video Recording

The Add crash dump button opens a dialogue to select a VivoQuant crash dump files.

Add crash dump

In addition to the manual Add button options, the pre-defined report options will automatically gather certain files and add
them to the report. Users can review some low-level items in the Content section by double-clicking on them.
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Content Panel

It is also possible to rename entries in the Content section by double-clicking on the top-level element.

Rename Content

Once all relevant files have been included in the report, click save and choose a filename. The zip file that is generated can be
included in issue reports to Invicro support support@invicro.com to help the investigation of the issue.
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Standalone Help Reporter

Another way to use Help Reporter is through its own application allowing you to create a report in case you are unable to
start VivoQuant. It is located in the start menu with the name Service Reporter.
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Overview
The iPACS Sync application is designed for batch, two-way data transfers between the WebDisk of a specific iPACS project
and a local storage location. Directories and files are synchronized between the source and destination locations, and data
transfers are authorized by an iPACS user’s account permissions.

Batch Transfer Data to and from the iPACS

Browse the following links to learn more about using iPACS Sync to batch transfer data.

Download latest iPACS Sync Application

Configure a Sync Job

Run a Sync Job

Sync Specific Files from an iPACS
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Configure a Sync Job

Create a Sync Job using the Wizard

To create a new job, click Create New Job at the top of the iPACS Sync application window. This will launch the iPACS Sync
Job Wizard, which will guide you through the process of setting up a Sync job.

Open Sync Job Wizard

1. Specify the iPACS URL or IP address in the iPACS Address field. Previously used addresses are available by clicking the
arrow at the right of the text field.

2. Enter the username and password to use for the Sync. Data transfers adhere to the roles associated with an iPACS
user’s account.

3. After entering the required information, click Next.

4. The wizard will attempt to download and install the sync key file for the specified iPACS. Alternatively, you can access
the wizard via a web browser on the home admin page. The admin page is only available to users with the admin role.

5. Once the Sync Key is installed, click Next.

6. Specify the direction of the Sync.

7. Provide the complete path to the local directory to use in the Sync.

8. Select the project on the iPACS to use for the Sync.

The  button will retrieve a list of projects on the iPACS, which can be selected by clicking the arrow to the right
of the text field.

The path of the iPACS project can also be manually entered in the iPACS Project field.

9. The WebDisk folder for the selected project will automatically populate into the WebDisk Folder field. You can select
subfolders via the drop-down menu to the right of the text field.

10. After entering the required information, click Next.
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11. A summary page shows all the selected settings for the new Sync job.

12. Enter a name for the Sync job, then click Finish.

The Sync job is now created, and will be run immediately. Further settings can be configured, as described in the following
sections.

Configuring Additional Settings

The iPACS Sync Config window allows you to manually create new Sync jobs and edit the configuration settings of existing

jobs. To access the iPACS Sync Config window, click on the wrench icon  on the left side of the main window.
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Configuring Additional Settings

Select the job to configure from the Open drop-down, or enter a name and click Create to create a new Sync job.

Create New Sync Job

iPACS Setup

Make a job active or inactive. Specify the iPACS URL or IP address in the Hostname field. Data transfers adhere to the roles
associated with an iPACS user’s account. If the Username and Password information are not provided here, the application
will prompt for it before every data transfer iteration. Click the Configuration button to automatically obtain the sync key file
from the iPACS if necessary.

iPACS Setup

Directory Setup

Specify the direction of the Sync. Provide the complete path to the local directory to use in the Sync. Select the project on

the iPACS to use for the Sync; the  button will retrieve a list of projects on the iPACS, which can be selected by clicking the
arrow to the right of the text field. The WebDisk folder for the selected project will automatically be entered into the
WebDisk field. Subfolders can be selected by clicking the arrow to the right of the text field.
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Directory Setup

Setting Description

Delete local files
after transfer

Files that were successfully transferred to the server are deleted locally. This feature is potentially
dangerous and could lead to loss of data if not used properly.

Delete after Schedule when files are removed from source location.

Scheduler

Create a schedule for when a Sync job will run.

Scheduler

Setting Description

Scan interval Specify how often a Sync job runs while the application is open.

Autosync changes A Sync job will automatically start whenever a new folder is added to the top level
folder.

Only during scheduled scan
interval

A Sync job will automatically start at the time specified on the days selected.
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Notifications

Notifications

Setting Description

Message
Notifications

Turn on Message Notifications and specify what type of messages are sent.

SMTP Server Contact your IT department for the server address. Normally can be found in the settings tab of
your Email Client.

Port Contact your IT department for the server address. Normally can be found in the settings tab of
your Email Client.

Username Username used associate with your email account.

Password Authorization to access your email account.

From Email account from which the notification will be sent.

Recipients Notifications will be sent to the provided email addresses.

Advanced

Include or exclude files by specifying their extension. (e.g. *.dcm *.img *.hdr *.txt *.png). Filter is applied recursively through
the subfolders of the top-level folder. The user can also provide files containing which file names, file extensions, and/or
folders to include or exclude. Example text files would include the following:

Include:

+ 2009*/ + *.csv

Exclude:

- *
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In this example, all folders beginning with 2009 and all .csv files within those folders would be included in the transfer. All
other files would be excluded.

Exclude

Setting Description

Verbose Print more detailed log messages.

Compression Data is compressed before sending.

Filename charset Specify as US-ASCII, ISO-8859-1, UTF-8 or disable this feature.

Sync deleted files Remove remote files that are no longer available locally. This feature is potential
dangerous and could lead to loss of data if not used properly.

Keep newer files Modified files at destination end will not be overwritten.

CVS Exclude Ignore all version control hidden files (.svn folder) when restoring files via iPACS sync.

Always Prompt for download
destination (global setting)

Prompt user to specify download destination for each file downloaded via iPACS sync
from the iPACS.

Store Job

Click Save at the bottom of the window to save any changes to the Sync configuration. Click Cancel to discard all changes
since the last time the configuration was saved.

Store Job
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Syncing data to iPACS
The following sections describe how to run an iPACS Sync job:

Run a Sync Job

Sync jobs are created/modified in the configuration window. To run a job, select the appropriate job and click Run.

Run a Job

Icon Descriptions

Icon Description

Pause a Sync Job

Run all active Sync Jobs

Stop a Sync Job

Open the configuration page

Open the help guide

Quick Sync

This feature is a simple way to quickly download all files from a WebDisk folder, or it can facilitate the transfer of large
amounts of data from the iPACS to a local location.

To download all files and folders in a WebDisk folder, follow these steps:

1. Navigate to the desired WebDisk folder on the iPACS.

2. Click iPACS Sync URL under Other Links on the right side of the page.

3. Copy the URL to the clipboard.
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4. In the iPACS Sync client, go to Jobs -> Quick Sync, then paste the URL.

5. Select a folder where the iPACS files will be saved.

6. The iPACS Sync client will run a job to transfer all files and folders from that WebDisk folder to the specified location.

Quick Sync

To download selected files from iPACS, follow these steps:

1. Select the desired files from the Browser or WebDisk, then right-click one of them and select iPACS Sync.

2. A browser.irsync file will be downloaded.

3. In the iPACS Sync client, open the browser.irsync file by going to Jobs -> Quick Sync File, then selecting the file.

4. Select a folder where the iPACS files will be saved.

5. The iPACS Sync client will run a job to transfer the selected files to the specified lo cation.

Download from iPACS
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Create a custom Brain Atlas

How to create a Custom Brain Atlas

A custom brain atlas can allow the user to perform other registrations based on your own ROIs, and on images of other
animal species. This can be done with the provided wizard in VivoQuant.

The following files comprise an atlas:

Item Format Description

Reference image .raw The reference image data on which your ROI atlas has been segmented

Reference Image
Header

.mhd The header corresponding to the raw reference image

ROI Atlas .rmha The segmented regions of your reference image in which you’d like to use as an
atlas

ROI Key .csv A CSV file of the region names in the order that they appear in the rmha file

 Note: These files will be located in the configured atlas path.

 Note: The tool can handle CT or MR data as the input and MR, PET, or SPECT for the input functional data.

Creating a custom atlas with the wizard

1. Open your data then go to the 3D ROI Tool. Load in the ROI(s) (stored either locally or on iPACS):

Load ROI
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2. The ROI(s) should be available in the ROI selector and should also appear on the ROI table:

Loaded ROI

3. Navigate to Advanced Modules > 3D Brain Atlas tool, then select the + button:

Brain Atlas Tool menu
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Add new atlas

4. Follow the steps prompted by the Brain Atlas Tool Wizard to select reference images and ROIs.

Selected loaded ROIs
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Selected loaded ROIs

Set atlas name

 Important: When choosing the animal name, ensure that there is a corresponding entry in the specieslist.txt file, or
the atlas will not appear 3D Brain Atlas Tool dialog.
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Add key files

 Important: If selecting manually generated keyfiles, at least two must be selected in the file dialog (one left and one
right) with CTRL+select (as appropriate for your platform). The filenames must match the either atlasName-Left.csv or
atlasName-Right.csv

Saved documents
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Saved output

The custom atlas should be ready to use.

The specieslist.txt file

If you should need to create an atlas for another species, you can do so by editing the specieslist.txt file that’s located next to
the VivoQuant application. Typically, this file can be found at the following locations:

Windows: C:\Program Files\inviCRO\VivoQuant\specieslist.txt

macOS: /Applications/VivoQuant/Contents/MacOS/specieslist.txt

Species list file

 Important: On some platforms, you may need administrator access to modify this file.

 Tip: Users can make variations on species’ names if an atlas is needed on a specific data type. For example, a PlanarMouse
and VolumetricMouse species name could be created.
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Key file format

Content

The key file is a comma separated text file without a header row. Empty lines, or lines starting with # or $ are ignored.

The line format is:

input index of the ROI in the .rmha file,output ROI index in the resulting segmentation,ROI name

For example, the keyfile below corresponds to an .rmha ROI file which has 28 disjointed ROIs, which will map to 14 regions
in the resulting output segmentation:

Keyfile format

Filename

The wizard will generate a key file with the following name format:

atlasName-Key-nRegionsRegionsdirection.csv

The atlasName is entered by the user in the wizard process.

The nRegions value will be either All if all ROIs in the current layer were selected to be used, or the number of ROIs.

The direction value could be one of Left, Right or LeftRight if the user has ROIs with the text left or right (case insensitive) in
the ROI names. It will be empty if none of the selected ROIs were named this way.
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This pattern could be used to create segmentations for left cerebellum and right cerebellum separately, or cerebellum
combined.
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Hardware Requirements
The following table outlines the minimum and recommended hardware requirements needed to install VivoQuant in your
computer:

 Minimum Recommended

Operating System 64-bit Windows (10 or 11)  

 10.9 Mac OS or later  

 Ubuntu 20.04  

RAM 8 to 12 GB 12+ GB

Processor 64 bit (For MacOS, x86 support required)  

GPU OpenGL 2.0+ OpenGL 3.0
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Corrupted Data
Data files used in VivoQuant, such as VQ sessions, images and movies, might become corrupted after being processed. For
example, a VQ session zipacs file might get corrupted during the unzipping process. On these occasions, we recommend
clearing the cache before attempting to open the corrupted file again.

VivoQuant Cache Files

VivoQuant cache stores data files such as images or VQ sessions that are frequently accessed or were used recently in a local
repository to improve load time.

If you are using Windows OS, you can find the VivoQuant cache at the following location:

C:\Users\<username>\AppData\Roaming\inviCRO\VivoQuant\cache

Cache files can also be quickly accessed by typing the following path in Windows navigation bar:

%appdata%/inviCRO/VivoQuant/cache

In MAC, the caches files are located here:

~/Library/VivoQuant

If you are using Linux, you can find the VivoQuant cache here:

~/.VivoQuant

Clear VivoQuant Cache

To clear the cache, you can navigate to the above location and manually delete the stored data.

Alternatively, you can clear the cache directly on VivoQuant by navigating to Tools → Configuration → DICOM, and hitting
the Clear button in the DICOM Cache section.

Clear VivoQuant Cache
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Memory Allocation Error
While loading, coregistering, or cropping images, you might receive a Memory Allocation error message followed by a
VivoQuant crash. This error may occur when manipulating large datasets.

Memory Allocation Error

Troubleshooting the Memory Allocation Error

Follow these steps to avoid memory allocation errors:

1. Disable the MIP viewer to lower resource consumption.

2. Downsample your data via the Preprocessing tool

3. Crop your data to remove unnecessary empty space around the subject and decrease the data size.

4. Load in the NM image prior to the CT, so that the CT downsamples to the same voxel size as the NM.

5. Work on a computer that meets or exceeds the hardware recommendations.
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Disabled MIP
If you can’t see the MIP view or 3D rendering of your data, make sure that MIP Viewer is enabled the in your VivoQuant
instance. To do this, navigate to Tools → Configuration → Data, and uncheck the Disable MIP viewer check box.

Enable MIP Viewer

Further Troubleshooting

If, after enabling the MIP Viewer via VivoQuant’s configuration, it still doesn’t appear, or if the Disable MIP viewer checkbox
is greyed out, try the following possible solutions:

Install OpenGL

OpenGL 2.0 is the minimum requirement for MIP to work, but 3.0+ is preferred. Make sure one of these versions is installed
on your computer. For more information on minimum hardware requirements for VivoQuant, see Hardware
Recommendations.

Check for Planar Data

A MIP cannot be generated with planar data. Note that, even if your data is not planar, VivoQuant might interpret it as such if
the Max Voxsize Ratio is less than that of your image. You can increase the ratio by navigating to Tools → Configuration →
Data, and increasing the number for the field Max voxsize ratio for vol .
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Change Max Voxsize Ratio

Check Internal Settings

If a previous run of VQ failed to set up the MIP, a setting might be preventing further attempts to create it. To reset this
setting, follow the below steps:

On Windows: Open the Registry Editor and navigate to:
Computer\HKEY_CURRENT_USER\Software\inviCRO\VivoQuant\MIP. Check that the QVTKWidgetCreationFail is set
to false.

Windows Registry Editor
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If you need to set the correct key value, right-click the key, select Modify and type false in the Value data field. You will
need to restart VivoQuant for the change to take effect.

Set Key Value

On Mac: open the Terminal and run the following command: defaults write com.invicro.VivoQuant
"MIP.QVTKWidgetCreationFail" 0

For further support, please contact support@invicro.com.
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Image Distortion and Mirroring
When loading data into VivoQuant, you might notice that the images appear upside-down or squished in the Display.

Mirroring

Left/Right Mirroring

VivoQuant allows you to choose between two Left/Right orientation options: Neurologist (LR) and Radiologist (RL).

To select an orientation mode, navigate to Tools → Configuration → Display, and use the Orientation drop-down menu to
choose the desire orientation option.

Head/Feet Mirroring

If you notice that your images appear upside down, you can change the Head/Feet orientation by following these steps:

1. Navigate to the Reorientation/Registration operator.

2. Select all the images in your dataset.

3. Check the Head/Feet checkbox.

4. Click the checkmark  button to apply your changes.

Change Head/Feet Orientation
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Distortion

If you notice that your images appear distorted, they might be loading as planar images. If the voxel size ratio for a non-planar
image is greater than your configured maximum ratio, VivoQuant forces the image to load as a planar image. Increasing this
maximum value will prevent this distortion.

To do this, navigate to Tools → Configuration → Data, and increase the number for the Max voxsize ratio for vol  field.

Change Max Voxsize Ratio
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